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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON'’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Digital Photo Professional (hereinafter, “DPP”) is a high-performance
RAW image processing, viewing and editing software for EOS DIGITAL
cameras. It is often thought that RAW images are difficult to handle
compared with ordinary JPEG images, but using DPP, you can perform
advanced edits and print RAW images with ease.

RAW Images and Their Features
What is a RAW Image?

A RAW image is image data that has recorded output data of imaging
sensor. As image processing is not performed inside the camera when a
photo is taken and the photo has been recorded in the special form of
“RAW image data + Image processing conditions information at the time
of shooting”, special software is needed to view or edit the image.

* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. In
the same way, for RAW images too, you cannot view them as images on

your computer unless you perform subsequent image signal processing.

Therefore, even though it is digital, this processing is called
“development”.

When is RAW Development done?

DPP automatically carries out this “development” processing when
RAW images are displayed in DPP.

As a result, RAW images displayed in DPP are images whose
development processing has been completed.

With DPP, you can view, edit and print RAW images without being
particularly conscious of the development processing.

What Advantages Does a RAW Image Have?

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open a RAW image in DPP, the image is automatically developed and
you can view the image as an image to which image processing
conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Consequently, image
deterioration is not a problem and it is the perfect image data for users
who want to get creative with their images after they have been shot.
In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe”.

i %

ata

M oy |
Image processing conditions information
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Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

View and organize RAW images

Real-time adjustment of a RAW image
Various image adjustments while maintaining the original image
Freely apply a Picture Style
View your image before and after adjustment in the same window

Trim and adjust the angle of an image
Change image size

Correction of lens aberration
Automatic/manual dust erasure processing

Convert from a RAW image to a JPEG or

TIFF image and save
Process large numbers of RAW images in batches
Transfer the image to image editing software

Print a RAW image
View and organize JPEG and TIFF images

Real-time adjustment of JPEG and TIFF
images
Various image adjustments while maintaining the original image

Print JPEG and TIFF images

Color management compatibility
CMYK simulation for commercial printing

System Requirements

Introduction

oS Mac OS X 10.8, 10.9
Computer | Macintosh with one of the above OS installed
CPU* Intel processor ngfanrfgeat
RAM Minimum 2GB
Displa Resolution : 1024 x 768 or more P
play Colors : Thousands or more Ope?glt?on
* Core 2 Duo or higher is recommended
This software program is not compatible with UFS (UNIX File System)
formatted disks. Advanced
Check the Canon Web site for the latest system requirements, Operation
including supported OS versions.
Advanced
Supported Images ors
. . and Printing
This software supports the following image types.
Image type Extension ' Processing ‘
RAW images*! shot with EOS DIGITAL Lag%ﬁrﬂgggsers
cameras, excluding EOS DCS1 and .CR2
RAW images | EOS DCS3 TIF —
RAW images*2 shot with PowerShot .CRW JFFgclst/I%Cl]:F
cameras Images
JPEG images EXIf 2.2,2.21 or 2.3-compatible JPEG JPG, JPEG
images
TIFF images | Exif-compatible TIFF images TIF, .TIFF RETIEED
*1 Compatible with RAW images shot with EOS D6000 or EOS D2000
that have been converted to RAW images using the CR2 Converter
and have the “.CR2” extension. Index
For information on CR2 Converter, refer to Canon Web site.

*2

» Only with models where Digital Photo Professional is listed in the
“Data Type” item in the “Specifications” section near the end of the
Camera User Guide.

* Use the dedicated CameraWindow application to download images
from a PowerShot camera to a computer. See the Software Starter
Guide for details.

* Lens aberration correction can only be used with some camera and
lens models.

» Automatic dust erasure processing and other EOS DIGITAL specific
functions cannot be used.
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Introduction

Downloading Images to Your Computer Adijust brightness of shadows/highlights - p.55
Download images by connecting your cameraand 0.7 Reduce image noise = p.60 Contents at
computer ' Correct lens aberration -» p.61 a Glance
Download images using a card reader 2p9 Use the Digital Lens Optimizer - p.68
. . Use a Picture Style file - p.57 Basic
Viewing and Checking RAW Images e y . Operation
_ _ Edit efficiently = p.34
QU|cI.<Iy enlarge parts of an |m§ge *pll Edit an image while comparing the image before and - D51
Sort images (check marks, rating) = p.18, p.19 after adjustment P. Advanced
Display the images shot simultaneously as a RAW 0.22 Synchronize multiple images - p.52 Operation
@age and ‘?PEG mage asa smgI? I_maqe _ Display an area beyond the set range as a warning 53
Display the images in the thumbnail list display at high indicator (Highlight/Shadow warning) P Advanced
resolution 2p23 . . . . . Image Editing
Restore an adjusted image to its condition at the time - p.43 and Printing
Check shooting information such as the shooting date =» p.10, p.23 of shooting p. =)
Composite images -»p.78 Ereeadal
Editing RAW Images (Adjusting) Create HDR (High Dynamic Range) images - p.81 Lar%el Numbers
Adjust brightness/darkness =*p.12, p.26 w
Use automatic adjustment = p.33 it
Change the Picture Style - p.26 Printing Editing
Sharpen the modulation and contrast of colors (contrast) ~ =» p.29 Print well on a Canon printer i gg’g Egg JITrEgéLIS':F
Make skin tone look healthier (color tone) = p.30 Faithfully reproduce the color of the subject =» p.43, p.87,
Make the image colors more vivid (color saturation)  =» p.30 when printing p.88, p.89 _
. eference
Make an image sharp (sharpness) = p.3l Print with the shooting information -»p.85
Adjust an image to make color tone more natural - Print a thumbnail list of images - p.86
; p.28
(white balance) , .
_ _ _ Approximate the color seen on screen with your - 093 Ind
Change an image to black-and-white or sepia tones rintina results P naex
p.30 p g
(monochrome) —
Trim an image and adjust the angle of an image = p.38 Conversion of Images
Specify an aspect r_atio tha}t matches the size of the - p.38 Convert a RAW image to a JPEG image - p.42, p.99 @ @
paper on which an image is to be printed o
. i Edit in Photoshop = p.77, p.100
Erase dust shot with the image =*p.73, p.75 .
, Perform batch processing -» p.99
Erase unwanted parts of an image ->p.77 _ _ _
Edit (adjust) a JPEG image =»p.103

Auto correct RAW images with the Auto Lighting Optimizer =» p.59



1 Basic Operation

The basic operational flow — from how to download to your computer
images shot with a camera to checking, editing, saving and printing a
downloaded RAW image — is explained here.
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Starting up DPP

Click the Dock icon.

Digital Photo Professional

Click

DPP starts up and the main window ([Folder] window) appears.

v

Maln wmdow ([Folder] window)

Bockmarh  Label Adpsimen Tooh  Wwidew Pl

| i

Main Window Display

In the main window, you can use tabs to select either the [Folder]
window or the [Collection] window. The [Folder] window displays the
images in folders on your computer, while the [Collection] window (p.36)
displays images selected randomly by the user from one or more folders
and gathered together.

Unless noted otherwise, the [Folder] window will be described as the
main window from this point on.
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Downloading Images to Your Computer

Introduction

Connect the camera and computer with the cable provided and Start up EOS Utility.
download the images saved on the memory card inserted in the camera. Select the [Tools] menu » [Start EOS Utility].
For downloading images, start up the camera software “EOS Utility” —
from DPP and use. Cgr(xst;a;r;cgeat
Start Quick check tool EF
Select the save destination for the images. _#S
Select the save destination in the folder area on the left of the Start Trimming/Angle Adjustment too HT B1ip
main window. Opergtion
When creating a folder, see p.47.
e00 Digit m Advanced
£ - Trancfer to Photoshon CrT) Operation
nc folder with EQS5 Utility
Folder Collection(0) T Advanced
v macosx EOS Utility starts up. Image Editing
'L_',: ::;llllcoart:::?(ems EOS Utility (Displayed items differ depending on connected U] (R
- camera)
v -canon — PrOCQSSing
B e — — Large Numbers
> & Library Control Camera Accessories of Images
= Movies ——
‘.u: Music
VpBiciua Editing
P -- Starts to download images JPEG/TIFF
> 1 sites Images
» [ shared
Lets you select and download images
Reference
Camera settings/Remote shooting
“‘ Monitor Folder
' Index




Connect your camera and computer and turn the
camera on.
Connect the camera and your computer with the interface cable
provided with the camera and turn the camera on.
For detailed instructions on connecting your camera and
computer, refer to the “EOS Utility Instruction Manual” (PDF
electronic manual).

Accessories

Starts to download images

Lets you select and download images

Camera settings/Remote shooting

Monitor Folder

Downloading of images begins.

The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of DPP.

The downloaded images are sorted by date into folders and
saved.

-I\@/E Advantages of using EOS Utility to download images

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.

5

You cannot start up EOS Utility in the [Collection] window
(p.6, p.36).
When EOS Utility has been started up from DPP, you cannot use
the following functions.
* Quick check window view (p.16)
e Trimming and adjusting the angle of an image (p.38, p.111)
« Digital Lens Optimizer (p.68)
» Compositing images (p.78)
« Creating HDR (High Dynamic Range) images (p.81)
« Dust erasure processing (copy stamp function)
(p.73 to p.77, p.114 to p.118)
» Batch change file names (rename function) (p.101)
« Printing using Easy-PhotoPrint EX (Plug-in printing) (p.43)
* Transferring images to Photoshop (p.77)
» Batch saving images (batch processing) (p.99)
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Downloading Images Using Your Card Reader

You can also download images to the computer, using a third-party card
reader.

Load the memory card into the card reader.

Open aremovable disk icon in the folder area and
move the [DCIM] folder inside to a suitable place
such as to the [Desktop].

000 Digital Photo P

[IE!

Folder Collection(0)
v = MacOsx
b | Applications
(7 Temporary Items
¥ |8 Users

¥ @ canon

P & Library
= Movies
[ & Music
» = Pictures
» (4 Public
P [ Sites
b [ 4 Shared
¥ |_ EOS_DIGITAL
» [ DCIM

The [DCIM] folder is copied to your computer.
All images are saved in folder units inside the [DCIM] folder.

By selecting the memory card folder directly in DPP, the images in the

Display the images downloaded to your computer.

In the [DCIM] folder copied to your desktop, select the folder
where the shot images are saved.

8086 Digital Photo Profession

= i E

Folder Collection(0)

v = MacOsx
» | A Applications
[F Temporary ltems
v & Users
v & canon
v [ Desktop
V|

L. .
[ 102cANON g
» | Document ts IMG_0001.CR2

b [& Library
= Movies
& Music

A .
¥ [ Pictures -

F[)

< Images in the folder are displayed in the main window of DPP.

Checking before downloading images

folder are displayed in DPP and you can check the shot images.

5

Copying images to your computer will take some time when there

is a large number of images saved on the memory card.

For details on the [DCIM] folder structure and the file names of
shot images, refer to “Folder Structure and File Names in the
Memory Card” in the “EOS Utility Instruction Manual” (PDF
electronic manual).
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Viewing an Image

Images downloaded to your computer are displayed as a thumbnails list
in the main window. You can double-click an image to open the edit
window and display the image at large size.

Viewing Images as Thumbnails in the Main Window

o Rotate selected image
Main window ‘

[@ Dignal Fhote Professional fie (i ew kmfark L
[

v e bt o g 14 s o it e[| e

Click to select the image
Display thumbnails of all the images inside the
folder selected in the folder area on the left

® Images displayed with the ["® ] icon are movie files and cannot
be played back in DPP.
If the message [Insufficient memory.] appears, there are too
many images in one folder. Decrease the number of images in
one folder such as by dividing them into smaller folders, etc.

|§| When aspect ratio information is attached to the shot image with the
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark lll, EOS-1D
Mark lll, EOS 5D Mark lll, EOS 6D, EOS 7D Mark Il, EOS 7D, EOS
70D, EOS 60D, EOS REBEL T5i/700D, EOS REBEL SL1/100D,
EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T5/
1200D, EOS M2 or EOS M, the image is displayed as a trimmed
image (p.38, p.111).
For a list of main window functions, see p.124.

Changing the Size of Thumbnail Images

You can change the size of the thumbnail images displayed in the main
window and display them with shooting information attached.

Select the [View] menu » desired item.

View
Edit in Edit image window H—
View collections WHG

v Tab

v Folder view

v Toolbar
Tool palette T
Large thumbnail #1

v Medium thumbnail *2
Small thumbnail 3
Thumbnail with information ¥4
Sort >

The display changes to the selected item.
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Enlarging and Viewing an Image in the Edit Window

Double-click

The edit window appears.

Edit window '

Tool palette

lcore v o v 0  dd o

T e

It may take time for the image to redraw itself.
Click the [@®] in the upper left of the edit window to close the edit
window.

By selecting the [View] menu » [AF Point] in the edit window, you can
display the AF points selected in the camera at the time of shooting.
However, AF points are not displayed for images whose image size
has been changed and then been converted and saved (p.42, p.134),
images for which you selected an effect other than [Shot settings] as
correction of fisheye lens distortion aberration, or images which have
had settings specified during RAW processing on the camera for
distortion correction and chromatic aberration correction.

For a list of edit window functions, see p.127.

Enlarging and Viewing a Specific Area

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.

© Double-click again to revert to the full view.

» To change the enlargement display position, drag on the image
or drag the enlargement display position of the tool palette.

Enlargement display position in the tool palette

Change the enlargement
display position by
dragging

5@/5 To display an image in an enlargement ratio other than 100%

Select the [View] menu » [200% view] or [50% view].

|§| You can change the enlargement ratio when you double-click (p.91).
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Adjusting an Image

You can perform a variety of image adjustments, such as adjusting the
brightness or changing the Picture Style of an image, using the tool
palette of the edit window. You can easily restore an image to its original
settings with the [] button even if you have made the wrong
adjustment. Try out the various adjustments.

As an example, the procedure to adjust the brightness of an image is
explained here.

Tool palette
[ RAW | RGB  NR/ALO  LENS |
— .
|Eﬂ'gi‘|tness adjustment l| - i| Reverts the Image to
ﬁl ) .00 the original settings
|White balance adjustment [_)rag the S“der Ieﬁ: or
right

& (Auto)
|Pictura Style = i|

@& (Standard) ﬂ [ Browse...

ST A

Contrast: o —u-u-u-u‘eru-u-uq
Highlight: (1) . i
Shadow: Al s e
| Linear
Color tone: o T@T
Color saturation: o ‘-._._._:e.—.-.-.-
Unsharp mask ':]
Strength: 0 m
Fineness: ] m
Threshald: 1] m

The image brightness changes in real time according to the
amount of adjustments.

? The tool palette does not display

Select the [View] menu P [Tool palette].

About the Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your
editing requirements.

Because adjustment made with the tool palette (it undergoes automatic
development processing each time) only changes the image processing
conditions, the “original image data itself” remains unaffected.
Therefore, there are no problems with image deterioration that arise with
editing and you can readjust your images any number of times.

See Chapter 2 onwards for more detailed information on the various
functions of the tool palette.

About Recipes

In DPP, all the adjustment contents (image processing conditions
information) made with the tool palette are saved to an image as data
called a “Recipe” (p.96).

@ For a list of tool palette functions, see p.128.
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Saving an Image

If you perform the save operation described here, you can save all the Savi ng
adjustment contents (recipe) made with the tool palette to the RAW

image. With DPP, you can perform the following types of saving according to
your requirements. For detailed information on each saving method, see
Chapter 2 onwards.

Introduction

Contents at
a Glance

Select the [File] menu » [Save].

Save (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW i
Close window FW image and save. Operf@tion
[ Save 3G ] Save a.S (p4l) - .
e T 8s Add adjustment contents (recipe) made with the tool palette to a RAW
Convert and save... s image and save as a separate RAW image. The original RAW image Advanced
remains unaffected. Operation
Print... . _ 2P Add thumbnail to image and save* (p.23)
Print with detailed setting... €-#D Create a new thumbnail image for the main window and save to each
Print contact sheets... ~38P image. Imgg\éaggﬁ?ng
Plug-in printing r The quality of images in the main window improves and images and Printing
Info 8| redraw themselves more quickly.
_ _ _ Convert and save (p.42) Processing
Your adjustment contents (recipe) are saved to the image. Convert adjusted RAW image to a JPEG or TIFF image and save. Large Numbers
The original RAW image remains unaffected. of Images
Batch process (p.99)
Convert in batches adjusted multiple RAW images to JPEG or TIFF Editing
images and save. JPEG/TIFF
. . . Images
The original RAW images remain unaffected.
* Option available in the main window. Reference
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00
©

13



Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the [File] menu » [Print].

Close window HW
Save s
Save As... {35
Convert and save... ¥D
[ Print... 2P )
Print with detailed setting... {+3D
Print contact sheets... ~®P
Plug-in printing [
Info £

The [Print] dialog box appears.

Print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [Print] button.
Printing begins.

-:\@/3 To change the paper size

To set the paper size etc., select the [File] menu » [Print].

Printing
With DPP, you can perform the following types of printing according to
your requirements. For detailed information on each printing method,
see Chapter 2 onwards.

Print one image (p.46)

Print with a Canon inkjet printer (p.43)

Print with a high-end Canon printer (p.87)

Print with shooting information (p.85)

Printing a thumbnail list (contact sheet printing) (p.86)

Quitting DPP

In the main window, select the [Digital Photo
Professional] menu » [Quit Digital Photo

Professional].

Digital Photo Professional

About Digital Photo Professional

Preferences... 3,
Service >
Hide Digital Photo Professional 3H
Hide Others H#H

[ Quit Digital Photo Professional EEQ)

DPP quits.

|§| A confirmation dialog box for saving the images appears when you
try to quit DPP without saving the adjusted image. Click the [Yes to
all] button to save the adjustment contents (recipe) to all the images

adjusted.
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D Advanced Operation

A more advanced operation — from efficiently checking images, to
various ways of editing an image, printing a RAW image using a Canon
printer and sorting images — is explained here.

Efficiently Checking/Sorting Images.........ccccccoeeeeeee. 16
SOortiNg IMAgES......oeeiiii e 18
Attaching Check Marks........cccoooeeiiiiiiiii. 18
Setting Ratings ..., 18
Sorting Images in the Main Window .......................... 19
Attaching Check Marks in the Main Window ......... 19
Setting Ratings in the Main Window ...................... 19
Arranging Images in the Main Window...................... 20
Arranging by TYPe ...coovvviiiiiiie e 20
Arranging Freely ..o 21
Displaying a RAW Image and JPEG Image as a Single
[ gT= T =T 22
Improving the Quality of an Image in the Main Window ... 23
Checking Image Information...............cc.ooooeel. 23
Editing an Image ........ccoooovvieiiiie e 25
About the RAW Tool Palette.........cccooeeveeiiiiieiinnennnnn. 25
Editing with the Tool Palette in the Main Window.. 25
Adjusting Brightn@ss.............uvviiiviviiiiiiiiieeans 26
Changing a Picture Style ............cccooeeeeiii 26
Picture Style File.......cccooiiiiiiiiii 27
Adjusting Color Tone by Changing White Balance.... 28
Adjusting Color Tone Using Click White Balance....... 28
Adjusting Contrast ... 29
Changing Color Tone and Color Saturation............... 30
Adjusting MoONOChrome...............eevveviivviiieniiniiinnnnns 30
Adjusting Image Sharpness.........cccccceeeeviiiiieeiiiinnnnn. 31

Detailed Setting of Image Sharpness..................... 32
Automatically Adjusting Brightness and Color (Tone
CUIVE ASSISE) coiiiiiiiiiiie e 33

Editing Efficiently ... 34
Editing in the Edit Image Window..............ccccvvveeenn... 34
Changing the Thumbnail Display Position to Horizontal............... 36
Gathering and Editing Images in the Collection Window ... 36

Trimming and Adjusting the Angle of an Image....... 38

Applying Adjustment Contents to Other Images...... 41

Saving Editing Results............cccccoevieiiviiiie e, 41
Saving Editing Contents to a RAW Image.................. 41
Saving as a JPEG or TIFF Image.........cccccvvvvvvivvnnnnnns 42

Re-Editing an Image........ccccceevvevveiiiiie e 43

Printing an IMage ..........ccovviiiiieeieeie e 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint EX .............ccceeeees 43
Printing Photographs with a Printer other than Canon
L = O ad € 410 6T 46

Organizing IMages ......ccouviiiiiieiiiii e 47
Deleting an Unwanted Image ............ccoevvvvviiiieeeeneennns 47
Creating a Folder for Saving Images...............ccceeee. 47
MoVING IMAaQES ... 48
Moving Images in Folders .........cccooovvvviiiiiiiiieeeeeeeia, 48
Registering Frequent-Use Folders (Bookmark
ReQgISLration) ......cccoeeveeeee e 49

Organizing Bookmarks ...........ccocoeveiiiinninieeeee, 49
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can attach check marks and sort
images into five groups.

Introduction

—_—

Double-click the area you want to enlarge.

[ T e £ T s Tl

12345 Contents at

. . . = a Glance
Display the quick check window. 0 e Double-click e
Click the [Quick check] button. R -
Digital Photo Professional - [ MacOSX /Users/canon/Piq j =2 BaSi(.:
Operation
D ————————————

The quick check window appears.

Click the [Next] or [Previous] button to switch
between images to be checked.
Quick check window

AN 2718 BC_0002.CILZ (1454 = 2104]

.....

[

All the images displayed in the main window can be checked in

the quick check window.

The area you double-clicked is enlarged to 50% view.
To change the display position, drag on the image.
Double-click again to revert to the full view.

® To quit, click the [OK] button.

|§| When [AF Point] is checkmarked, you can display the AF points
selected in the camera at the time of shooting. However, AF points
are not displayed for images which have had their image size
changed and then been converted and saved (p.42, p.134), which
have had settings specified during RAW processing on the camera
for distortion correction and chromatic aberration correction, which
are composited, or which are created as HDR (High Dynamic
Range) images.
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Vs

> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switch between images using the keyboard

You can also switch between images by pressing the <3§> + <—>or
<3> + <> keys.

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

|§| The enlargement ratio when an image is enlarged is half (50%)
of the 100% (actual pixel size).

You can change the enlargement ratio to 100%, when an image
is enlarged (p.91).

For a list of quick check window functions, see p.132.
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Sorting Images

You can sort images by attaching check marks or setting ratings
(indicated with [ ] marks) by subject or theme.

Attaching Check Marks

Display the image you want to attach a check mark
to, and then click any one of [#] to [5].

Check mark

[ Clear }

12345 Click

The selected check mark appears in the upper left of the window.

(‘Zheck mark

2/15 IMG_0002.CR2 [3456 x 2304]

| soxview [N Full screen
e L__..,_,_,_,J

Check mark

Click the [Clear] button to remove the check mark.

|§| The values of check marks attached to images in DPP version 3.8
or earlier are maintained as they are.
You can also attach check marks from the menu that appears by
clicking on an image in the main window while holding down the
<control> key.

Setting Ratings
Display the image you want to rate, and then click
any one of the [ - ].

Rating
T

(s » » » @) Click (changesto [ % ] after

clicking [ = ])

The rating is set and an icon corresponding to the selected [ %]
appears in the upper left of the window.
(Window shown with a rating of three [%])

® To set [Reject], click the [Reject] button. Click the [Reject] button
again to cancel.

Rating icon
—

2/15 IMG_OD02.CR2 [3456 x 2304]

| soxview || Full screen }

Introduction

—_—

Contents at
a Glance
D ————————

Basic
Operation

—

Advanced
Image Editing

and Printing
—_

Processing
Large Numbers
of Images

Check mark

123

Rating

*@v .

To cancel the rating, click the same [ ] as when the setting was
made on the right of the window.

® As the file structure of the image data is changed when a rating is
set to an image, it may not be possible to check the image
information in third-party software.

|§| You can also set ratings (including [Reject] setting) from the menu
that appears by clicking on an image in the main window while
holding down the <control> key.
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Sorting Images in the Main Window

You can also sort images in the main window by attaching check marks
or setting ratings (indicated with [E4] marks) by subject or theme.

Attaching Check Marks in the Main Window

Select the images you want to attach a check mark
to, and then click any of [E] to [E] in the toolbar.

Click

The selected check mark appears in the upper left of the image
frame.

Check mark

IMG_0001.CR2 = IMG_0D02 .CR2 * IMG_0003.CRZ
",

Click the check mark in the toolbar again to remove the check
marks.

Setting Ratings in the Main Window

Select the images you want to rate, and then click
any of the [@&] in the toolbar.

Click (changes to [EX]
after clicking [H])

—=- Select

The rating is set and an icon corresponding to the selected [E1]
appears in the image frame.
(Window shown with a rating of three [E4] as an example)

Rating icon

IMG_0002.CRZ

B e MGOndcRz =

To cancel the rating, click the same [E1] as when the setting was
made in the toolbar.

[Reject] cannot be set with the toolbar. Set [Reject] with the
[Label] menu or the quick check window (p.18).
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=@> To select multiple images in the main window

Click on desired images while holding down the <38> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <shift> key.

i@i— To display more thumbnails in the main window

You can display a large number of images by setting the size of thumbnail
images to small (p.10). Then, by selecting the [View] menu » [Rating] and
removing check marks so that ratings no longer appear in the image
frame, you can display still more thumbnail images in the main window.

|§| The [Label] menu can also be used to attach check marks and set
ratings.

By selecting the [Edit] menu » [Check mark] or [Rating] » image

selection criteria, you can refine criteria for selecting

checkmarked or rated images.

You can display and change the rating settings set in DPP with other

bundled software and on an EOS-1D X, EOS-1D C, EOS 5D Mark

lll, EOS 6D, EOS 7D Mark Il, EOS 7D (firmware version 2.0.0 or

later), EOS 70D, EOS 60D, EOS REBEL T5i/700D, EOS REBEL

SL1/100D, EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS

REBEL T5/1200D, EOS REBEL T3/1100D, EOS M2 or EOS M

camera.

» EOS Utility version 2.9 or later:

Ratings set in DPP are displayed. However, [Reject] is not
displayed and you cannot change rating settings.

* On an EOS-1D X, EOS-1D C, EOS 5D Mark Ill, EOS 6D, EOS
7D Mark I, EOS 7D (firmware version 2.0.0 or later), EOS 70D,
EOS 60D, EOS REBEL T5i/700D, EOS REBEL SL1/100D,
EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T5/
1200D, EOS REBEL T3/1100D, EOS M2 or EOS M camera:
Ratings set in DPP are displayed in the playback screen. You
can also change rating settings. However, you cannot display or
change settings for [Reject].

Reversely, you can also display and change with DPP the rating

settings set for still images on an EOS-1D X, EOS-1D C, EOS 5D

Mark Ill, EOS 6D, EOS 7D Mark I, EOS 7D (firmware version

2.0.0 or later), EOS 70D, EOS 60D, EOS REBEL T5i/700D, EOS

REBEL SL1/100D, EOS REBEL T4i/650D, EOS REBEL T3i/

600D, EOS REBEL T5/1200D, EOS REBEL T3/1100D, EOS M2 or

EOS M camera.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [View] menu P [Sort] » desired item.

View collections NHEG
v Tab
v Folder view
+ Toolbar
Tool palette ®T
v Rating
Large thumbnail #1
¥ Medium thumbnail 382
Small thumbnail ##3
Thumbnail with information 384

o Rating : Ascending order
Rating : Descending order

v File name
Shooting Date/Time
RAW priority

Check mark1
Check mark2
Check mark3
Check mark4
Check mark5

The images are arranged in the order according to the selected
item.
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Sort item Description
Rating: ascending Sorted in order of fewest [ % ].
order
Rating: descending Sorted in order of most [ ].
order
File name Images are sorted by file name in alphanumeric

order (0to 9 = Ato 2).

Shooting Date/Time Images are sorted by shooting date and time

from the earliest.

RAW priority Images are sorted in the following order: RAW

images - JPEG images - TIFF images.

Check mark1 -
Check mark5

Images with check marks take priority and are
sorted in number order.

-Z@/E Check mark sorting order

When check marks from 1 to 5 have been set, the images are sorted as
follows:

Check markl selected: 1»2->3->4-5

Check mark2 selected: 2->3->4->5-1

Check mark3 selected: 3»4->5->1->2

Check mark4 selected: 4-»5->1->2-3

Check mark5 selected: 5»>1-2->3->4

Arranging Freely
Drag and drop the image to the desired location.

@ Dignal Phots Professional Ve Beckmank Ll ASuvieant E 4 el GARAM @

..........

dota 0 Sty b d tie N e 11

The image moves to the desired location.

@ You can also select multiple images (p.20) and move them.

@ The order of rearranged images is maintained until you quit DPP
or select another folder in the folder area.
Select the [View] menu » [Sort] P [File name] to revert to the
order before the images were rearranged.

E@E Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you quit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View settings] tab sheet in the [Preferences] to
maintain the order of images without changing the image file names
(p.91).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.101).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Digital Photo Professional] menu »
[Preferences].

Select the [View settings] tab sheet and checkmark
[Display only CR2 images for CR2 and JPEG files of
the same name].

e

Preferences

General settings || View setti || Tool palette | Color management
—
Grid pitch
64 Pixels(8-256)

Locking selected image
E Images opened in Edit window remain selected in main window
Magnification in Edit window

@) Fit to window ) 50% O 100% ) 200%
Magnification when the Edit/Edit image window is double-clicked

@ 50% ) 100% O 200%

and IPEC
E Display only CR2 images for CRZ and JPEG files of the same name J

Sort order in main window
E Retain sart order

Highlight/shadow warning

Highlight 255 (192-255 (N
Shadow 0 (0-64) s |
Quick check tool display
@ s0% () 100% (moiré reduction off)
( Cancel | f 0K ’

The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [GXXD] mark (p.126).

? RAW images with the extension “.CR2” can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF”
cannot be displayed as a single image.

-Z\@/E When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.

* Deleting an image (p.47)

» Moving or copying an image (p.48)

» Checkmarking (p.18, p.19)

» Rating (p.18, p.19)

» Rotating an image (p.124, p.132, p.133)

« Attaching a thumbnail to an image and saving (p.23)

Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[XXD] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2 (p.125).

|§| In step 2, if you uncheck [Display only CR2 images for CR2 and
JPEG files of the same name], the RAW image and JPEG image
are displayed as separate images.
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Improving the Quality of an Image in the Main Window
Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images redraw
themselves more quickly.

With all the images selected, select the [File] menu »
[Add thumbnail to image and save].

e

Open in Edit window E40)
Open in Edit window (enlarged)
Close window HW
Save *S
yve Ac {3385
Add thumbnail to image and save (3T ]
Convert and save... a6 )
Batch process... #B
Create new folder 138N
Print... ®P
Print with detailed setting... 43D
Print contact sheets... ~®8P
Plug-in printing »

=@ The extent of the improvement in quality

The quality is improved for any JPEG or TIFF image. While the image
quality improves regardless of the thumbnail size (p.10), selecting [Large
thumbnail], with its larger display size, shows the improvement more
clearly than [Medium thumbnail] and [Small thumbnail].

|§| A large number of images may take some time to be processed.

Checking Image Information

Select the image for which you want to check the

iImage information.

Click the [Info] button.

8006

Folder

il

Collection{0)

v 3 ENG
P | % Applications
» [ Developer
» [ 3 Phomn

The image information window appears (p.24).
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Select a tab sheet and check information.
[Shooting Information] tab sheet

[Metadata] tab sheet

800

_ IMG_0001.CR2

{ Shooting Information | M

—

| Item

Camera Model
Firmware

Shooting Date/Time
Owner's Name
Shooting Mode

Tw( Shutter Speed )
Av( Aperture Value )
Metering Mode
Exposure Compensation
ISO Speed

Auto 150 Speed
Lens

Focal Length

Image Size

Image Quality

Flash

FE lock

White Balance Mode
AF Mode

Picture Style
Sharpness

Contrast

Saturation

Color tone

Color Space

Highlight tone pricrity
Aute Lighting Optimizer

Dust Delete Data
File Size

Drive Mode

Live View Shooting
Date/Time(UTC)
Latitude

Lonnitude

Long exposure noise red...
High IS0 speed noise re...

Peripheral illumination c...

Value

FileName ___________|IMG000LCR2 I

Canon EOQS XXXX
Firmware Version X.X.X
TR TR b R

Shutter-Pricrity AE
1/1600

8.0

Evaluative Metering

1]

400

OFF

EF70-200mm f/4L USM
188.0mm

prteseeied

Auto

Manual focusing
Landscape

4

1]

1]

1]

sRGB

0:0ff
0:5tandard
0:Disable
3:Disable
Disable

No

KAHKKB
Continuous shooting
OFF

r R

800

I

_ IMG_0001.CR2

data }

Shooting Information | M

Description a

[Document Title]
XXANKKAX

[Author]
XXANKKAX

[Author Title]
XXANKKAXK

[Description]
XXANKKAXK

[Description Writer]
XOXXNXK

[Keywords]
XXAXKHAXK

[Copyright Status]
XOKXXNXK

[Copyright Motice]
XXAXKHAX

[Copyright info URL]
XXANKKAX

Shooting information is displayed in the [Shooting Information]
tab sheet, while IPTC* information appended to the image after
shooting is displayed in the [Metadata] tab sheet.

IPTC* information provides additional comments on images,
such as captions, credits and the shooting location. The
information is sorted into 5 different categories and can be
viewed by selecting [Description], [IPTC Contact], [IPTC Image],
[IPTC Content] or [IPTC Status] from the list box in the [Metadata]
tab sheet.

IPTC* information can only be appended to JPEG/TIFF images
using Photoshop (CS3 or later).

* International Press Telecommunications Council (IPTC)

The contents of the [Shooting Information] tab sheet will vary
depending on the camera model.

Y
~
NS

Convenient uses in the main window

Difference with the [Thumbnail with information]

Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in [View]
menu » [Thumbnail with information] (p.10).
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Editing an Image

This section explains how to adjust an image using the tool palette in the
edit window.

You can easily restore an image to its original condition with the []
button even if you have made the wrong adjustment. Try out the various
adjustments.

How to make adjustments using the [RAW] tool palette functions, and
how to adjust automatically with the [RGB] tool palette are explained in
this section.

Tool palette

| BT

Edit window

— —— J

The image changes in real time according to adjustments
performed with the tool palette.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <38> +
<Z> keys.

|§| You can rotate an image in the [Adjustment] menu.
You can adjust an image while comparing the images before and
after adjustment (p.51).
You can synchronize multiple images and edit while comparing
them (p.52).
See p.127 for a list of edit window functions, and p.128 for a list of
tool palette functions.

About the RAW Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your
editing requirements.

Adjustments similar to those that can be performed with the functions of
your camera can be performed using the functions of the [RAW] tool
palette. When the camera settings were incorrect during shooting, or
when the shooting result is not what you visualized, you can get closer
to what you envisaged with the [RAW] tool palette which is similar to the
camera.

All functions other than [RGB] tool palette automatic adjustment, and
each function of the [NR/ALO] and [LENS] tool palette are explained in
Chapter 3.

Editing with the Tool Palette in the Main Window

By clicking the [Tool palette] button (p.124) in the toolbar on the main
window, the same tool palette that appears in the edit window is
displayed and you can edit images.
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Adjusting Brightness

The brightness of an image can be adjusted. Move the slider to the right
to make the image brighter and to the left to make the image darker.

{ RAW | RGB NR/ALO LENS |

Reverts the image to

|l e i [ ) the original settings
T b l( '3-0011 Enter a numerical
|While balance adjustment h.?,.,d| value
@ tuto) %) (Ture...)

Drag the slider left or right

|§| The adjustment range is —2.0 to +2.0 (in 0.01-stop increments when
entering a value).

Changing a Picture Style

If the image you shot is different to what you visualized, you can change
the Picture Style to get closer to what you envisaged.

Even if you have saved the image (p.41) with [Monochrome] (p.30)
selected, you can still change to another Picture Style at any point by
simply selecting a Picture Style other than [Monochromel].

|Picture Style (-_PH,_.J]— Reverts the image to

l @ES{M dard) - ' Browse...

A

h—ll}_ﬂ =30 -6.0 =40 -20 0 20 40

@ Even if the RAW image is from a camera that does not have
Picture Style settings, you can still set a Picture Style as long as
the RAW image is compatible with DPP (p.3).

You can retain the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings, even if you change the
Picture Style (p.92).

[Auto] is only applied to images shot with the EOS-1D X, EOS-1D C,
EOS 5D Mark I, EOS 6D, EOS 7D Mark Il, EOS 70D, EOS REBEL
T5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/650D, EOS
REBEL T3i/600D, EOS REBEL T5/1200D, EOS M2 or EOS M.
When changing a Picture Style with several images selected, you
can select [Auto] if images shot with the EOS-1D X, EOS-1D C, EOS
5D Mark I, EOS 6D, EOS 7D Mark Il, EOS 70D, EOS REBEL T5i/
700D, EOS REBEL SL1/100D, EOS REBEL T4i/650D, EOS REBEL
T3i/600D, EOS REBEL T5/1200D, EOS M2 or EOS M are included.
However, [Auto] is actually applied only to images shot with the
EOS-1D X, EOS-1D C, EOS 5D Mark Ill, EOS 6D, EOS 7D Mark I,
EOS 70D, EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS
REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T5/1200D,
EOS M2 or EOS M.

You cannot select [Auto] with multiple-exposure RAW images
created on the camera.
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Picture Style

@)

Standard

Auto

Portrait

Landscape

Neutral

Faithful

Monochrome

Description

The Picture Style set on the camera when the
image was shot.

When a mode in the Creative Zone is selected on
the camera, the Picture Style setin () is
displayed.

When a mode in the Basic Zone is selected on
the camera, [Shot settings] is displayed in (), and
image characteristics that are according to the
selected shooting mode are applied.

The image looks vivid.

Generally, this setting is suitable for most images.

The color tone will be adjusted to suit the scene.

The colors will look vivid. Especially the colors of
blue skies, greenery, and sunsets will be vivid in a
shot of nature, outdoor, or sunset scenes.

For nice skin tones.

Effective for close-ups of women and children. By
changing the [Color tone], you can adjust the skin
tone (p.30).

For vivid blues and greens.

Effective for making images of landscapes
impressive.

For natural colors and subdued images.

Effective for base images which are to undergo
adjustment.

When the subject is photographed under a color
temperature of 5200K, the color is adjusted
colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment.

For black and white images.
You can also adjust with [Filter effect] or [Toning
effect] (p.30).

Picture Style

(Picture Style file
registered in the
camera)

[Picture Style file
applied in DPP]

Description

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

The name of the Picture Style file applied in DPP
is displayed in [].

Picture Style File

A Picture Style file is an extended function file of Picture Style. See p.57
for how to use Picture Style files.
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Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source at the time of shooting an
image of, for example, pale-colored flowers.

Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.
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| RAW | RGB NR/ALO LENS !
|Erighrness adjustment - |
IIIIIIIIIIImIIIIIIIIIII E-DD
|White balance adjustment U - l Reverts the image to
[#] 1] 2] 3 |( Register.. ) the original settings
['L @ (Auta) - ﬁITune...j

Select

& () is the white balance set on the camera when the image

was shot.

« When a mode in the Creative Zone is selected on the camera,
the white balance set in () is displayed.

* When a mode in the Basic Zone is selected on the camera,
[Shot settings] is displayed in (), and image characteristics that
are according to the selected shooting mode are applied.

« If you have corrected white balance, the correction value is
displayed in ().

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (this page).

AL/

=@< Tune with color tone
To make further fine adjustments to color tone after adjusting the white

balance, you can use [Color tone] (p.30) to get closer to your requirements.

© You cannot register the adjustment results as personal white
balance (p.98) when you have selected [ g ( )] from the list box.
You cannot change or adjust white balance with multiple-

exposure RAW images created on the camera.

|§| Refer to your camera’s Instruction Manual for details on each white
balance setting.

| RAW | RGB NR/ALO LENS !
‘Erighmess adjustment - ‘
||||||||||Im||||||||||| E-DD
White balance adjustment =] ‘
7] [ 1 ]2 [ 3 ](Register.” .
L~ - ' — S Click
(Auta) -.] | Tune... }

% Click on a point that is to be the standard for white.

Click

Reverts the
image to the
original settings

The coordinates of the cursor position and the
RGB values (8-bit conversion)
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The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, click the [[#]] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

|§| The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.
You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast
weaker.

|
[Picture Soe [ ® | Reverts the image to
S — 3 (arowse..) the original settings

A

LS i 4 ke
-10.0 -30 -60 -40 -20 O 20 40

Contrast: {0) ﬁ‘ Drag the slider left or
Highlight: (i) e——— right (9 steps)
Shadow: 0 '.—.T._’.@.—.—.._T
| Linear
Color tone: o T@T
Colar saturation: 10) '—.—.—._.‘@.—.—._.—
Unsharp mask | :!
Strength: {0 m
Fineness: ] m
Threshald: {0 m

Displays the value of the setting

=@ [Linear] - A function for advanced adjustment

Use [Linear] when you will be adjusting separately using image editing
software that has advanced editing functions. Note that when [Linear] is

checkmarked, the image will become dim.

@ The Auto Lighting Optimizer (p.59) will not function when [Linear] is

checkmarked.
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Changing Color Tone and Color Saturation

Skin tone and overall color saturation can be adjusted.
If Picture Style (p.26) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (this page).

| Picture Style

[ ® - Reverts the image to

& (Standard)

W) (Browse... ) the original settings

W

g

A

r‘-~1I]_0 -8.0 -6.0 -40 -20 O 2.0 4.0

Contrast: (a '—u—u—.-.eu—u—.-.‘
Highlight: [ By s
Shadow: 0 m

! Linear
Color tone: (U ey et TDrag the sliders
Color saturation: (W) s left or “ght

Unsharp mask | :]

Strength: {0) m

Fineness: a m

Threshold: [ )] m

Displays the values of the settings

Color tone: Mainly used for adjusting skin tones. Move the

Color saturation:

slider to the right to make skin tones more
yellow, and to the left to make skin tones
redder.

The overall color depth of the image is
adjusted with color saturation. Move the slider
to the right to make the color deeper, and to
the left to make the color weaker.

@ The adjustment range is —4 to +4 (in 1-stop increments).

Adjusting Monochrome

When the Picture Style (p.26) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering and with the
look of a single-color photograph.

Select [Monochrome] in the [Picture Style] list box.

|Pictur& Style [ » —— Reverts the image to

W Browse... ) the original settings

| Monochrome

W

__

n—-iﬂ.ﬂ -30 ~6.0 -40 =20 O 20 4.0

A

Caontrast: ] T
Highlight: ] S —
Shadow: 0 T.QT
| Linear
Filter effect: None)| == Drag the sliders
Tl atect iNane)(O)——— 4| left or right
Unsharp mask ! 3!
Strength: {0) QT
Fineness: o m
Threshald: {0) m

Displays the values of the settings
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Filter effect: Creates an image where the white of clouds and the
green of trees are emphasized in the same
monochrome photograph.

Filter Example of effect
None General monochrome image without filter effect.

Blue sky is reproduced more naturally and white

Yellow
clouds emerge clearly.
Orange Blue sky becomes somewhat darker. The
9 brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red ;
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

Toning effect: You can create a monochrome photograph to which a
single color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

Y
~ -

2> Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider closer to the right.

Adjusting Image Sharpness

You can make the overall atmosphere of an image sharper or softer.
Adjustment can be made by selecting from two modes, [Sharpness] and
[Unsharp mask].
[Sharpness]: Controls the sharpness of an image by adjusting the
level of emphasis for the outline of the image. The
further to the right the [Sharpness] slider is moved (the
larger the setting), the more the edges are
emphasized for a sharper image.

[Unsharp mask]: Adjusts the image’s sharpness more finely.

[Strength]: Shows the level of emphasis for the outline of the
image. The further to the right the slider is moved (the
larger the setting), the more the image’s edges are
emphasized for a sharper image.

Shows the fineness of the emphasized outline. The
further to the left the slider is moved (the smaller the
setting), the more fine detail can be emphasized.
Sets “how much contrast difference there should be
compared to surroundings before emphasizing
edges”.

[Fineness]:

[Threshold]:
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Select [Sharpness] from the list box and make the
setting.

| Picture Style

[EJ]J— Reverts the image to

[ @ (standard)

"

78] (Browse..) the original settings

A

rt--ll]_lfl T e 20 4.0

Contrast: L) S, A

Highlight: {1 esemoun - oy

Shadow: L b SR
! Linear

Color tone: 1o T@T

Color saturation: 10 T@T

{ sharpness 49} Select [Sharpness]

Sharpness: Vvl B

IIDrag the slider left or right

Displays the value of the setting

|§| The adjustment range is 0 to 10 (in 1-stop increments).

Detailed Setting of Image Sharpness
Select [Unsharp mask] from the list box and make

the setting.

‘ Ficture Style

B

| @ (Standard)

e ] (Browse... :‘,

¥

x|

"100 -3.0 -6.0. -4.0 -2.0
Contrast:
Highlight:
Shadow:
| Linear
Color tone:

Caolor saturation:

{mllll Il

o |||||i|||||
o |||||i|||||

{OJ LI I I | { ek Bl R
{OJ LI L I I |
=1}

l Unsharp mask

L

Strength:

Fineness:

Threshold:

Displays the values

of the settings

Select [Unsharp mask]

Drag the slider left or right

? The effects of sharpness adjustment appear unnatural

Adjust image sharpness with the window view set to [200% view],
[100% view] or [50% view]. If the view is set to [Fit to window] (full view),

the effects of adjustment may seem unnatural.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, the image tone
curve can be adjusted automatically (p.143). You can select the degree
of automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired
automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

'} NRfALO LENS *
Tone curve assist i+ | Reverts the tone curve
Tone curve adjustment ( | to the original settings
'''''' i KN
255 | Vi High
Standard
D ol
0 255
Eﬂghtﬂess trrrrrerrfrrrrn et Dz
Contrast: "““‘@"““ e
Hue ey erenn |‘-?r‘! DE
Satur‘lr“}n ety reny |bi lDD 3
Sharpness: e—ibl 0 ?

The tone curve changes as adjusted.

A/
~ -

:@: Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

¢ Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

« Images which have extreme backlighting

(D It you click the [(E25]] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.107).
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Editing Efficiently
Editing in the Edit Image Window

The thumbnail display and the edit window are combined, and images
can be edited efficiently while quickly switching between images to be
edited. Images to be edited are to be selected beforehand in the main

window.

In the main window, select the images you want to edit.

Switch to the edit image window.

806
=S i &
Folder Collection(()

¥ 2l ENG
Bl & Applications ;
L 'Ln Developer r
B [ Photn i

Click

The main window switches to the edit image window.

Edit the image.
Change the size
Edit image window

Frofesvienat =

o e I g e

Select the image to be edited
The selected image is displayed as an enlargement in the
middle of the window

It may take time for the image to redraw itself.

The same tool palette as in the edit window is displayed and you
can edit the image.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <38> +
<Z> keys.

@ By selecting the [View] menu » [AF Point] in the edit window or edit

image window, you can display the AF points selected in the camera
at the time of shooting. However, AF points are not displayed for
images whose image size has been changed and then been
converted and saved (p.42, p.134), images for which you selected
an effect other than [Shot settings] as correction of fisheye lens
distortion aberration, or images which have had settings specified
during RAW processing on the camera for distortion correction and
chromatic aberration correction.
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Double-click the area you want to enlarge.

o i i b

TS Vew Label Admit Tooh W ) W e wesl00aAM @ |

Double-
click

B O g e

The area you double-clicked is enlarged to 100% (actual pixel
size).

To change the display position, drag on the image or drag the
enlargement display position (p.128) of the tool palette.
Double-click again to revert to the full view ([Fit to window]).

To return to the main window, click the [Main Window] button on
the toolbar.

== To display an image in an enlargement ratio other than 100%

Click the [50% view] or [200% view] on the toolbar.

5

You can change the way the tool palette is displayed (p.92).
You can change the enlargement ratio when you double-click
(p-91).

With the edit image window, you can only select images from a
single folder. To gather images from several folders for editing,
see “Gathering and Editing Images in the Collection Window”
(p-36).

For a list of edit image window functions, see p.133.
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Changing the Thumbnail Display Position to Horizontal

Select the [View] menu » [Change thumbnail

position].

| ————

If you select [Change thumbnail position] again, the thumbnail
display reverts to the vertical position.

Gathering and Editing Images in the Collection Window

You can gather any randomly selected images together in the
[Collection] window for viewing, comparison and editing. You can gather
images from several folders as well as from only one folder, allowing you
to work with them efficiently.

Select images from the [Folder] window in the main

window, and select the [File] menu » [Add to collection].

Open in Edit window #0
Open in Edit window (enlarged)
Close all
Open window BN
Close window BW
Save #S
Save As... {+385
Add thumbnail to image and save 38T
Convert and save... ¥D
Batch process... ®B
Create new folder {+38N
Print... #/P
Print with detailed setting... %D
Print contact sheets... ~HP
Plug-in printing 2
[ Add to collection ®G
Remove from collection a0

The selected images are added to the [Collection] window and the

number of selected images is shown on the [Collection] tab sheet.

When you add RAW and JPEG images displayed as a single
image (p.22), the number of images shown on the [Collection]
tab sheet increases by 2.

You can select several images and add them to the [Collection]
window.

You can also add images to the [Collection] window by selecting
images, clicking on the image while holding down the <control>
key, and selecting [Add to collection] from the menu that appears.
You can add up to 1,000 images to the [Collection] window.
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Select the [Collection] tab sheet.

8006

Folder

i &

Collectionil4)

v = MacDsx
b | & Applications
[ ¥ Temporary Items
¥ |& Users
v @ canon

The selected images are displayed in the [Collection] window.

Check displayed images in the [Collection] window.

@ Digital Pheto Professional File  Edit View Bookmark Label  Adjustment

Aditre BGE | Adabe HCE

High qualty  Recipe data: Ne Stuamiber of images 7

Tools Window Help

-4 Wed 046 AM G

Edit the images.
You can now edit the images displayed in the [Collection]

window.

Images displayed in the [Collection] window are retained in the
[Collection] window even after quitting DPP.

|
\\/

:@5 To remove images from the [Collection] window

Removing randomly selected images
Select the images to be removed in the [Collection] window and then
select [Remove from collection] in the [File] menu. (You can also remove
images from the [Collection] window by selecting the images, clicking on
the image while holding down the <control> key, and selecting [Remove
from collection] from the menu that appears.)
Note that even if you remove an image from the [Collection] window, the
original image remains unaffected.

Removing all images
Select [Clear collection] in the [File] menu. (You can also remove all
images from the [Collection] window by clicking while holding down the
<control> key, and selecting [Clear collection] from the menu that
appears.)
Note that even if you remove all images from the [Collection] window,
the original images remain unaffected.

® Modifications to the image are applied to the original image
Modifications made to images added to the [Collection] window are
all applied to the original image.

|§| You can arrange images displayed in the [Collection] window the
same way as in the [Folder] window (p.20, p.21). You can
maintain the order of rearranged images even after quitting DPP
by checkmarking [Retain sort order] on the [View settings] tab
sheet in the [Preferences] (p.91).

You cannot use the following functions in the [Collection] window.

« Starting EOS Utility (p.7), or synchronizing folders with EOS
Utility
» Batch change the file name of images (p.101)
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Trimming and Adjusting the Angle of an Image

Adjust the angle of the image as needed.
Trimming/angle adjustment window

£ 171 IMG_D001.CR2 (3456 x 2304]

You can crop only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes

vertical. You can also adjust the angle of an image before trimming. If
you select [Circle] for [Aspect ratio], the area outside the specified range

is only masked in black and the image will not be cropped.

Select the image to be trimmed.

Open the trimming/angle adjustment window.
Click the [Trimming Angle] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

Rotare feft Rotate right Cuick Stamp Trimming Batch
check

B il

The trimming/angle adjustment window appears.

Editing can be done once the image is displayed clearly in the

trimming/angle adjustment window.

Largest
possible
trimming
range

Click
(rotate
image left
or right in
90-degree
increments)

L334 351 ) -> ¢ ZHTDAS Y  LOOY R 162 ) [ 150 4

!
Drag* (0.01-degree increments;
adjustment range: -45 to +45 degrees)

Use the mouse (click A/V) to adjust the angle or
directly enter the adjustment angle* (0.01-degree
increments; adjustable range: -45 to +45 degrees)

* You cannot adjust the angle of images that exceed 9999 x 6666
pixels in size.

If you click [Center on Screen], you can display the trimming
range in the center of the window.

When correcting lens aberrations, it is recommended to perform
lens aberration correction before adjusting the angle of the
image.

If you click the [OK] button after adjusting only the angle of the
image, the image will be trimmed at the largest possible trimming
range.

|§| When aspect ratio information is attached to an image shot with the

EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D
Mark Ill, EOS 5D Mark Ill, EOS 6D, EOS 7D Mark Il, EOS 7D, EOS
70D, EOS 60D, EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS
REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T5/1200D, EOS
M2 or EOS M, the trimming range based on the aspect ratio information
is displayed.
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Select aratio and drag the trimming range.

CTala) * 171 IME_O001.CRZ [3436 x 2304]

Cancel

Select a
trimming
ratio

Drag the
trimming
range

A704, 362 ) -> {2201, 410 ) = {4577 x 0051 )| 150 P

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range. (Not available
when [Circle] is selected.)

List of aspect ratios (width : height)

1:1

3:2

2:3

4:3

3:4

5:4

4:5

A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

Circle

[Free]: You can trim an image to any size, regardless of the
selectable ratio.

[Custom]: You can trim an image at the specified ratio.

[Circle]: The area outside the specified range is masked in
black. The image is not trimmed.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.126).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its trimmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at

any time

A trimmed image is displayed or printed as a trimmed image.

However, since the image is not actually trimmed, you can always

revert to the original image by clicking the [Reset] button in the

trimming/angle adjustment window or performing the “Re-Editing an

Image” procedure (p.43).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.126).

« Edit window: The image is displayed in its trimmed condition.

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when converted and saved
The trimmed RAW image actually becomes a trimmed image when
converted to a JPEG or TIFF image and saved (p.42).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D
Mark 1ll, EOS 5D Mark Ill, EOS 6D, EOS 7D Mark Il, EOS 7D, EOS
70D, EOS 60D, EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS
REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T5/1200D,
EOS M2 or EOS M, the set trimming range based on the aspect ratio
information is displayed. Since the image is not actually trimmed, you
can change the trimming range or revert to the condition before
trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 5D Mark Ill, EOS 6D, EOS 7D Mark Il, EOS
70D, EOS 60D, EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS
REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T5/1200D,
EOS M2 or EOS M, its trimming range cannot be changed nor
reverted to the condition before trimming, since the image is actually
trimmed and saved in the set trimming ratio.*

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.135).

* When shooting with EOS 5D Mark Il or EOS 7D Mark I, and [Add
cropping information] is set in Custom Functions, aspect ratio
information is only set and the image is not actually trimmed, even
for JPEG images.

-@> Convenient functions of the trimming/angle adjustment
window

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

To select multiple images in the main window, click the images while
holding down the <3£> key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <shift> key.

© For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view the image in detail in the
trimming/angle adjustment window, so using this function is not
recommended.

|§| For a list of the trimming/angle adjustment window functions, see
p.135.
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Applying Adjustment Contents to Other Images

You can copy the image adjustment contents (recipe) adjusted with the
tool palette and apply it to other images.

You can efficiently adjust multiple images by adjusting one image and
applying the results of this to multiple images shot in similar shooting
environment.

Select the adjusted image and then select the [Edit]

menu » [Copy recipe to clipboard].
The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu P [Paste recipe to
selected image].

The recipe is applied to the image.

|§| The recipe (p.96) can be saved as a separate file from the image
and loaded and applied to another image (p.97).

Saving Editing Results
Saving Editing Contents to a RAW Image

All the contents (recipe) adjusted with the tool palette as well as the
trimmed (p.38) range information can be saved to a RAW image or to a
separate RAW image.

The adjustments made with the tool palette (p.54 to p.67) and the dust
erase processing explained in Chapter 3 (p.73 to p.77) can also be
saved in a RAW image.

Select the [File] menu » desired item.

Open in Edit window #®0
Open in Edit window (enlarged)

e all
Openwindow
Close window BW
Save #S
Save As... 35S
Add thumbnail to image and save 3T
Convert and save... ®D
Batch process... )
Create new folder 8N
Print... #P
Print with detailed setting... 48D
Print contact sheets... ~HP
Plug-in printing >
Add to collection ®G
Remove from collection 4 #8C
Clear collection
Delete &
Info |

Your adjustments are saved to the image.
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Saving as a JPEG or TIFF Image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

The image is saved as a separate image, so the RAW image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

Open in Edit window #0
Open in Edit window (enlarged)
Close window e
Save #S
Save As... 4+ 385
' Convert and save... ®D l
Batch process... #*B
Create new folder £+ 38N
Print... #P
Print with detailed setting... 438D
Print contact sheets... ~HP
Plug-in printing »
Add to collection ®G
Remove from collection 488G
Clear collection
Delete 8 <&
Info £

The [Convert and save] window appears.

Specify the necessary settings, and then click the

[Save] button.
By default, the image is converted and saved to a JPEG image

with the highest image quality, without changing the image size.

Change the settings according to your requirements.

0.6 Convert and save

Enter a file name

(Save As: | IMG_0001

Tags:

(Whera (5] Desktop )7 Se|eCt the save

EE— destination
Select an image type

(Kind of file | Exif-JPEG 2] )
Image quality T . YV

Output setting
Ourput resolution 350 dpi (¥ Embed ICC profile

Resize setting
| ] Resize V! Lock aspect ratio
Width Height Unit
5472 x 3648 pixel
(5472 pixel ) (3648 pixel )

Shooting info setting

() Include all shooting info
( ;-Rsmovs only GPS info
(") Remove shooting info

Cancel '| Save \}7

The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.

Click and save

AL
~

=)= To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two different versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

|§| By saving as explained on this page, a trimmed image (p.38) or
dust-erased image explained in Chapter 3 (p.73 to p.77) actually
becomes a trimmed image or dust-erased image.
You can reduce the noise characteristic of JPEG images which

occurs when you convert and save an image as a JPEG (p.90, p.91).

You can batch convert and save multiple images (p.99).
For a list of [Convert and save] window functions, see p.134.
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.25 to p.33), so the “original image data itself”
remains unaffected.

Also, the trimming range information of a trimmed image (p.38) is simply
saved to the image.

For this reason, you can undo any adjustments saved (p.41) to the
image, trimming information, and revert to the condition when last
saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Rotate left L
Rotate right 3R
Work color space >
Tone Curve Assist - 5tandard

Tone Curve Assist - High

Revert to last saved settings “_3Z
Revert to shot settings ~¥Z

The image reverts to the conditions of the selected item.

Printing an Image

This section explains how to print high-resolution photographs easily
with Canon inkjet printers compatible with the Canon printing software,
Easy-PhotoPrint EX. It also explains how to print photographs using
other printers.

Proceed to the page for the printer you are using.
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint EX (this page)
Printing Photographs with a Printer other than Canon Inkjet Printers
(p.46)

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint EX

You can perform the following types of photograph printing with Canon
inkjet printers compatible with Easy-PhotoPrint EX (hereinafter, “EPP
EX") :

Simple printing of RAW images

Printing with faithful colors

To perform this printing, it is necessary to first install EPP EX version 1.1
or later on your computer.
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Select the image to be printed.

Start up EPP EX.

Select the [File] menu » [Plug-in printing] » [Print with Easy-

PhotoPrint EX].

Print with Easy-PhotoPrint EX )‘

Open in Edit window #0
Open in Edit window (enlarged)

Close all

Open window F#EN
Close window ®W
Save ®S

Save As... {+3S

Add thumbnail to image and save 3T
Convert and save... ®D
Batch process... #*B

Create new folder 138N
Print... #P

Print with detailed setting... {+3D
Print contact sheets... ~38P

Add to collection £
Remove from collection 380G
Clear collection

Delete # <@
Info £ |

EPP EX starts up.

In the EPP EX window, select the [File] menu »
[Preferences].

My Recent Files b

Next Step

Preferences...

The [Preferences] window appears.

In [Print Quality], select [Quality Priority], click the
[Option] button. In the dialog box that appears,
checkmark [Print with the best quality].

(600 Preferences ]
[ Print Advanced

Number of copies : 1 i ; Copies

Printing Order 7By' Date Tl

Amount of extension of borderless printing : = Default ﬂ

Print Quality (“Quatiypriony ) }—————— Select
= { Option... w’ Qua“ty

Priority

Defaults

Help ) { Cancel _n( oK }

Click and checkmark [Print with the best quality]
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Select the [Advanced] tab, checkmark [Enable ICC
profile], and then click the [OK] button.
The [Preferences] window closes.

Specify the number of sheets to be printed, and then
click [Select Paper].
EPP EX

ana Meew Phoco Print - Eavy-PhotoPrint £X
Sooecy B musmier of copeed 1 prn 1t mach image

Exif Pt

e ﬂi Eﬁ = i s
ms osmy ohS e *;.“:*. S0®—="=—Clickto
b ‘ a increasethe
ﬂm“ i

o ey s number of
sheets to be

h printed

Select the paper type, and then click the [Layout/
Print] button.

anA Piew Photo Print - Easy-FhotoPrin EX
S ‘ . "’ Exif Pint
e Cwen 08 )
(9 tromume_ L] (e i .
it A Select the
Pl paper size
o A and type
e |
| [ B
Click

Specify the layout, and then click the [Prlnt] button.

Exif Prnt

Select the
layout

e 331 e rad Inaite Pages

[ e | |

Click to print
Printing begins.
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? Additional information

Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

The printed image’s color is not what you expected

In the EPP EX window, select [Preferences] in the [File] menu and
then click the [Advanced] tab in the [Preferences] window to display
the [Advanced] tab sheet.

In the [Advanced] tab sheet, select [Enable ICC profile] in [Color
correction for printing] and try printing using the [Perceptual] setting
(p.144).

|§| DPP is also compatible for printing with Easy-PhotoPrint Pro
(p-87).
Note that since EPP is not compatible with Mac OS X 10.8 or
later, printing is not possible with a computer running on Mac OS
X 10.8 or later.

Printing Photographs with a Printer other than Canon Inkjet Printers

You can print one image on one sheet of paper.

Select the image to be printed.

Select the [File] menu » [Print].

e

Open in Edit window
Open in Edit window (enlarged)

Close window

Save
Save As...

Add thumbnail to image and save

Convert and save...
Batch process...

Create new folder

#O

HEW

)
{+#5
48T

®D

B

43N

Print...

%P )

Print with detailed setting...
Print contact sheets...

Plug-in printing

Add to collection

Remove from collection

Clear collection

Delete
Info

43b
~EP

£
4 #C

#&
|

The [Print] dialog box appears.

Printing begins.

Set to photograph printing and print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [Print] button.
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Organizing Images
This section explains how to delete unwanted images, create folders for
saving images, move or copy images, etc., and organize your images.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Delete].

i |

Open in Edit window FO0
Open in Edit window (enlarged)

Close window W
Save #S
Save As... {r 35S
Add thumbnail to image and save 38T
Convert and save... ®D
Batch process... #*B
Create new folder {+3¥N
Print... ®P
Print with detailed setting... 4 #D
Print contact sheets... ~3HP
Plug-in printing »
Add to collection £
Remove from collection +3#C
Clear collection

Delete 3%@)
Info E|

The image is moved to the [Trash] and is deleted from DPP.
The images are deleted completely from your computer by
selecting the [Finder] menu » [Empty Trash] on the desktop.

Creating a Folder for Saving Images

You can create a folder for sorting images.

In the folder area, select the location where the new

folder is to be created.

ano Digital Photo P|

i1 13,

Folder Collection(0)
v 2} Macosx
P |4 Applications
[F Temporary Items
¥ [£ Users
v & canon
» [ Desktop
» [ Documents
- (@ Library
= Movies

& Music

» [ sites
P |2 Shared

Select the [File] menu » [Create new folder].

Open in Edit window #®0
Open in Edit window (enlarged)

Close window BW
Save kY
Save As... {35
Add thumbnail to image and save 3T
Convert and save... ®D
Batch process... #B

[ Create new folder Q%N )

Print... P
Print with detailed setting... 48D

The dialog box for entering a folder name appears.

Enter a folder name and click the [OK] button.

The new folder is created in the folder selected in step 1.
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Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Introduction

—_—

Contents at
a Glance

~

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <option> key
and release when the image is in the destination
folder.

Digital Photo Professiong

Folder ~ Collection(®)
v 54 MacOSX
» |A Applications

[¥ Temporary Items
¥ |& Users
v 4 canon
¥ [BE Desktop
& Travel
» % Documents
» |® Library
& Movies
& Music
¥ |2 Pictures
¥ [ photo
[ 3000 _xx _xx
P [& Public
» [1 Sites
» [ Shared =

o B 5
The images are moved or copied to the destination folder.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <option> key
and release when the folder is in the destination folder.

Digital Photo Professiong

v = MacOsx
B |4 Applications
[ Temporary ltems
v [ & Users
¥ @ canon
¥ [@§ Desktop
[ Travel
» |3 Documents
P |# Library
|® Movies
| # Music

® .,
== IMG_0001.CR2
A p

» (& Public
» | Sites
» [ shared =y

The folders are moved or copied to the destination folder.
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Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders appear by clicking the [Bookmark] menu.

Select the folder for which a bookmark is to be

registered.
/8068 Digital Photo Profession,
2 ([ = L
Folder Collection(0)
¥ =4 MacOSX
» A Applications
|7 Temporary ltems
¥ |& Users
v 4 canon
¥ [BE Desktop
& Travel
» % Documents
» |® Library
# Movies @ @
i Music IMG_0001.CR2
v (i Pictures " 2
v
13 o - & Select
> @ . :
» [ sites —
» [ shared
e

Select the [Bookmark] menu » [Add].
The folder selected in step 1 is registered in the [Bookmark]
menu.
Select a registered folder from the [Bookmark] menu to display
images in the selected folder in the main window.

Organizing Bookmarks

You can change a folder name or delete a folder registered in
[Bookmark].
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3 Advanced Image Editing and Printing

Introduction
Various preferences including advanced image adjustment, automatic Using the Digital Lens Optimizer ...........ccccccceeeeeeen. 68 T
dust erasure processing, various printing functions for printing out work, Compatible Cameras 68
and color management are explained here, geared to the user who is o~ T Contents at
1anag . P re, geared Compatible LENSES........ccccccvveiiieiiiie e 68 a Glance
competent in the handling of third-party image editing software. ) L. L -
Using the Digital Lens Optimizer.........ccccccceevveeeeeennnnns 70
Adjusting While Comparing with the Original Image... 51 Performing Automatic Dust Erasure Processing..... 73 OpBe‘j‘Z‘tfon
Changing How the Window is Split...........cc.coeceevne.... 51 Compatible Cameras..............ccccciii, 73
Adjusting by Comparing Multiple Images................. 52 Automatic Dust Erasure Processing in the Main Window... 74 .
Dlsplaylng an Area Beyond the Set Range as a Manua”y EraS|ng DUSt (Repalr FUI’]C'[IOH) ................ 75 Operation
Warning Indicator (Highlight/Shadow Warning) ....... 53 Erasing Unwanted Parts of an Image (Copy Stamp
Performing Advanced Editing.............o..oovvveovvve. 54 Functlo-n) ..................................................................... 77 Imgcé%?ﬁ?ng
Adjusting White Balance with Color Temperature _____ 54 TranSfernng a RAW Image to PhOtOShOp ................ 77 and nting
Tuning White Balance with Color Wheel ................... 54 Setting Work Color Space- ..., 7 Processing
Adjusting Dynamic Range ...........cccccvvveeeeeeeeeeeieeennnen, 55 Compositing Images........coccoviiieiiiieeeciee e, 78 Lar%ei Numbers
Adjusting Brightness of Shadows/Highlights ............. 55 Compositing Methods.............cccooo g1 2=
Tone Curve Adjustment............cccovvveviiiiiieiiiiieeeeeeiee, 56 Creating HDR (High Dynamic Range) Images........ 81 Edit}ng
i . . JPEGITIFF
I.Exampl.e of a Tone (‘Turve Operation .................... 57 Starting Up Map ULty .........cocveeieiiereceeceeecee e 84 Images
;J‘Emg ahplglcj;s ?tyl:ePFllle """""""""""""""""""""""" 2; Printing with Shooting Information........................... 85
_ outthe _ 00_ aette. T Printing a Thumbnail List (Contact Sheet Printing)...... 86 Reference
Using 'Fhe AuFo Lighting Optimizer.........cccccoeeeevennnnn. 59 Printing RAW Images on a High-End Canon Printer ... 87
Reducing NOISE.........uciiiiiiiiiiie e 60 Printing with a High-End Canon Inkjet Printer ............ 87 M
Correcting Lens Aberration ..........cccoeevvevviiieieeeeennnnnn. 61 Printing with DPP and Easy-PhotoPrint Pro........... 87 Index
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Compatible LENSES ..o 61 Printing with a Large-Format Canon Printer .............. 89
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Adjusting While Comparing with the Original Image S
You can display before and after versions of an adjusted image in the . . . .
same window and adjust while checking the adjustment resullts. Changing How the Window is Split S—

You can change the display of the image to a single image split in two.

Contents at
a Glance

In the edit window, select the [View] menu » [Before/
after comparison].

In the edit window, select the [View] menu » [Display
mode] » [Split smgle |mage]

Basic
Operation

N —

Advanced
Operation

Imag\(ailtmg
and PPinting

| iy e v o ey

=» One image is divided and displayed on the left and right or top

The image divides into a left and right window. and bottom Processing
i i i iti ) Large Numbers
The window on the right shows the image after editing. @ To switch between top and bottom, and left and right, perform the o% Images
Change the image display. same operation as step 2 on the left page. b
Select the [View] menu » [Change up/down/left/right] » [Up/ Editing
down] JPEG/TIFF
. Images
ann - ~ RIS 1
Reference
—
Index
_
- 00
The layout of the two images changes to top and bottom.
The bottom window shows the image after editing. @

|§| Images can also be displayed in the edit image window by the same
operation.



Adjusting by Comparing Multiple Images .
You can synchronize the display position of multiple edit windows and Move the display position.
adjust images while comparing them with each other. If you move the enlargement display position in one of the edit
__ ] ] ] windows, the enlargement display position will also change in the
In the edit window, display the multiple images to be other edit windows. Contents at
compared. To cancel synchronization, select the [Window] menu » —
, : hroni in.
Align the images. [Synchronize] again Basic
Align the images for easy comparison. Operation
Select the [Window] menu » [Synchronize].
Advanced
, Onetai
Enlarge the image. pera a

Enlarge and dlsplay any of the edit windows.

W Degital Fhats Professional e E0n _Vew _ Adjaimen  Tosis Wndew R
o - Epr—

Imag\(ajltmg
and PPinting

i

Processing
Large Numbers

of Images
—_—

" e Editing
JPEG/TIFF

Images
—

T o o A Reference

The other edit windows will also be displayed in the same
position/enlargement ratio. ——

|§| Synchronization only applies to the enlargement display position
and the enlargement ratio. Adjustments to the images are not

synchronized.
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Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning)

You can set up a warning indicator in both the highlighted part and the
shaded part, which is effective for checking the bright and dark areas
and preventing excessive adjustment of an image. Where the area on
the image has exceeded the set range, you can display the highlighted
part in red and the shaded part in blue.

Select the [Digital Photo Professional] menu »
[Preferences].

Select the [View settings] tab sheet.

Enter the warning value for [Highlight] and [Shadow].

-
Preferences

GCeneral settings | Wiew { | Tool palette Color management

Grid pitch
64 Pixels(B-256)

Locking selected image

a Images opened in Edit window remain selected in main window

Magnification in Edit window

=

=) Fit to window ) 50% ) 100% ) 200%

Magnification when the Edit/Edit image window is double-clicked

® 50% O 100% O 200%

RAW and JPEC
E Display only CR2 images for CR2 and JPEC files of the same name

Sort order in main window
™ Retain sart order

Highlight/shadow warning

Highlight 255 | a9z-255) [N
Shadow o) cen

Quick check tool display

@ 50w () 100% (moiré reduction off)

f Cancel 3 (’ DK~ ’

Click the [OK] button to close the window.

Display the edit window.

Select the [View] menu » [Highlight]. Similarly, select
[Shadow].
On the opened image, if there is an area that exceeds the value
entered in step 3, the highlighted part of that area is displayed in
red and the shaded part is displayed in blue.

|§| You can also display the warning with the same operation in the edit

image window.
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Performing Advanced Editing

This section explains how to use the advanced adjustment function on
the tool palette in the edit window.

Adjustments made using the high-level functions of the [RAW] and
[RGB] tool palettes, as well as the functions of the [NR/ALO] and [LENS]
tool palette are explained in this section.

Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

{ RAW | RGE NR/ALO LENS |

‘Eﬂ'ghmess adjustment L...b..._,l‘
e S 0.00
‘Whila balance adjustment "___b_‘”
( Color temperature ﬂm
(=) (ssm0_k)——— Displays the value of the

setting
Drag the slider left or right

|§| The adjustment range is 2500 to 10000K (in 100K increments).

Tuning White Balance with Color Wheel

White balance can be tuned by moving a cursor in the color direction
shown in the color wheel.

In the [RAW] tool palette, click the [Tune] button.

Tune by dragging a point.
You can also fine-tune your adjustment by directly entering the
adjustment values.

o ‘White balance fine adjustment
Colar tone: — Enter the values
Color saturation: to set

Cancel 1 f oK "

Drag

@ To register adjustment results as personal white balance (p.98),
select a setting other than [ ()] from the [White balance
adjustment] list box, and then tune with the color wheel. You
cannot register the adjustment results as personal white balance
when you have selected [ ()] from the list box and have done
any tuning.

You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

|§| The adjustment range of color tone is 0 to 359 (1 increment in
numerical value input), and the adjustment range of color saturation
is 0 to 255 (1 increment in numerical value input).

R

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advapced
Imag iting
and Pfinting

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00

54



R

Introduction

Adjusting Dynamic Range Adjusting Brightness of Shadows/Highlights —
Dynamic range (width of gradation expression) from dark points to bright You can adjust the brightness of shadows and highlights in an image. Contents at
points in an image can be adjusted. By adjusting shadows and highlights in an image with a restricted a Glance

brightness, you can reduce the effects of clipping in shadows and —
|Piclure Style - | hlghllghts :
. — - Move downwards OpBearlZIt(i:on
P@‘S‘“"d““” ] k_“”';“e"': Output highlight points [Pt e 5]
d / : | @8 (Standard) -¢] (Browse...j
Move to the left or right - - . gg‘é?gﬁgﬁ
Input highlight points '
r‘—lllt] S T B e S = .0
o - Advapced
Contrast: {0) T@T i ] ; o L Imag\gﬁting
Highlight: {i1){ =—— 210 ATNGEIR A0 W0 0 20 40 and Pfinting
Shadow: 10 m Contrast: N s i
_ Linear Move upwards Highlight: 0) Drag the sliders left or Processin
Calor tone: {0y T —— Output shadow points Sharow: 11 e s Tright Large Numbegrs
Color saturation: 10) T@T ) Linear of Images
Unsharp mask 4] Colar tone: {0) T@T —
Strength: () e —— Color saturation: (0} T — Editing
Finaness: i0) m Unsharp mask | :! JPEG/TIFF
Threshold: () ME— Strangth: {0 Em— Images
trrrrerr e
. Fi 1 o &

Move to the left or right TI::::I - o @_.

Input shadow points s SErEETEE
The horizontal axis shows the input level and the vertical axis —
shows the output level.

Index
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i Make adjustments.
Tone Curve Adjustment Batch adjusts RGB
You can adjust the brightness, contrast and color of a specific area by Adjusts each channel Contents at
changing the tone curve (p.143). ; : a Glance
RAW | RGB | NR/ALO  LENS -
Tone curve assist | |
In the tool palette, select the [RGB] tab sheet. | 0] G|
Tone cprve adjustment =] ‘ Basic
. — 1 Operation
. . RGB R|c|e| il
Select the tone curve mode and interpolation — o 7]
method.
Advanced
| RAW | RGB | NRJALO = LENS | Operation
|T0ne CUrve assist il Il s | Eb‘
Tone curve adjustment b ‘
— — . . Advamced
RCB IL‘L G|s] {*"fi _ = CII(':k to add a [I;I] (point) |mag\51i_ting
255 : Adjust by dragging [] and Pfinting
{ Processing
Large Numbers
of Images
v Curve a —
Straight < | - BT
<control> + click inside _ Editing
v RGBR GB the graph to d|sp|ay the Brightness: T e 0 i JPEG/TIFF
Luminance RG B menu ANt e B olF) Images
Hue: 3 o i
Saturation: . E 100 i Reference
ol ; Sharpness: [ ) f
- 2] -] S
Sl The horizontal axis shows the input level and the vertical axis
i . shows the output level. Index
S = The maximum number of [] is 8. e
K CECEER A TRTET To delete a [[J], double-click on the [[7].
Saturation: e ] -
Sharpness: B f @ @

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any @
adjustments (p.92). ~—
The tone curve mode and interpolation method for a tone curve

can also be changed in [Preferences] (p.92). 56



Example of a Tone Curve Operation

Makes medium tones brighter

Makes medium tones darker

7

J

-

Makes tones sharper

Makes tones softer

y

Using a Picture Style File

A Picture Style file is an extended function file of a Picture Style.

With DPP, you can apply to RAW images Picture Style files that you
have downloaded from Canon Web site effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
Picture Style file, save it to your computer beforehand.

Display the image to which the Picture Style file is to
be applied in the edit window (p.11).

Select the [RAW] tab sheet in the tool palette, and
click the [Browse] button.

‘F‘icture Style = i‘
[ @ (Standard) E a

s e

A

tiD.ﬂ -3.0 -6.0 -40 -20 O 2.0 4.0

The [Open] dialog box appears.

Select a Picture Style file saved on your computer,
and click the [Open] button.
The Picture Style file you selected is applied to an image.

To apply a different Picture Style file, follow the procedure from
step 2 again.

ﬁl The Picture Style files that you can apply to the camera are files with
the “.PF2” or “.PF3” extension only. Furthermore, you cannot apply
Picture Style files with the extension “.PSE” to an image; however if
such afile is registered in the camera and the image is shot, the
image will display correctly.
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About the RGB Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your
editing requirements.

The [RGB] tool palette functions are the same as ordinary image editing
software, such as tone curve adjustment that is explained here, with
which you can adjust RAW images.

However, because the adjustment width of the functions in the [RGB]
tool palette is wider than the [RAW] tool palette, the image color may be
saturated, or the image quality may deteriorate if you adjust too much.
Therefore we recommend for functions other than tone curve
adjustment (p.56) and automatic adjustment (p.33), that you adjust
images using the same functions available in the [RAW] tool palette.
See Chapter 5 for explanations on functions of the [RGB] tool palette
other than tone curve adjustment.

@< Using the tool palette

We recommend that as a general principle you edit RAW images using
the [RAW] tool palette. However, where the adjustment width with the
[RAW] tool palette is not wide enough and you wish to use the special
functions in the [RGB] tool palette, we recommend that you adjust your
images at the necessary lowest limit with the [RGB] tool palette after
having completed basic adjustment with the [RAW] tool palette.

Use the adjustment function of the [NR/ALO] and [LENS] tool palette
(p.129) when applying the Auto Lighting Optimizer (p.59), reducing
noise (p.60) or correcting aberration (p.61) after you have made any
required adjustments with the [RAW] and [RGB] tool palettes.
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Using the Auto Lighting Optimizer
If the shooting result is dark or the contrast is low, you can use the Auto
Lighting Optimizer function to auto-correct the brightness and contrast,
and obtain a more pleasant image.

You can also change the settings of the image shot with the camera’s
Auto Lighting Optimizer function.

This function is compatible only with RAW images shot with EOS-1D X,
EOS-1D C, EOS-1D Mark IV, EOS 5D Mark lll, EOS 5D Mark Il, EOS
6D, EOS 7D Mark II, EOS 7D, EOS 70D, EOS 60D, EOS 50D, EOS
REBEL T5i/700D, EOS REBEL SL1/100D, EOS REBEL T4i/650D, EOS
REBEL T3i/600D, EOS REBEL T2i/550D, EOS REBEL T1i/500D, EOS
REBEL T5/1200D, EOS REBEL T3/1100D, EOS M2 and EOS M.

* ALO stands for Auto Lighting Optimizer.

Select the [NR/ALQO] tab sheet from the tool palette in
the edit window or edit image window.

" rRaw  RGB | NRjALO | LENS |
|Autu Lighting Optimizer |
@ 1 1
Low Standard  Strong
|Noise reduction Apply |
RAW | MR Preview... |
Luminance noise reduction
{21 D tirrrrrrrrrrrrrrrennn 20
Chrominance noise reduction
{5] D trrrrrrrrrreerrnnrnen 20
TIFF/JPEG
Luminance noise reduction
) 0 20
Chrominance noise reduction
[(4]] 0 20

Checkmark the checkbox.

" RAW RGB | NR/ALO | LENS '

‘Autu Lighting Optimizer

® —— —

Low Standard  Strong

Checkmark

For images shot with the camera’s Auto Lighting Optimizer
function, the checkbox is already checked.

Change the settings according to your preferences.

" RAW RGB | NR/ALO | LENS '

‘Autu Lighting Optimizer

— S

Low Standard  Strong

Select from three levels:
Low/Standard/Strong

Auto correction is applied to the image to match the settings.
For images shot with the camera’s Auto Lighting Optimizer
function, the settings at the time of shooting are applied as the

default values.

To cancel the Auto Lighting Optimizer, remove the check mark

from the checkbox.

When [Highlight tone priority] is set to [Enable] in EOS-1D X,
EOS-1D C, EOS 5D Mark lll, EOS 6D, EOS 7D Mark Il, EOS 7D,
EOS 70D, EOS 60D, EOS REBEL T5i/700D, EOS REBEL SL1/
100D, EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS
REBEL T2i/550D, EOS REBEL T5/1200D, EOS REBEL T3/1100D,
EOS M2 and EOS M, the Auto Lighting Optimizer function cannot

be set.

You cannot use the Auto Lighting Optimizer with multiple-
exposure RAW images created on the camera.
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Reducing Noise

You can reduce noise that arises in RAW images shot at night or with a
high 1ISO speed.
NR is an abbreviation for “noise reduction”.

Select the [NR/ALQO] tab sheet from the tool palette in
the edit window or edit image window.
Click the [NR Preview] button.

NP Preview... |

| Noise reduction

RAW [[

The [NR Preview] window appears.

Adjust an image.

8NN NR Preview

Navigator
window

— Enlargement

display
position
Luminance noise reducty
fh’ o e S = Drag the
o 2 sliders

( Cancel

D Y —

NR check| window
You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect.
The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.
You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

Click the [Apply] button.
Noise reduction is applied to the image and the image is
redisplayed.

? The noise reduction function does not work

Noise reduction cannot be applied when [Viewing and saving RAW
images] (p.90) is set to [High speed] in the [Preferences] window.
Select [High quality] to reduce noise.

VL
-Q= To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/ALO]
tool palette (p.129) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

i

You can set the default noise reduction beforehand, using
[Default noise reduction settings] in the [Tool palette] tab sheet in
the [Preferences] (p.92).

« When [Apply camera settings] is selected, you can pre-set a
noise reduction level that suits the camera settings beforehand
as the default.

* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand. This is
particularly useful for applying noise reduction to all the images
in a folder at once, such as batch noise reduction for images
with high 1ISO speeds.

However, for images with recipes attached, the noise level

recorded in the recipe will be applied.

If [Luminance noise reduction] has been set, resolution may be

reduced along with reduction of noise.

If [Chrominance noise reduction] has been set, color bleeding

may occur along with reduction of noise.

For a list of [NR Preview] window functions, see p.131.
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Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Please note that you can only correct RAW images which have been
taken with the compatible cameras and lenses listed below. JPEG or
TIFF images cannot be corrected.

Compatible Cameras

EOS-1D X

EOS-1Ds Mark lli
EOS-1Ds Mark 11
EOS-1D

EOS 5D*1

EOS 7D

EOS 50D

EOS REBEL T5i/700D
EOS REBEL T3i/600D

EOS DIGITAL REBEL
XSi/450D

EOS REBEL
T3/1100D

EOS M

EOS-1D C

EOS-1D Mark IlI

EOS-1D Mark Il

EOS 5D Mark Il

EOS 6D
EOS 70D
EOS 40D

EOS REBEL SL1/100D EOS REBEL T4i/650D

EOS REBEL
T2i/550D

EOS-1D Mark IV
EOS-1D Mark II N
EOS-1Ds

EOS 5D Mark II
EOS 7D Mark I
EOS 60D

EOS 30D*?

EOS REBEL
T1i/500D

EOS DIGITAL REBEL EOS REBEL

XTi/400D DIGITAL

T5/1200D

EOS DIGITAL REBEL EOS M2

XS/1000D

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

Compatible Lenses

Fisheye, ultra wide, and wide angle lenses

EF 14mm f/2.8L USM

EF 8-15mm f/4L USM Fisheye*3
EF 20mm /2.8 USM

EF 24mm f/1.4L 1l USM*3

EF 24mm /2.8 IS USM*3

EF 28mm /2.8

EF 35mm f/1.4L USM

EF 35mm f/2 IS USM*3

EF 14mm f/2.8L Il USM*3
EF 15mm /2.8 Fisheye*3
EF 24mm f/1.4L USM

EF 24mm /2.8

EF 28mm /1.8 USM

EF 28mm /2.8 IS USM*3
EF 35mm f/2

Standard and medium telephoto lenses

EF 40mm /2.8 STM*3
EF 50mm f/1.4 USM

EF 50mm /1.8 Il

EF 85mm f/1.2L Il USM*>
EF 100mm /2 USM

EF 50mm f/1.2L USM*4
EF 50mm /1.8

EF 85mm f/1.2L USM
EF 85mm /1.8 USM

Telephoto lenses

EF 135mm f/2L USM

EF 200mm /2L IS USM*3
EF 200mm /2.8L 1l USM
EF 300mm f/2.8L IS USM
EF 400mm f/2.8L IS USM
EF 400mm /4 DO IS USM
EF 500mm /4L IS USM

EF 600mm /4L IS USM

EF 800mm f/5.6L IS USM*3

EF 135mm /2.8
(with Softfocus mechanism)

EF 200mm /2.8L USM

EF 300mm f/2.8L IS Il USM*3
EF 300mm /4L IS USM

EF 400mm f/2.8L IS Il USM*3
EF 400mm f/5.6L USM

EF 500mm f/4L 1S 1l USM*3
EF 600mm /4L IS Il USM*3
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Zoom lenses
EF 16-35mm f/2.8L Il USM*3

EF 17-35mm f/2.8L USM

EF 20-35mm f/3.5-4.5 USM

EF 24-70mm f/2.8L Il USM*3

EF 24-85mm f/3.5-4.5 USM

EF 28-70mm f/2.8L USM

EF 28-90mm f/4-5.6 Il USM

EF 28-90mm /4-5.6 Il

EF 28-105mm f/3.5-4.5 USM

EF 28-105mm f/4-5.6 USM

EF 28-135mm f/3.5-5.6 IS USM
EF 28-200mm f/3.5-5.6 USM

EF 55-200mm f/4.5-5.6 Il USM
EF 70-200mm f/2.8L USM

EF 70-200mm f/2.8L IS Il USM*3
EF 70-200mm f/4L USM EF 70-200mm f/4L IS USM*4

EF 70-300mm f/4-5.6L IS USM*3 EF 70-300mm f/4-5.6 IS USM

EF 70-300mm f/4.5-5.6 DO IS USM EF 75-300mm f/4-5.6 |I*3

EF 75-300mm f/4-5.6 I11*3 EF 75-300mm f/4-5.6 USM

EF 75-300mm f/4-5.6 Il USM EF 75-300mm f/4-5.6 Il USM

EF 90-300mm f/4.5-5.6 EF 90-300mm f/4.5-5.6 USM

EF 100-300mm f/4.5-5.6 USM EF 100-400mm f/4.5-5.6L IS USM
EF 200-400mm f/4L IS USM*3

EF 16-35mm f/2.8L USM

EF 16-35mm /4L IS USM*3
EF 17-40mm f/4L USM

EF 24-70mm f/2.8L USM

EF 24-70mm f/4L IS USM*3
EF 24-105mm /4L IS USM

EF 28-90mm f/4-5.6 USM

EF 28-90mm f/4-5.6

EF 28-90mm f/4-5.6 III

EF 28-105mm f/3.5-4.5 [l USM
EF 28-105mm f/4-5.6

EF 28-200mm f/3.5-5.6

EF 28-300mm 1/3.5-5.6L IS USM
EF 55-200mm f/4-5.6 USM

EF 70-200mm /2.8L IS USM

Macro lenses
EF 50mm f/2.5 Compact Macro*3 EF 100mm f/2.8 Macro USM
EF 100mm f/2.8L Macro IS USM*3 EF 180mm f/3.5L Macro USM

MP-E 65mm /2.8 1-5x Macro
Photo*3

5

EF-S lenses
EF-S 60mm /2.8 Macro USM EF-S 10-18mm f/4.5-5.6 IS STM*3
EF-S 10-22mm f/3.5-4.5 USM EF-S 15-85mm f/3.5-5.6 IS USM*3
EF-S 17-55mm /2.8 IS USM EF-S 17-85mm f/4-5.6 IS USM
EF-S 18-55mm /3.5-5.6 IS STM*3 EF-S 18-55mm f/3.5-5.6
EF-S 18-55mm {/3.5-5.6 Il EF-S 18-55mm /3.5-5.6 I11*3
EF-S 18-55mm /3.5-5.6 USM EF-S 18-55mm /3.5-5.6 1l USM
EF-S 18-55mm f/3.5-5.6 1S*3 EF-S 18-55mm /3.5-5.6 IS II*3
EF-S 18-135mm f/3.5-5.6 1S*3 EF-S 18-135mm /3.5-5.6 IS STM*3
EF-S 18-200mm f/3.5-5.6 1S*3 EF-S 55-250mm f/4-5.6 1S*3
EF-S 55-250mm f/4-5.6 IS 1I*3 EF-S 55-250mm f/4-5.6 IS STM*3

EF-M lenses
EF-M 22mm /2 STM EF-M 11-22mm f/4-5.6 IS STM
EF-M 18-55mm f/3.5-5.6 IS STM EF-M 55-200mm f/4.5-6.3 IS STM

Aberration correction will not apply to images shot with a combination of
lenses *3 *4 *5 gnd EOS 5D or EOS 30D with the firmware versions below.
* You cannot attach an EF-S lens to EOS 5D.

*3 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.5 or earlier

*4 EQS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

*> EOS 5D with firmware version 1.0.5 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

You can also correct RAW images taken with the compatible lens
even when the extender is attached.

You can also correct RAW images shot with EF 50mm /2.5
Compact Macro fitted with Life Size Converter EF.

The aberration correction function is not available for images shot
with combinations of camera/lens other than those given under
“Compatible Cameras” and “Compatible Lenses”. They are
therefore not displayed and cannot be used.

The lens aberration correction function is not available for
multiple-exposure RAW images created on the camera.

EF cinema lenses (CN-E lenses) are not compatible.
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Making Corrections

You can make corrections to any of the four aberrations as below, either
one at a time or simultaneously.
Peripheral illumination
Chromatic aberration (color fringing which occurs in the periphery of
an image)
Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)
Distortions

In the tool palette, select the [LENS] tab sheet.

Click the [Tune] button.

" RAW RGB  NR/ALO | LENS |
|Digil.a| Lens Optimizer —
Setting OFF
Lens data No
[ Update... |
Lens aberraticn correction [ —— ]|
Peripheral illumination OFF
Chromatic aberration QOFF
Color blur OFF
Distortion QFF

The [Lens aberration correction] window appears.

Checkmark the items to be corrected.

A

Lens aberration cerrection - [IMG_0001.CR2]

The image is corrected and redisplayed.

Check the results of corrections to peripheral illumination or
distortions in the full view.

Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check. In the
top right of the window, the area is displayed at 200% in the
enlargement display section (p.136).

You can lessen the degree of correction by moving the slider to
the left for the item you want to correct.

You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

To correct distortion aberration of images shot with a fisheye lens
(EF 8-15mm f/4L USM Fisheye or EF 15mm /2.8 Fisheye), four
effects can be selected from the [Effect] list box in addition to
[Shot settings] normally used for distortion correction.

The level of an effect can be adjusted with the adjustment slider
located below [Distortion].

For details on each effect, see “Effects of Distortion Aberration
Correction for Fisheye Lenses” (p.64).
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For images shot with EF 8-15mm /4L USM Fisheye, a fine-tune Effects of Distortion Aberration Correction for
slider is also displayed when you select [Emphasize Linearity] :
from the [Effect] list box. FISheye Lenses
Adjust the amount of correction for distortion aberration with the Shot settings Cgfg;%;r;fgeat
adjustment slider, and then adjust with the fine-tune slider if more By selecting this option, only distortion aberration correction for
adjustment' is required. _ o correcting optical distortion is performed.
When the list box for selecting an extender is displayed, select Basi
the extender attached at the time of shooting from the list box. Ope?g.ltfon
Click the [OK] button.
The [Lens aberration correction] window closes and the result of
the corrections is applied to the image in the edit window and the gd‘é?gt‘i:gg
image is redisplayed. P

The result of the settings of the [Lens aberration correction]
window is also displayed in the tool palette.

In the main window, the [Q}DJ] mark is displayed on the image to
indicate the lens aberration corrections (p.126).

Advapced
Imag iting
and Pfinting

Processing
Emphasize Linearity Large Numbers
. . W S . . of Images

This converts the image to a “central projection” style image. This

projection method is used with general lenses. —
Differing from fisheye lenses, central projection displays straight lines JFFgclst/I'rl]'PFF
as straight lines. By selecting this option, a wide-view panoramic Images
image can be obtained. However, the periphery is stretched, resulting

in decreased resolution.
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Emphasize Distance

This converts the image to an “equidistant projection” style image.
This projection method preserves distance relationships.
Equidistant projection displays a distance in the same distance
anywhere from the center to the periphery. In particular, when
shooting a celestial body such as the celestial sphere, same heights
above the horizon (declination) are captured at the same heights.
This method is therefore used in such photography as celestial
photography (star maps, solar path diagrams, etc.).

Emphasize Periphery

This converts the image to a “stereographic projection” style image.
This projection method emphasizes the periphery.

Stereographic projection allows position relationships on a spherical
surface, such as N, S, E, W on a map, to be displayed correctly. It is
therefore used for world maps and monitoring cameras.

By selecting this option, the periphery is stretched and may result in
decreased resolution.

Emphasize Center

This converts the image to an “orthogonal projection” style image.
With this projection method, the center is more emphasized.

Since an orthogonal projection allows a subject of the same
brightness to be displayed as occupying the same area in the image,
this method has typical uses in photography for celestial luminance
distributions and center-emphasized animal photography. By
selecting this option, the center is stretched and may result in
decreased resolution.

® While selecting any of the options [Emphasize Linearity],
[Emphasize Distance], [Emphasize Periphery], or [Emphasize
Center] will yield results similar to each of the projection methods,
the conversion does not exactly apply each projection method in
their precise sense.
Accordingly, care should be taken since they are not suited to
scientific or other such purposes.
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About Shooting Distance Information Slider

When correcting RAW images shot with the cameras in the table below,
if shooting distance information has been saved to the image, the slider
is set automatically according to this shooting distance information.

However, if no shooting distance information is saved to the image, the
slider is set automatically to the right end at infinity position and a [<!>]

appears above the slider.

If the image’s shooting distance is not infinite, you can minutely adjust
the distance by operating the slider while looking at the screen.

The distance cannot be minutely adjusted by using the slider for images
shot with an EF-M lens. (The slider is not displayed.)

EOS-1D X EOS-1D C
EOS-1Ds Mark I EOS-1D Mark Il
EOS 5D Mark II EOS 6D

EOS 7D EOS 70D

EOS 50D EOS 40D

EOS REBEL SL1/100D EOS REBEL T4i/650D
EOS REBEL T2i/550D EOS REBEL

T1i/500D
EOS REBEL EOS REBEL
T5/1200D T3/1100D
EOS M2 EOS M

EOS-1D Mark IV
EOS 5D Mark IlI

EOS 7D Mark Il

EOS 60D

EOS REBEL T5i/700D
EOS REBEL T3i/600D

EOS DIGITAL REBEL
XSi/450D

EOS DIGITAL REBEL
XS/1000D

When correcting RAW images shot with the cameras in the table
below, it is set automatically to the right end at infinity position. You
can then minutely adjust the distance by operating the slider while
looking at the screen if the shooting distance is not infinite.

EOS-1D Mark Il N EOS-1Ds Mark Il EOS-1D Mark Il
EOS-1Ds EOS-1D EOS 5D
EOS 30D EOS DIGITAL REBEL

XTi/400D DIGITAL

For RAW images shot with MP-E 65mm f/2.8 1-5x Macro Photo or EF
50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].

[Shooting distance information] slider is applied to all the correction
items with check marks.
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Correcting Multiple Images at a Time

Select multiple images to correct in the main window. Display tool
palette by clicking the [Tool palette] button (p.124) in the toolbar. If you
perform correction procedures (p.63) when tool palette is displayed, you
can apply the same corrections to all the images selected in the main
window.

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.41).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.60). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high ISO speed, the
noise might not be reduced.

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p-31).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.30) and/or the color saturation (p.107) to
make the color deeper.

The result of [Color blur] correction cannot be detected
[Color blur] correction is effective for correcting blue or red color blur

which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

® The periphery of the image may be truncated when [Distortion]
correction is made.

|§| For a list of the [Lens aberration correction] window functions, see
p.136.
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Using the Digital Lens Optimizer

This function enables the resolution of images to be increased by
removing any remaining aberration related to image-forming capability
or any deterioration of resolution resulting from diffraction phenomena
that are unavoidable as long as light must pass through the lens. These
optical phenomena cannot be corrected under [Lens aberration
correction] (p.61). Correction is achieved using the designed value of
each lens. The images that can be corrected are RAW images shot
using any of the following “Compatible Cameras” and “Compatible
Lenses”. JPEG, TIFF, S-RAW, and M-RAW images cannot be corrected.
To use this function, [Lens data] for the lens used to shoot images first
needs to be downloaded to your computer.

Before using the Digital Lens Optimizer, it is recommended that you set
[Sharpness] or [Strength] for [Unsharp mask] for images to O.

Compatible Cameras

EOS-1D X EOS-1D C EOS-1D Mark IV
EOS-1Ds Mark I EOS-1D Mark Il EOS-1D Mark II N
EOS-1Ds Mark 1l EOS-1D Mark Il EOS-1Ds
EOS-1D EOS 5D Mark Il EOS 5D Mark I
EOS 5D*1 EOS 6D EOS 7D Mark I
EOS 7D EOS 70D EOS 60D

EOS 50D EOS 40D EOS 30D*2

EOS REBEL EOS REBEL EOS REBEL
T5i/700D SL1/100D T4i/650D

EOS REBEL EOS REBEL EOS REBEL
T3i/600D T2i/550D T1i/500D

EOS DIGITAL REBEL EOS DIGITAL REBEL EOS REBEL
XSi/450D XTi/400D DIGITAL T5/1200D

EOS REBEL EOS DIGITAL REBEL EOS M2
T3/1100D XS/1000D

EOS M —_— .

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

Compatible Lenses

Wide angle lenses

EF 14mm f/2.8L USM
EF 20mm /2.8 USM
EF 24mm f/1.4L USM
EF 24mm /2.8 IS USM
EF 28mm /2.8

EF 35mm f/1.4L USM
EF 35mm /2 IS USM

EF 14mm f/2.8L Il USM
EF 24mm f/1.4L 11 USM
EF 24mm /2.8

EF 28mm /1.8 USM
EF 28mm /2.8 IS USM
EF 35mm f/2

Standard and medium telephoto lenses

EF 40mm /2.8 STM
EF 50mm f/1.2L USM
EF 50mm /1.8 1l

EF 85mm f/1.2L 1l USM

EF 100mm f/2 USM

EF 135mm /2L USM
EF 200mm /2.8L USM

EF 300mm /2.8L IS Il USM
EF 400mm f/2.8L IS USM
EF 400mm /4 DO IS USM

EF 500mm /4L IS USM

EF 600mm f/4L IS Il USM

EF 50mm /1.4 USM
EF 50mm /1.8

EF 85mm f/1.2L USM
EF 85mm /1.8 USM

EF 135mm /2.8
(with Softfocus mechanism)

Telephoto lenses

EF 200mm /2L IS USM

EF 200mm f/2.8L 1l USM
EF 300mm /4L IS USM

EF 400mm f/2.8L IS Il USM
EF 400mm f/5.6L USM

EF 500mm /4L IS Il USM
EF 800mm /5.6L IS USM
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Zoom lenses

EF 16-35mm f/4L IS USM

EF 17-35mm f/2.8L USM

EF 20-35mm f/3.5-4.5 USM
EF 24-70mm f/2.8L 1l USM

EF 24-85mm f/3.5-4.5 USM
EF 28-70mm f/2.8L USM

EF 28-105mm f/3.5-4.5 || USM
EF 28-200mm f/3.5-5.6 USM
EF 28-300mm f/3.5-5.6L IS USM
EF 70-200mm f/2.8L IS USM

EF 16-35mm f/2.8L USM

EF 16-35mm f/2.8L Il USM

EF 17-40mm f/4L USM

EF 24-70mm f/2.8L USM

EF 24-70mm f/4L IS USM

EF 24-105mm f/4L IS USM

EF 28-105mm /3.5-4.5 USM
EF 28-135mm /3.5-5.6 IS USM
EF 28-200mm /3.5-5.6

EF 70-200mm /2.8L USM

EF 70-200mm f/2.8L IS Il USM  EF 70-200mm f/4L USM

EF 70-200mm f/4L IS USM EF 70-300mm f/4-5.6L IS USM
EF 70-300mm f/4.5-5.6 DO IS USM EF 70-300mm f/4-5.6 IS USM

EF 100-300mm f/4.5-5.6 USM EF 100-400mm f/4.5-5.6L IS USM
EF 75-300mm f/4-5.6 IIl USM EF 75-300mm f/4-5.6 Il USM

EF 75-300mm f/4-5.6 IlI EF 75-300mm f/4-5.6 1|

EF 75-300mm f/4-5.6 USM EF 200-400mm f/4L IS USM

Macro lenses
EF 50mm /2.5 Compact Macro  EF 100mm /2.8 Macro USM
EF 100mm f/2.8L Macro IS USM EF 180mm f/3.5L Macro USM

MP-E 65mm /2.8 1-5x Macro
Photo

EF-S lenses

EF-S 60mm /2.8 Macro USM
EF-S 10-22mm f/3.5-4.5 USM
EF-S 18-55mm f/3.5-5.6 1| USM
EF-S 18-55mm f/3.5-5.6 Il
EF-S 18-55mm {/3.5-5.6

EF-S 18-55mm f/3.5-5.6 IS
EF-S 17-85mm f/4-5.6 IS USM
EF-S 18-135mm f/3.5-5.6 IS
EF-S 18-200mm f/3.5-5.6 IS
EF-S 55-250mm f/4-5.6 IS |

EF-S 10-18mm f/4.5-5.6 IS STM
EF-S 15-85mm /3.5-5.6 IS USM
EF-S 18-55mm f/3.5-5.6 USM
EF-S 18-55mm {/3.5-5.6 I

EF-S 18-55mm /3.5-5.6 IS 1l
EF-S 17-55mm /2.8 IS USM
EF-S 18-55mm /3.5-5.6 IS STM
EF-S 18-135mm f/3.5-5.6 IS STM
EF-S 55-250mm f/4-5.6 IS

EF-S 55-250mm f/4-5.6 IS STM

EF-M lenses

EF-M 11-22mm f/4-5.6 IS STM

EF-M 22mm /2 STM

EF-M 18-55mm f/3.5-5.6 IS STM EF-M 55-200mm f/4.5-6.3 IS STM

The Digital Lens Optimizer is also available for images shot with
an extender mounted on a compatible lens.

You cannot use the Digital Lens Optimizer with multiple-exposure
RAW images created on the camera.

EF cinema lenses (CN-E lenses) are not compatible.
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Introduction
g o — Click the [Update] button.
Using the Digital Lens Optimizer [Update]
" RAW = RGB = NR/ALO | LENS |
Digital Lens Optimizer [ — ] Contents at
In the tool palette, select the [LENS] tab sheet, and | | a Glance
.. Settin OFF
check the status of [Lens data] for [Digital Lens ’
Optlmlzer] . Lens data Mo BaSiC
([_Upsate._] Operation
{ RAW = RGB  NRJALO | LENS |
|Digita| Lens Optimizer [T] | |Lens aberration correction |
Advanced
i A5 The [Add or Remove lens data] window appears. Operation
( Lens data Mo )
Advemced
Imag\gji_ting
|Lens aberraticn correction [ —— ] | and ntlng
[Not Available] is displayed for an image shot with a non- Processing
compatible camera or lens, or for a non-compatible image such Lagg}lceml;h;r;gsers
as a JPEG, TIFF, S-RAW, or M-RAW image. The function cannot
be used for these images. -
L : n
If [NO] is displayed, proceed to step 2. To use the function, you JPEIG/I'“gFF
need to download [Lens data] for the lens used when shooting Images

the image. It is recommended that you check the lens used when
shooting the image beforehand. The lens used can be checked

using the [Info] button in the toolbar on the main window (p.23). Reference
If [Yes] is displayed, proceed to step 4.

Index

00

® To use this function, an environment with Internet access

(subscription to a provider, browser software installed and an in-
place line connection) is required.

An administrator-level privilege is required for this operation.

|§| Before you click the [Update] button in step 2, Lens data [No] may
be displayed instead of [Not Available] for non-compatible images.
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Checkmark the checkbox for the lens used to shoot
the image, and click the [Start] button.

Add or Remove lens data

] EF500mm F4L IS Il USM
EF600mm F4L IS Il USM
EF16-35mm F2.8L Il USM
EF16-35mm F2.8L USM
EF17-40mm F4L USM
EF24-70mm F2.8L Il USM
EF24-70mm F2.8L USM
EF24-105mm FAL IS USM
EF28-300mm F3.5-5.6L IS USM
EF70-200mm F2.8L IS Il USM
EF70-200mm F2.8L IS USM

=
0
=
=
M
=
=
=
=

njw

EF70-200mm F4L USM (Add)
U-3U00mm F4-5.6 OSW

=» The lens data is downloaded to your computer.

-»When the downloading of the lens data ends, the indication for
[Lens data] changes to [Yes].

@ You can download the data for up to 30 lenses at the same time.

@ If you remove the check mark from the checkbox for already-
downloaded lens names and click the [Start] button, the lens data
will be deleted from your computer.

@ Depending on the type, current state, etc. of software running on
your computer, the download of the lens data may fail. If it occurs,
wait for a while, then try downloading the data again.

4

Click the [Tune] button.

[~ RAW RGB NR/ALO | LENS |——

|Dlgital Lens Optimizer ( [ Tune... ]]
Setting 50
Lens data Yes

=» The [Digital Lens Optimizer] window appears.
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Checkmark the [Setting] checkbox and adjust the
image.

ann * | Digital Lens Optimizer - [IMG_9416_01.CR2]
._v._ e - = =
- > | - &-“- - .
i @ N
T e
wlh = P o
X = 2
-
i -
A, - x Shooting distance information
- (2o}
=]
~ -~ ‘ (] Setting (100) '
= & a1l 1
T
% ) 4

Do not sharpen previews

v
Cancel X Save

o
-
b

The [Setting] checkbox will be checkmarked if the image has the
Digital Lens Optimizer already applied. Remove the checkmark
and click the [Save] button to cancel the Digital Lens Optimizer.
Images displayed in the [Digital Lens Optimizer] window are with
[Sharpness] and [Unsharp mask] effects applied by default. If you
checkmark the [Do not sharpen previews] checkbox, images are
displayed without [Sharpness] or [Unsharp mask] effects applied,
allowing you to check only the Digital Lens Optimizer effect.
When applying the Digital Lens Optimizer, the effect of
[Sharpness] or [Unsharp mask] may become excessive. It is
recommended that you set [Sharpness] or [Strength] for [Unsharp
mask] for images to 0 before using the Digital Lens Optimizer.
Adjust [Sharpness] or [Unsharp mask] again after applying the
Digital Lens Optimizer to images.

When the list box for selecting an extender is displayed, select
the extender attached at the time of shooting from the list box.
Use the slider to adjust the Digital Lens Optimizer effect.

When [MAX] is displayed for the Digital Lens Optimizer level, the
effect will remain the same even if you move the slider further to
the right.

You can change the display position of the check window by
dragging the enlargement display position in the navigator
window.

Even if you set shooting distance for a lens in this window, the
value indicated for shooting distance in the [Lens aberration
correction] window will not change.

If no shooting distance information is saved to the image, the
shooting distance slider is set automatically to the right end at
infinity position and a [<!>] appears above the shooting distance
slider. The distance cannot be minutely adjusted by using the
slider for images shot with an EF-M lens. (The slider is not
displayed.)

Images cannot be corrected for [Chromatic aberration] in [Lens
aberration correction] if the Digital Lens Optimizer has been
applied.

Click the [Save] button.

]

\

The [Digital Lens Optimizer] window closes and correction
results are applied to the image in the edit window.

Corrections made in the [Digital Lens Optimizer] window are also
displayed in the tool palette.

In the main window, the [g}h] mark is displayed on the image to
indicate that the Digital Lens Optimizer is applied (p.126).

After clicking the [Save] button, the application of the corrections
to the image may take some time.

The size of the image file will be larger after applying the Digital
Lens Optimizer.
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Stamp Teimming

The copy stamp window appeatrs.

Performing Automatic Dust Erasure Processing .
The Dust Delete Data that is appended to images shot with the camera When the image has redrawn itself, click the [Apply
that can attach this data, can be used to automatically erase dust spots. Dust Delete Data] button. ——
‘. — Cont;ents at
. a Glance
Compatible Cameras
Basic
EOS-1D X EOCS-1D C EOS-1D Mark IV Operation
EOS-1Ds Mark 1l EOS-1D Mark IlI EOS 5D Mark Il —
EOS 5D Mark II EOS 6D EOS 7D Mark II Advanced
EOS 7D EOS 70D EOS 60D Operatm”
EOS 50D EOS 40D EOS REBEL
T5i/700D \(31
Imag iting
EOS REBEL EOS REBEL EOS REBEL and Pfinting
SL1/100D T4i/650D T3i/600D
EOS REBEL EOS REBEL EOS DIGITAL REBEL \ ~ AN _ _ I Lg’r“’ecﬁjrﬂggrs
T2i/550D T1i/500D XSi/450D =» Dust spots are erased in a single operation. 0% Images
EOS DIGITAL REBEL EOS REBEL EOS REBEL y. Click the [OK] button to return to the main window.
XTi/400D DIGITAL T5/1200D T3/1100D ¥ =>The [3] mark (p.126) is displayed on an image from which dust Editing
JPEG/TIFF
EOS DIGITAL REBEL [y /1o £0S M spots have been erased. Images
In the main window, select an image appended with Reference
Dust Delete Data. —
Click the [Stamp] button.
Index
Digital Photo Professional - [ MacOSX /Users/canon/Pic
_

00
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? Additional information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.75) or the copy stamp function (p.77).

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).

A/

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, see p.140.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image you want to
erase dust spots.

Click the [Stamp] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

Cuick Stamp Trimming
check

The copy stamp window appeatrs.

When the image has redrawn itself, double-click the
point from where dust is to be erased.

ig._nn ) 113 G O340.CR2 11434 = 2504]

105 v || il i e
_ Asol Dwit Oelete Dats
[

CoJey Double-
-~ = click

L 150N e e s s

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spot to be
erased.
If the dust spot is dark in color, click the [ @»( |] button, and if
the dust spot is light in color, click the [ (] button.
When you move the cursor over the image, the dust erasure
range appears as [O].

Place the dust spot to be erased within the [O] and
click.

BT = 1718 C_D0V0 A2 (1456 = 21041

Click

The dust spot within the [Q] is erased.

Click on another part of the image to continue erasing dust spots
in the image.

To erase dust in another part of the image, click the button
clicked in step 4 again to cancel dust erasure processing and
perform the operation again from step 3.

When the dust spot cannot be erased, [(§)] is displayed.

Click the [OK] button to return to the main window.
The [@,] mark (p.126) is displayed on the image from which dust
spots have been erased.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.77).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).

A/

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 5, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you
can efficiently erase dust spots by clicking the images while holding
down the <3B8> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <shift> key, and then displaying the copy
stamp window.

® For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

@ For a list of the copy stamp window functions, see p.140.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1to 3in “Manually Erasing Dust (Repair
Function)” (p.75).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <option> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [8,] mark (p.126) is displayed on the corrected image.

Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Photoshop.

Select the [Tools] menu » [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
a time, see p.100.

@ Compatible versions of Photoshop are CS or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.143) is added. The ICC profile
contains information about [Preferences] (p.93) or work color
space set for each image as described below, and the appropriate
color information is relayed to Photoshop.

When you quit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred
image as a separate image in Photoshop is recommended.

Setting Work Color Space

A different work color space (p.144) from the default settings (p.93) can
be set for each image.

Select the [Adjustment] menu » [Work color space] »
color space to be set.

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.93), this default
setting will not be applied and the individually set color space will remain.

5@/5 The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Compositing Images
You can combine two images into a single image. You can further

combine images by adding another image to the composited image.

Since the composited image is saved as a separate image, the original
images remain as they are.

|§| This function can be used with all image types (p.3) supported by
DPP. However, images with more than 6666 x 4444 pixels are not
supported.

The color space of a composited image will be the color space of
the background image.

Image information is not appended to a composited image.

Select a background image in the main window.

- L ENG Flvers canan Parere s s sxns_ss_xs |

You can also select a background image from the edit window,
edit image window, or [Collection] window.

Select the [Tools] menu » [Start Compositing Tool].

Start Quick check tool LHBF
Start Stamp tool s
tart Trimming/Angle Adjustment tool 38T
Start Compositing Tool X
Start HDR Tool Y
Start Rename tool T H#R
Start EOS Utility THEE
Sync folder with EOS Utility
Transfer to Photoshop LEP

The compositing tool window appears.

™M _| IMG_0001.CR2 [3456 x 2304]

100% view

Image

| Selectan image
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Select the image to combine.

Select the image to combine from the [Foreground Image] list
box.

l 100% view '

Select an image
¥ IMG_0001.CR2
IMG_0002.CR2

IMG_0004.CR2
IMG_0006.CR2

The selected image is displayed in the [Foreground Image]

thumbnail display.

A preview of the combined background image and foreground

image is displayed in the composite preview.

The following images can be combined.

* When a background image is selected in the main window
([Folder] window) or edit window: images in same folder as
background image

* When a background image is selected in the [Collection]
window: images in the [Collection] window

* When a background image is selected in the edit image
window: images displayed in the thumbnail display area

You can combine images of different sizes.

Select a compositing method.

Select a compositing method from the [Composite Method] list
box.

[ 100% view ]

Foreground Image
| IMG_0002.CR2 iy

posite Method
¥ Add
Average
Weighted
Lighten

Darken

The compositing method selected in the composite preview is
applied.

The compositing method can be selected from five types: Add,
Average, Weighted, Lighten, and Darken. For details on each
compositing method, see “Compositing Methods” (p.81).

If you select [Weighted], you can set the proportion of brightness
of the image to be combined. Use the [Weight] slider at the
bottom of the [Composite Method] list box or directly enter a
value to set the brightness proportionally.

By clicking the [100% view] button, the image is displayed at
100% magnification (actual pixel size).
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Introduction
Position the images.
8.0 | | IMG_D001.CR2 [3456 x 2304]
{ 100% view ] Contents at
Foreground Image _ a Glance
| IMG_0002.CR2 P4 \ )
Basic
Operation
Advanced
R Operation
Pleichen
¥ Compose in RAW Format
Weight
Imag |t|ng
Shift large amount (50 pixels) and Pfinting
Shift small amount (1 pixel) Processing
o Large Numbers
Align image centers of Images
——
You can also directly enter the position Editi
‘ coordinates of the [Foreground Image] JPE(IB;'?'IQFF
: to align it. Images
_ Reference
By default, the background image and the [Foreground Image] are
displayed with their centers aligned. —
[Compose in RAW Format]
Checkmark the [Compose in RAW Format] checkbox as necessary. Index
@ You can set [Compose in RAW Format] under the following @ The following functions are not available for images composited T
conditions. with [Compose in RAW Format].
Both the background image and [Foreground Image] are RAW » Auto Lighting Optimizer (p.59) @ @
images, and, all the following conditions are met. « Picture Style Auto (automatically set to Standard) (p.57)
* The cameras used to shoot were of the same model « Selecting [Circle] for the aspect ratio when trimming (p.39)
* The ISO speed setting at time of shooting was the same

* The highlight tone priority setting at time of shooting was the same
» The image sizes (original size) are the same
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Click the [Save As] button.

Position

2
F

ooenn

v

—

¥
*]

Y 0 8

( Continue )

& Save As... 3

By clicking the [Save As] button, the [Convert and save] window
(p.42) appears. Specify the required settings, and then click the
[Save] button.

By clicking the [Continue] button, images are combined to create
a new background image, and you can continue by combining
another image.

To finish, click the [Close] button.

Compositing Methods

Add

The brightnesses of the background image and [Foreground Image]
are added and images are overlaid.

Average

Images are overlaid with negative exposure compensation being
applied automatically. If you want to change the amount of exposure
for individual images, select [Weighted].

Weighted

Compositing method where brightness is set proportionally for the
[Foreground Image].

Lighten

The background image and the [Foreground Image] are compared,
with only brighter portions being combined.

Darken

The background image and the [Foreground Image] are compared,
with only darker portions being combined.

Creating HDR (High Dynamic Range) Images
You can create images with a wide dynamic range where clipping in
highlights and shadows has been reduced, and images that appear like
paintings. This is suited for scenes such as still-lifes and landscapes.
This function is most effective when using three images with different
exposures of the same scene (negative exposure, standard exposure,
positive exposure) to create an HDR image. However, you can also
create an HDR image from two images, or even only one.

Since an HDR image is saved as a separate image, the original images
remain as they are.

* HDR stands for High Dynamic Range.

|§| This function can be used with all image types (p.3) supported by
DPP. However, images with more than 6666 x 4444 pixels are not
supported.
Image information is not appended to an HDR image.

Select an image in the main window.

iaia) Dvgiial Phose Peodessional - | LG isers canon Pt s (Fheta xaxs_an us 1l
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Introduction

Specify the required settings, then click the [Start

2 Select the [Tools] menu » [Start HDR Tool].
HDR] button.

&0 Select Images Contents at
Start Quick check tool THBF | a Glance

Start Stamp tool NS
Start Trimming/Angle Adjustment tool X ##T

iting Tool X
Start HDR Tool ALY

Start Rename tool N #R

Basic
Operation

Start EQS Utility 8E
Sync folder with EOS Utility
Advanced

Operation

Advamced
Imag iting
and PPinting

Transfer to Photoshop N#P

=» The [Select Images] window appears.
@ You can also display the [Select Images] window from the edit
window and edit image window.

@ To change the selected image, or add another image, click the

[Browse] button and in the [Open] dialog box that appears, select
the image file and click the [Open] button.

® If you select two images of the same size, you can checkmark
the [Auto Align] checkbox for auto image alignment. However,
auto image alignment may not work properly with repetitive
patterns (lattice, stripes, etc.) or flat, single-tone images.

=» By clicking the [Start HDR] button, the [Adjust Image] window
appears.

® After using auto image alignment, the periphery of the images is
partially deleted.
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Make required selections to adjust the image.

[ Nals)

[Tone/Color]

IMC_0001.CR2/IMC_0002.CR2/IMG_0003.CR2

Sliders in [Adjust Image]

Adjust Image

Presets
Natural 5

Tone/Color
Brightness:(55)
——
Saturation:(50)
—¢—
Contrast:(50)
——

[Deal Enascemen:
Strength:(0)
oO———
Smoothness:(0)
t——
Fineness:(0)

oO———

Save As...

[Brightness]: Adjusts the overall brightness of the image. Move

[Saturation]:

[Contrast]:

the slider to the right to brighten the image, and to
the left to darken the image.

Adjusts the overall color saturation of the image.
Move the slider to the right to make the color
deeper, and to the left to make the color weaker.
Adjusts the overall contrast of the image. Move
the slider to the right to make contrast stronger
and to the left to make contrast weaker.

[Detail Enhancement]

[Strength]:

Adjusts the overall contrast and contrast of
details together. Move the slider to the right for a
stronger effect.

[Smoothness]: Adjusts the overall smoothness of the image.

[Fineness]:

Move the slider to the right for a smooth and
natural impression.

Adjusts the clearness of details. Move the slider
to the right for a sharper outline.

[Presets] and finishing effects

With [Presets], you can select from the five preset finishing
effects below from a pulldown menu ([Natural] is selected by
default), instead of operating the sliders individually. By selecting
a finishing effect, each slider moves according to the setting. You
can also operate and adjust the sliders after selecting an effect.

[Natural]:

[Art standard]:

[Art vivid]:
[Art bold]:

[Art embossed]:

In high-contrast scenes, rendering in areas
where highlights or shadows are usually clipped
is corrected, for a finish with reduced highlight
and shadow clipping.

Gives a finish with painting-like tonality for an
impressive image.

For a more vivid look than with [Art standard].
For a more vivid look than with [Art standard],
that makes the subject pop out.

Tones down sharpness more than [Art standard],
for an old-fashioned feel.
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Click the [Save As] button.

=» By clicking the [Save As] button, the [Convert and save] (p.42)
window appears. Specify the required settings and click the
[Save] button.

Starting Up Map Utility

Map Utility is a software that allows you to view images shot on a GPS
function-compatible Canon camera, including the shooting location and
route travelled. After installing Map Utility to your computer, you can
start it up from DPP.

Select the [Tools] menu » [Start Map Utility].

=»Map Utility starts up.

@ For information about Map Utility, refer to the Map Utility
instructions, or to the Help for Map Utility.

® Do not edit images with DPP and use Map Utility at the same time.
Editing results may not be saved properly.

|§| © Version 1.1.0 or later versions of Map Utility are compatible.
@ Map Utility is not included on the EOS DIGITAL Solution Disk.
© [Start Map Utility] will not appear in the [Tools] menu if Map Utility
is not installed to your computer.
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Printing with Shooting Information

You can freely layout one image on one sheet of paper and print
together with titles and shooting information, etc.

Select one image to be printed.
Select the [File] menu » [Print with detailed setting].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

¥ IMG_0001.CR2

E[ Printer | Image Text Settings )
{

Printer :

[ Properties

Media
Ad

Media orientation i‘
T Portrait
(O] Landscape

Media size:
297.0 mm x 209.9 mm

Print profile:

CMYK profile:

CMS settings...
(__Apply Y Cancel | )

Print preview

The image can be moved by dragging.

Drag the four corners of the image to change the size.

For the shooting information, click [E]] on the [Text] tab sheet
and select the necessary items in the window that appears.

“@< To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

@ You can set printer profiles (p.93).

If CMYK simulation has been set, the image is printed in the set
colors (p.93).
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.

Select images to be printed in a thumbnail list.
Select the [File] menu » [Contact Sheet Prints].

Specify the required settings for printing, and then
click the [Print] button.

Switches the settings tab sheet

Contact Sheet Prints

J il {
{ Printer | Image Text Settings

Printer :

Properties

Media :
A4

Media orientation:

) portrait
C Landscape

Media size:
209.9 mm x 297.0 mm

Print profile:

CMYK profile:

CMS settings...

Apply Cancel Print

Print preview

A/

“@< To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

@ You can set printer profiles (p.93).

If CMYK simulation has been set, the image is printed in the set
colors (p.93).
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Printing RAW Images on a High-End Canon Printer

Printing with a High-End Canon Inkjet Printer

For high-end Canon inkjet printers that are compatible with the printing
software Easy-PhotoPrint Pro and Print Studio Pro, you can print with
DPP by a simple operation that has the following features:

Simple printing of RAW images

Printing in faithful colors

High quality printing using a wide color space of Adobe RGB, etc. and

the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP and Easy-PhotoPrint Pro, first install Easy-PhotoPrint
Pro version 1.3 or later on your computer.

Printing with DPP and Easy-PhotoPrint Pro
Select the [File] menu » [Plug-in printing] » [Print
with Easy-PhotoPrint Pro].

Easy-PhotoPrint Pro starts up.

Match on-screen image colors and printing result

colors.
Select [Custom] in [Print Quality], click the [Set] button, and in the
window that appears, drag the slider to [1] at the right end, and
then click the [OK] button to close the window.
Next, click the [Color Adjustment] button to display the [Color
Adjustment] window and display the [Color Management] tab
sheet. Set [Color Mode] to [Enable ICC Profile] and [Printer
Profile] to [Auto], and then click the [OK] button to close the
[Color Adjustment] window.

Specify any other required settings for printing, and

then print.

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.93) is not applied.

The printed image’s color is not what you expected

In the Easy-PhotoPrint Pro window, click the [Color Adjustment]
button to display the [Color Management] tab sheet, set [Rendering
Intent] to [Perceptual] (p.144), and try printing.

/

> Advantages of printing with Easy-PhotoPrint Pro

Printing with faithful colors

When a color space is set (p.77, p.93), it is automatically transmitted
from DPP to Easy-PhotoPrint Pro, allowing you to print with faithful
colors.

Printing with a wide color reproduction

When the color space setting (p.77, p.93) is set to a color space wider
than sRGB (such as Adobe RGB), the image is printed with a wider
color gamut than an image that has an sRGB color space, with green
and blue in particular being reproduced vividly.
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Printing with DPP and Print Studio Pro
Select the [File] menu » [Plug-in printing] » [Print
with Print Studio Pro].

Print Studio Pro starts up.

Specify required settings for printing photographs,
and then print.

Refer to Print Studio Pro's Instruction Manual for details on
settings.

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.94) is not applied.

Y

@< Advantages of printing with Print Studio Pro

Printing with faithful colors
When a color space is set (p.77, p.93), it is automatically transmitted

from DPP to Print Studio Pro, allowing you to print with faithful colors.

Printing with a wide color reproduction

When the color space setting (p.77, p.93) is set to a color space wider
than sRGB (such as Adobe RGB), the image is printed with a wider
color gamut than an image that has an sRGB color space, with green
and blue in particular being reproduced vividly.
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Specifying Preferences

You can change the various functions of DPP in the [Preferences]
window. Check the contents of each window and set.
Refer to the detailed explanations if available, as well as to each

Introduction

Printing with a Large-Format Canon Printer

You can use DPP to print with the DPP-compatible Canon large-format

Contents at

imagePROGRAF printer. To print with DPP, first install imagePROGRAF window. a Glance
Print Plug-In for Digital Photo Professional on your computer. — ]
Select the [Digital Photo Professional] menu »
Select the [File] menu » [Plug-in printing] » Plug-In [Preferences]. OBearlZitcizon
for the printer you use. The [Preferences] window appears. P
The Plug-In starts up. Select a tab sheet, specify the settings, and then
Specify the required settings for printing click the [OK] button. gg‘é?gtcigg

photographs and then print.

? Additional information

A single image can be printed at a time

. . . . . . " Specified folder
You can print a single image selected in DPP at a time. When printing ot Bd 2 A Processing
multiple images, perform printing for each image individually. LargllceI Numbers
. . . _ s i of Images
Functions set in DPP that are not applied to printing S":_relc'pe = E
.pe . . . = Display message when al ing e
Specified output resolution (p.90) and CMYK simulation (p.93) are not ) Add o file ainomatically Editng
app“ed' Viewing and saving RAW images JPEG/TIFF
6, High quality (recommended) View/save RAW images at high guality Im ag es
Mo . . . . . e e Moiré is reduced and the NR tool palette can be used
@< Advantages of printing with imagePROGRAF Print Plug-In e e
. . . . JPEG image quality
Prlntlng Wlth falthfu' COlorS || Rermove block noise and mosquito noise Reference
When a color space is set (p.77, p.93), it is automatically transmitted R e A ek
from DPP to the Plug-In, allowing you to print with faithful colors. i
Printing with a wide color reproduction »
. X ) At EOS Utility startup Index
When the color space setting (p.77, p.93) is set to a color space wider = N
|| Edit image window enabled at EOS Utility startup

than sRGB (such as Adobe RGB), the color reproduction range of the
imagePROGRAF printer is fully utilized and the image is printed with
a wider color gamut than an image that has an sRGB color space,
with green and blue in particular being reproduced vividly.

Preferences

S G  View settings Tool palette Color management J

Startup folder

@ Last displayed folder

Cancel [ { OK. |
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General Settings

You can specify the folder that opens when DPP is started up, image
quality of displayed and saved RAW images, etc.

Preferences

[ AR View settings Tool palette Color management |

Startup folder
() Last displayed folder
() Specified folder

Browse Macintosh HD/Users fuser/Desktop

Save recipe

G} Display message when adding file

: | Add to file automatically

Viewing and saving RAW images

G/-, High quality (recommended) View,/save RAW images at high quality

z Mairé is reduced and the NR tool palette can be used
) High speed

JPEC image quality
"] Remove block noise and mosquito noise

Default value of output resolution

350 dpi(1-60000)

At EOS Utility startup

|| Edit image window enabled at EOS Utility startup

Cancel | | oK |

Viewing and saving RAW images

You can select from two types of image quality for displaying/saving
RAW images: high image quality with false color reduction processing
and noise reduction function (p.60) used, or high speed without false
color processing and noise reduction function used.

[High quality]
False color reduction processing is automatically applied, and the
image can be displayed/saved as a false color reduced-high quality
image. Furthermore, you can use the noise reduction function (p.60)
to reduce the luminance noise and chrominance noise.
Because the effects of the false color reduction processing and noise
reduction function are difficult to see in the [50% view] or [Fit to
window] display of the edit window and edit image window, use
[100% view] or [200% view] to check.
We recommend that you normally set [High quality] for a balance
between image quality and display speed.

[High speed]
Since false color reduction processing is not applied, the display
speed of a RAW image in the edit window or the edit image window,
and the time it takes to save a RAW image is shorter than with [High
quality].
You cannot use the noise reduction function (p.60).
Depending on the image, it may be displayed/saved with false color
or noise being noticeable.

© For images shot with ISO speed range expansion set, the difference
in image quality between [High quality] and [High speed] becomes
remarkable. To check the image quality of images shot with ISO
speed range expansion, make sure to set [High quality] and check
the images in the edit window or edit image window.
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JPEG image quality

[Remove block noise and mosquito noise]
You can improve the quality of a JPEG image by reducing the noise
particular to JPEG images.
This setting is also effective when RAW images are converted to
JPEG images and saved (p.42, p.99) and for JPEG images that have
been saved with a different name.

? The extent of the improvement in noise reduction

The higher the JPEG image’s compression rate, the more noise is
reduced. When the compression rate is low, the effect of noise reduction
may not be noticeable.

Default value of output resolution

You can set the resolution for RAW images converted and saved as
JPEG or TIFF images (p.42, p.99).

View Settings

You can specify settings relating to the display.

Preferences

| General settings | Wiew il | Tool palette Color management

Grid pitch
64 Pixels(8~256)

Locking selected image

g Images opened in Edit window remain selected in main window

Magnification in Edit window
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Magnification when the Edit/Edit image window is double-clicked

) so% O 100% O 200%

RAW and JPEG

| E Display only CR2 images for CR2 and JPEG files of the same name

Sort order in main window

W Retain sort order

Highlight/shadow warning
-

Highlight 255 (192-255 [N
Shadaw 0 oo

Quick check tool display
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Introduction

Sort order in main window Tool Palette

You can set the order of images which have been rearranged in the
main window to be maintained or not maintained (p.21).

You can specify settings for the tool palette.
Contents at

If you checkmark the checkbox, the order of the rearranged images is ) . a Glance
maintained even if you quit DPP or select another folder in the folder eI
area.
. . General settings View settings | Tool palette | Color management A

If you remove the check mark, the order of the rearranged images is not @ BaS[{?
maintained and reverts to the previous order when you quit DPP or Default settings of RGB Tone curve mode peration
SeleCt anOther fOIder n the f0|der area. Tone curve mode Tone curve interpolation method Histogram

e O Eye— Advanced

e bt Operation

Highlight/shadow warning

Tool palette display in Edit Image Window

Highlighted/shaded areas that exceed the set range can be displayed ® Docking display AdvSmced
on the image as warning indicators (p.53). 2T der i Image®diting
Modified Picture Style settings and nting

g Retain settings of each Picture Style

Tool palette display mode .
| Same for Main window and Edit window Process'”g
. T, _ Large Numbers
. efault noise reduction settings of ImageS
‘@ Apply camera settings
() Set as defaults Ed|t|ng
RAW luminance noise reduction: @ O : J PEG/TI FF
RAW chrominance noise reduction: o £ - Imag es
TIFF/JPEG luminance noise reduction: ()
TIFF/JPEG chrominance noise reduction: ()] @—
RN RN Reference
( Cancel ) f 0K a
. Index
Default settings of RGB Tone curve mode

You cannot apply changes to the settings until you re-open the folder.

? Changes are not applied to the edited image @ @

Even if the default setting is changed, the new default setting is not @
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change the settings individually.
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Modified Picture Style settings

You can select whether the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings will be changed accordingly or
retained, when you change the Picture Style.
If you checkmark the checkbox, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be changed to match the
camera’s preset settings, when you change the Picture Style.
If you remove the check mark, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be retained, even if you
change the Picture Style.

Default noise reduction settings

You can set a default beforehand for the noise reduction level.
RAW Images
» When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.
JPEG/TIFF Images
* You can set a desired default noise reduction level beforehand.
For images not having a recipe attached, the default set here for noise
reduction level is applied. However, if you want to apply settings to
images in the opened folder, you need to re-open the folder after making
settings here. For images with a recipe attached, the noise level
recorded in the recipe remains as it is and the default for noise reduction
level set here is not applied.

AL/

=@> Advantages of setting a noise reduction default

In instances where the same level of noise occurs in several images,
such as images shot with high ISO speed, setting an appropriate default
noise reduction setting enables you to apply a batch noise reduction
default to all the images displayed in DPP (excluding images with a
recipe attached). This eliminates the need to apply noise reduction to
each individual image. And, since you always shoot with the same
conditions, it is also useful when you want to set the same noise
reduction level for all shot images.

Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

Preferences

I General settings View settings Tool palette Color management |

Default settings of Work color space
() sRGB

() Adobe RGB

() wide Gamut RGB

() Apple RGE

() ColorMatch RGB

Color matching settings
For display:

() sRGB

(®) Use the OS settings

O Monitor profile

ic-f'\-sv:-... _., MacOSX/ 300000 | ColorSync/Profiles /iMac-00000610-0000-9C6B- 0000-0000042....
Printing profile: Rendering intents:
None = ?] Perceptual
*) Relative Colorimetric
CMYK simulation profile: Rendering intents:
None ﬂ Perceptual

*) Relative Colorimetric
Rendering intents when using Easy-PhotoPrint

() Perceptual

(*) Relative Colorimetric

Cancel ) € 0K 3
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Default settings of Work color space

You can select from five types of color space (p.144) that is applied as a
default setting in RAW images. Color space that has been set is applied
as the color space when a RAW image is converted and saved (p.42,
p.99) or printed (p.43, p.46, p.85 to p.89).
If you have changed the setting, and you restart DPP, the new setting
is applied as the default setting color space.
You can check color space that has been set in an image in the main
window (p.124, p.125), the edit window (p.127), and the edit image
window (p.133).

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

|§| You can set a color space that is different from the default settings
for each image (p.77).

Display setting (color setting of the monitor)
Where a profile (p.143) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.

If you select [Use the OS settings], the color profile set in OS will also
be applied in DPP.

Select the [Monitor profile], click the [Browse] button and in the dialog
box that appears, select a profile for your monitor.

=)= Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.

Setting of printing profile (color setting of the printer)

Where a profile is not attached to the printer you are using to print
images, you can print an image and simulate the colors displayed on
screen by setting the profile in DPP. The profile that has been set is
applied to all printing (p.46, p.85, p.86) except when printing with a
Canon inkjet printer (p.43, p.87 to p.89).

@ If you specify a profile for printing in DPP, set the color adjustment
function of the printer driver to off. If it is left on, the image may be
printed in colors different from those displayed on screen.

:@3 Automatic settings for printing using EPP EX, and linked
printing

If you are printing using a Canon inkjet printer (p.43) or using linked
printing (p.87, p.89), a profile is set automatically even when the
[Printing profile] setting is not performed. This allows you to print faithful
colors easily.

Setting of CMYK simulation profile

You can select the color when printing in the CMYK environment of a
printing machine, etc. from four types of profiles (p.144) and perform
simulation on screen.
When CMYK simulation has been set, [CMYK] appears (p.124, p.125,
p.127, p.133) at the bottom of the main window, edit window and edit
image window, and colors can be checked.
To temporarily cancel CMYK simulation, press the <space> key.

R

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advapced
Imag iting
and Pfinting

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00

94



4 Useful Functions for Processing Large Numbers of RAW Images

For users shooting a large amount of RAW images, the convenient
function of batch processing large amounts of RAW images is explained
here.

Introduction

—_—

Contents at
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Utilizing Adjustment Contents (Recipe)................... 96 e
Saving RecipesasaFile.........ccccciiiee, 97 Operation
Loading and Pasting ReCIpes.........ccccccevvvvvvveeeininnenn. 97 T
Copying a Recipe and Applying to Another Image..... 97 Advanced
Operati
Batch Apply White Balance to Images (Personal White it
BalanCe) ...co.ovviiiiiiii s 98 N oceg
Registering Personal White Balance.......................... 98  |Image Editing
. . and Printing
Applying Personal White Balance .................cccoeeee. 08 S——
Batch Save as JPEG or TIFF Images (Batch LaPrréocsiggrs
PrOCESSING) . ..uvuiieiieiiiiie ettt 99 of Im&ges
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.vrd”) and loaded and

applied to another image.

You can edit images efficiently by selecting and adjusting one image
from images shot with the same shooting environment and batch
applying the adjustment results to a large number of images.

8 &S ¥ IMG_DO0L.CRZ
[ RAW | RGB NR/ALO LENS -

‘Efig?ltﬂ!s! adjustment =) |
VO Y

‘While balance adjustment =] |
Vad 1 2 EI:HSI.CI -

(@ uo) %) (Tune..)
A J

‘Piclure Style | & ||

(@ Gtandard) B srovsc...

Contrast: it o i
Highlight- e e
Shadow: A
! Linear
Color tone: 10 T@T
Color saturation: 1) WT
[ Unsharp mask ! 3]
Strength: L Sy
Fineness ) i s
Threshold: m

<

_& R m:age data

I \N
.vrd}

Contents adjusted using the tool
palette can be handled
individually as a recipe file
(extension “.vrd").

|§| The adjustment contents of JPEG or TIFF images (p.103) can be
saved as a recipe file (extension “.vrd”) and loaded and applied to
another image in the same way as with RAW images.

? Additional information

Recipe data includes tool palette contents

Recipe data includes adjustments made with the tool palette ([RAW],
[RGB], [NR/ALO] and [LENS]). For this reason, other editing content
such as trimming or dust-erasure (copy stamp) is not included in the

recipe data.

Recipes adjusted with the [RAW] tool palette can only be applied

to RAW images

Adjustments in the [RAW] tool palette, which can only be made for
RAW images, are not applied to a JPEG or TIFF image even if they

are pasted.
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Saving Recipes as a File Copying a Recipe and Applying to Another Image
Select an edited image, and then select the [Edit] You can copy a recipe of an edited image and then apply it to another
menu » [Save recipe in file]. image.

The [Save] dialog box appears. Select the image from which arecipe is to be copied

Select the destination folder, enter a file name, and and then select the [Edit] menu » [Copy recipe to
then click the [Save] button. clipboard].

The recipe is copied.

? Check the contents of arecipe file by pasting to an image Select the image to Whi_Ch the recipe is to b? applied
o _ _ and then select the [Edit] menu » [Paste recipe to
When you do not know the contents of a recipe file, paste it to an image

and check the settings in the tool palette. When only a few settings are SeleCted_ Imag e]j _
adjusted, we recommend you use a file name that describes the The recipe is applied to the image.
contents or that you separately record the adjustments as text

information.

Loading and Pasting Recipes

Select the image to which arecipe is to be applied,
and then select the [Edit] menu » [Read and paste
recipe from file].

The [Open] dialog box appears.

Select arecipe and click the [Open] button.
The recipe is applied to the image.
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Introduction

Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific - :

shooting environment can be registered as personal white balance. You Applyl ng Personal White Balance

can then perform efficient white balance adjustment by applying this In the main window, select the image to which white

personal white balance to a large number of RAW images shot in the balance is to be applied Cg'gf;rfgeat

same shooting environment.

Click the [Tool palette] button on the toolbar.

. . : The tool palette appears. Basic
Registering Personal White Balance _ _ Operation
Adi h hite bal Click the personal white balance number button that
To adjust white balance, select a setting other than [ ()] from Advanced
the [White balance adjustment] list box (p.28). You will be unable [ _RAW | RGB NR/ALO LENS [ Operation
to register the adjustments if you select [ g& ()]. \Eﬂg*ﬂﬂﬁss adjustment =3
In the [RAW] tool palette, click the [Register] button. gl N 00 Advanced
The [Register personal white balance] dialog box appears. [Whte balance adjustment . (5] 'Qna(?.eaﬁgt'ﬂ]"gg
Select the button number to be registered from the !E (EENEN st )
list and click the [OK] button. == - > Proce@sing
Larg bers
8N [#| Register personal white balance meges
: s 5 Picture Style | =y |
Register current setting in personal white balance ‘ L.,,,._J‘
s s . 'L & (Standard) } i] (Brm\rse...) Editing
Current setting: Click white balance b ; JPEG/TIEE
[I Custom 1 .:]] : Images
¥ Cancel ) E‘—GK—;,
Reference
-10.0 30 -60 -40 -20 0 20 40
Contrast: ] '_e_
Highlight- { T —
Shadow: (]} _—e—_—‘ [riafet
[_| Linear - )
Color tone: 1] F_@_
Color saturation: 1) '—_—@——‘
" Unsharp mask ‘] @ @
Strength: 1m e_'

Fineness: (0 G_T_T
Threshald: Y] 6.. LT

Personal white balance is applied to all the selected images.

® You cannot change or adjust white balance with multiple-exposure

RAW images created on the camera. 08



Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile
JPEG or TIFF images.

The images are saved as separate images, so the RAW images remain
unaffected.

In the main window, select multiple images to be
converted.

Click the [Batch process] button on the toolbar
(p.124).
The [Batch settings] window appears.

Specify the required settings, and then click the
[Execute] button.

Batch settings
Save folder

IMG_0001.CR2
IMG_0002.CR2 ENG/Users/canon/Desktop [ Browse...

IMG_0003.CR2
IMG_0004.CR2
IMG_0005.CR2 Kind of file [ Exif-JPEG 2]
IMG_0006.CR2
IMG_0007.CR2
IMG_0008.CR2 Output setting

IMG_0009.CR2
IMG_0010.CR2 Qutput resolution 350 dpi @ Embed ICC profile

File format

Image quality J 10

IMG_0011.CR2 Resize setting
IMG_0012.CR2 | Resize V Lock aspect ratio
IMG_0013.CR2 Width Height Unit
IMG_0014.CR2 5472 B 3648 i
IMG_0015.CR2 (5472 pixel ) (3648 pixel )

File name

() Current file name

String

() New file name
String Sequence number

Ex: IMG_0001 JPG, IMG_0002 PG

Shooting info setting

(=) Include all shooting info
(") Remove only GPS info
‘:‘Ilemuve shooting info

Image transfer settings

_| Open image using software

The batch processing dialog box appears and saving begins.
When all the images are saved, the [Terminate] button appears in
the batch processing dialog box.

In the processing dialog box, click the [Terminate] button.

? Saving images with recipe is not possible

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.41, p.119) to edited RAW images.

=)= To save the developing/editing results for the version you are currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two different versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

@ skillful batch saving

While saving is being performed, you can continue working in
another window

Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the edit window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.

® If the message [Insufficient memory.] appears, too many images are
selected at the same time. Decrease the number of selected images.

@ If you have selected [New file name] in [File name], [Sequence
number] has to be set.
By saving as explained on this page, a trimmed image (p.38,
p.111) or dust-erased image (p.73 to p.77, p.114 to p.118)
actually becomes a trimmed image or dust-erased image.
For a list of [Batch settings] window functions, see p.141.
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Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike Select Photoshop CS.

[Transferring a RAW Image to Photoshop] (p.77), you transfer images In the [Open] dialog box, select a Photoshop CS file or an alias
that have first been converted and saved as a seperate image, so the and click the [Open] button.

transferred image will not disappear after quitting the destination

Introduction

Contents at

software. The software used here as an example is Adobe Photoshop The [Open]_ dlalog_ box clpses and [Image transfer settings] in the a Glance
cS [Batch settings] window is set to Photoshop CS.
Checkmark [Open image using software]. A
In the main window, select multiple images to be image transfer settings Operation
tl’an Sferred . @Gpen image using software
. Adobe Ph hop CS B
Click the [Batch process] button on the toolbar e e Advanced
(p.124) f Cancel T Exerur ) Operation

The [Batch settings] window appears.

Click the [Execute] button.

Perform settings required for transferring (e.g. file The processing dialog box appears and batch transfer begins. |mg%\éaggﬁ?ng
format). When the first image has been transferred, Photoshop CS starts and Printing

) up and transferred images are displayed in transferred order.
Click the [Browse] button.

Procefésing
Batch settings Larg berS
IMGoooLcRz | e folder of Im ges
IMG_0002.CR2 ENG/Users{canonDesktop | Browse...
IMCE0003,CR2 File format
IMG_0004.CR2
| i ind of file [ Exif- : ] —
o | comm— Editing
IMG_0007.CR2 JPEG/TIFF
mgggg;gii Output setting Im ages
IMG_0010.CR2 Qutput resalution 350 dpi (] Embed ICC profile
IMG_0011.CRZ Resize setting
IMG_0012.CR2 | Resize V! Lock aspect ratio
IMG_0013.CR2 Width Height Unit
IMG_0014.CR2 5472 [ 3648
IMG_0015.CR2 bl e Reference
File name
() Current file name
String
() New file name
i - 00 Index
Bx. IMG_0001.JPG, IMG_0002 JPG
~— ——
Shooting info setting
(+)Include all shooting info
(_JRemove only GPS info
(_JRemove shooting info @ @
Image transfer settings
(] Open image using software
1 { Browse... |
| C | | Execute
© If the message [Insufficient memory.] appears, too many images are
The [Open] dialog box appears. selected at the same time. Decrease the number of selected

images.
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Batch Change the File Name of Images

In the main window, select multiple images of which
the file names are to be changed.

Introduction

Changing the File Name of Images in the Order in the Main Window

When you change the order of the images in the main window, you can

Contents at

Select the [Tools] menu » [Start Rename tool]. change in one operation the names of the files for the images, in the a Glance
The rename window appears. order they were rearranged.
Specify the required settings (p.142) and click the . : . .
pecity d gs (p.142) Change the order of the images in the main window Basic
[Execute] button. Operation
(p.21).
MacOSX/Users /canon/Pictures /Photo/xxxx_xx_xx
e N e In the main window, select multiple images of which .
ove (=} shooting DateTime (%) sequence number ) Do not change %] the file names are to be changed. Operation
Sug}Finumamwmduw SEI:JL:JZTE "umber:Sa\te sequence number SeIeCt the [TOOlS] menu } [Start Rename too'] "
;;'h‘eNé";eD ol Advanced
hdHOBLDI DAt Bl Shooting Date/Time ) . . |mage Edltlng
‘fc = Sl LA 1: Select [Fit to main window]. and Printing
— Lopy ename MM-DD-YY vy
MacSX /Users /canon Deskiop ™ Insert underbar MacOsX
Procefésing
Original File Modified File Name Larg bers
IMG_0001.CR2 | |DPP_09-13-06_0001.CR2 ] File Mame of Im ges
IMG_0001.JPG U DPP_09-13-06_0002.JPC U —
=g G = e Editing
o S g Basic Settings e
IMG_0004.JPG DPP_09-12-06_0008.IPC mages
IMG_0005.CR2 < DPP_09-13-06_0009.CRZ < 50”
I?G,UDOS.JPG . o 1 E:PP,DB—l}—OB,UDlO.IFG - - ]
S f*) Fit to main window
(_Cancel —=
- " Y File Name Reference
Processing begins and the file names are changed. _ Shooting Date/Time
'? Changes cannot be made when the file name is duplicated Specify the required settings (p.142). Index
If a file name in red text has appeared in [Modified File Name], the file name To copy an image, checkmark [Copy and Renamel]. R
has been duplicated. Changes cannot be made if even one file name has Click the [Execute] button.
been duplicated. Change the settings so that duplication does not occur. The file names are changed and the order in the main window is @ @
(D) The name of the movie files cannot be changed in DPP. maintained.
5 @ You cannot start up the rename tool from the [Collection] window (D) If the message [Insufficient memory.] appears, too many images are
(p.36, p.125). selected at the same time. Decrease the number of selected
For a list of the rename window functions, see p.142. images.
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5 Editing JPEG and TIFF Images

Introduction
DPP is software mainly aimed for advanced RAW image editing, but it —
also has JPEG and TIFF image editing functions. Here, the editing and
saving of JPEG and TIFF images are explained. Cgrgﬁinr;cgeat
Editing JPEG and TIFF Images...........cevvvvvvneennee. 103 ]

About the RGB Tool Palette .............cccocoeeeeeenenn 103 B

Automatically Adjusting Brightness and Color (Tone S

Curve ASSISt) ...ooooiiiiiii, 104

Adjusting Brightness and Contrast ...............c.co...... 105 gg‘é?;‘t‘i’gﬁ

Adjusting Color Tone Using Click White Balance..... 106

Adjusting Hue, Saturation and Sharpness................ 107

Tone Curve AdUSIMENt...........ccvovvreeeeeeieeereneneeens 108  [image diting

Adjusting Dynamic Range ..........cccccceevvvvviieeeesinnnnnn. 109 | and Printing
Reducing NOISE .........ovviiiiiiiiie e 110 )

. . . . Processing
Trimming and Adjusting the Angle of an Image..... 111  |Large Numbers
Performing Automatic Dust Erasure Processing ... 114 .2Mages |

Compatible Cameras.........ccoocveiiviieiiiiieceeeeen, 114 —

Automatic Dust Erasure Processing in the Main JPESH:F

WINAOW ... 115 i .qefe
Manually Erasing Dust (Repair Function).............. 116

Erasing Unwanted Parts of an Image (Copy Stamp Reference

FUNCHION). .. 118
Compositing and High Dynamic Range................. 118
Starting Up Map ULty .......cooeeeieiiiiiiieeeen 118 Index
Saving Editing Results.........ccoviiiiiiiiin 119 YV

Saving Editing Content to an Image............ccc...u...... 119

Saving as a Separate IMage .........ccoveveeeveeeveerennn. 119 @ @
Applying Editing Contents to Another Image......... 119
PrNtING ..o 119 @
Re-Editing an Image...........cooevviiiiiiiiiiiineeeeeeeeeeee, 120
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the [RGB] and [NR/ALO] tool palettes.

Because adjustment made with the tool palette (recipe) only changes
the image processing conditions, the “original image data itself” remains
unaffected. Therefore, there are no problems with image deterioration
that arise with editing and you can readjust your images any number of
times.

elajla) [¥ IMG_0015JPC
| RAW | RGB | NR/ALO  LENS
- —
EIraE)
Tone curve adjustment | B -||
e e | <] = | 2|
, |

255

Tone curve assist

oty 4

JPIi:‘.G,('IlIFlf image data

0 S I \N
- 255

4 [vrd ]

Brightness: VO 0 —_—

1 Contents adjusted using the tool
A palette can be handled
individually as a recipe file
(extension “.vrd”) (p.96, p.119).

Hue:
Saturation:

Sharpness:

In DPP all the adjustments (image processing conditions information)
made with the tool palette can be saved in the image as data called a
“recipe” (p.119), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.vrd”) (p.96, p.119).

About the RGB Tool Palette

With the functions in the [RGB] tool palette, you can adjust JPEG and
TIFF images with the same functions as ordinary image editing
software.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than the [RAW] tool palette, the image
color may be saturated, or the image quality may deteriorate if you
adjust too much. Therefore, take care not to adjust your images to an
excessive degree.

You can adjust RAW images with the functions in the [RGB] tool palette.

However, for functions other than tone curve adjustment (p.108) and
automatic adjustment (p.104), we recommend adjusting RAW images
using the same functions available in the [RAW] tool palette.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.143). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click the desired automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

" RAW | RGB | NR/ALO  LENS |

‘Tune Curve assist

f——Reverts the tone curve
to the original settings

Tone curve adjustment

255 |- High

Standard

0 2535

Eﬂghtﬂess trrrnrerrYrrrrn e D\:t
Contrast: '———‘@'———“ ol
trnrrrereYrner et L

s

Huse: ||||||||||i|||||||||| [_?‘_j D-Et

Saturation: . @ B 100 ]
(AR EER SR ERERE R R — e

Sharpness: @—ibi 0 ?
TRLELER IR RN EE LRI R ot

The tone curve changes as adjusted.

|
\\/

=@~ Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

* Images which have been shot with the proper exposure

» Images where the brightness is unbalanced

¢ Images which are too dark

* Images which have extreme backlighting

@ If you click the [[2%]] button, the tone curve as well as the [Hue]

and [Saturation] revert to the default settings. Take care when
adjusting the [Hue] and [Saturation] individually (p.107).
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Introduction
: : : Brightness: Move the slider to the right to make an image
AdJ_UStI (16 B (U htness. and Contr_aSt brighter and to the left to make an image darker.
The brightness and contrast of an image can be adjusted. Contrast:  Used to adjust modulation and degree of contrast Contents at
of color. Move the slider to the right to make a Glance

| RAW | RGB | NRJALO = LENS - contrast of an image stronger and to the left to —
[Tone curve assist 0 [+ 2] make contrast weaker.
Basic

Tone curve adjustment EJ| Op eration
e r [ G| e | ——
- |

255

Advanced
Operation

—

Advanced
Image Editing

and Printing
—

\ _ Processing
\ T " Large Numbers
of Images

R —

Drag the sliders left or

0 255 : = g
= right
Brightness: ] ‘L— 9 J I:I”ﬁg:l:

Contrast: D-—l Enter numerical values

r——

Hue: e rrnreYrnernnnnn [EI Diﬂ
Saturation: '_Q—[E] 100 %) Reference
(R AR IR RN R M

Sharpness: e—- | n
p (RN RN NN EJ D L e

Index
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|§| The adjustment range is —100 to +100 (in 1-stop increments when
entering a value).



Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Click the [[~#]] button.

- RAW | RGB | NR/ALO LENS

‘Tnne curve assist A HE+ HED |
Tone curve adjustment L“_‘) |
Rc]s]

o
[
w |l
A

ErighmESS: trrrrrerrfrrrrn et
Contrast: ’_ﬁ—
i rrereYrnerreent

Hue: ||||||||||E|||||||||| [EJ
Saturation: ||||||||||E|||||||||| E’J 100

[aw] (aw) (anl| [an] [a0]

=

(=]

Sharpnesx E|||||||||||||||||||l E]

Click on a point that is to be the standard for white.

anA | Dightal Photo Professional - | MacSX/Users/canon /Pictures /Photo,/ xxxx_xx o (IMG_DD 10, JPG | |

(3067, 547); 06 222,233

The coordinates of the cursor position and the RGB values (8-bit
conversion)

=» The color of the image is adjusted with the point you selected as
the standard for white.
If you click on another point in the image, the white balance is
adjusted again.
To finish click white balance, click the [] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

|§| The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.
The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.92).
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Introduction
- : : Hue: Move the slider to the right to make color tones
Adjusting Hue, Saturation and Sharpness d N
more yellow, and to the left to make color tones
You can adjust hue (tone) and saturation and make the overall redder. Contents at
. ontents a
atmosphere of an image sharper or softer. Saturation: Move the slider to the right to make the color = @lEree
deeper, and to the left to make the color weaker. —
| RAW | RGB = NR/ALO  LENS | Sharpness: Move the slider to the right to make an image
- i Basic
‘Tane curve assist 0| @b| sharper, and to the left to make an image softer. opa R
Tone curve adjustment o] |
e r [ G| & |
255] ' Advanced
Operation
Advanced
Image Editing
and Printing
—_—
Processing
Large Numbers
\ of Images
0 e, | E g
0 255 JP IFF
< - I es
E"ghm!ss trrrrereYrerrnrene Dl:r'
cuntraSl: trrrrrereYrerrrrennt Dz
Hue: mll et E‘I D E— Reference
Saturation: o[ 100 E—} Enter numerical values
Sharpness: @—-H 0 E——
. . Index
Drag the sliders left or right ? Sharpness is unnatural
Adjust sharpness with the window view set to [100% view], [50% view]
or [200% view]. If the view is set to [Fit to window] (full view), the
sharpness will seem unnatural.
|§| The adjustment range is —30 to 30 for hue, 0 to 200 for saturation, @
and 0 to 500 for sharpness (in 1-stop increments when entering a
value).
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Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.143).

Select the tone curve mode and interpolation

method.
| RAW | RGB | NR/ALO = LENS |
|Tnne Curve assist [ O I [+ !-Eb.‘
Tone curve adjustment | =

S

i{ﬁs]RIG|B| @

255

v Curve
Straight
<control> + click inside
vRGERGE the graph to display the
Luminance RG B menu
I:ll -
0 . i 2l55.
Erightness: 0 i
Caontrast: ] i
Hue: 3
Saturation:
ESharpness:

Make adjustments.

Batch adjusts RGB
Adjusts each channel

[ 1

RAW | RGE | NRJALO  LENS

|Tone Curve assist [ IO | Eb‘

Tone cprve adjustment | =y

—

o~ <[+ ) 7|

255

Click to add a [[] (point)
Adjust by dragging []

Brightness:

Cantrast:

B} ol
kel 0

Hue:

Saturation:

Sharpness:

The horizontal axis shows the input level and the vertical axis
shows the output level.

The maximum number of [[J] is 8.

To delete a [[]], double-click on the [[]].

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any
adjustments (p.92).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.92).
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Introduction

Adj usti ng Dynamic Range |§| The setting range of shadow points is 0 to 247 (in 1-stop -
increments when entering a value).

The setting range of highlight points is 8 to 255 (in 1-stop Contents at
increments when entering a value). a Glance
The histogram display changes according to adjustment. You can —
also fix the histogram display to the display before any

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Move downwards

Output highlight points adjustments (p.92). Basic
Operation
| RAW | RGB | NR/ALO = LENS |
‘Tcne curve assist 0 2+ 2o ‘
Tone curve adjustment - Jl-— Reverts the Advanced
image to the BpFT ation
W e [ || Z| imag
Output —— 259 Orlg_mal
highlight point settings Advanced
numerical Image Editing
value and Printing
D e
Processing
Move to the — Move to the Large Numbers
right left of Images
Input shadow | Input highlight
points points Editthg
] JP IFF
5 I es
Outputshadow — o J
pointnumerical 0 255+ Input highlight
Value E"ghme 5 e geYrrrrninnnn D z pOint numerical Reference
Cﬂntrasl} '_@_‘ ol value
Input Shadow_ (AR ARRRRE b (ARNENU AT : : —_—
pOintnumericaI Hue trrrrrregryrrernrnnng lEJ D ‘E‘
value Saturation: (o) 100[) Index
Sharpness: e oy | 0 ?

Move upwards
Output shadow points @ @
The horizontal axis shows the input level and the vertical axis shows @

the output level.
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Reducing Noise

You can reduce noise that arises in JPEG and TIFF images that have
been shot at night or with a high ISO speed.

Select the [NR/ALO] tab sheet from the tool palette in
the edit window or edit image window.

Click the [NR Preview] button.
| Noise reduction

RAW ﬁ NR Preview... |

The [NR Preview] window appears.

Adjust an image.

‘|@nn

NR Preview

Navigator
window

— Enlargement
display
position

TIFF/JPEG

Luminance noise reducf

(01

) E— z Drag the
n sliders

( Cancel ) ( Apply )

Chrominance noise redjgay
{0}

|
NR check window

You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect.

The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.

You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

ALy
N

-
- ~

Click the [Apply] button.
Noise reduction is applied to the image and the image is
redisplayed.

To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/ALO]
tool palette (p.129) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

5

If [Luminance noise reduction] has been set, resolution may be
reduced along with reduction of noise.

If [Chrominance noise reduction] has been set, color bleeding
may occur along with reduction of noise.

You can set the batch processing settings for noise reduction
beforehand, using [Default noise reduction settings] in the [Tool
palette] tab sheet in the [Preferences] (p.92). This is particularly
useful for applying noise reduction to all the images in a folder at
once, such as batch noise reduction for images with high ISO
speeds. However, where images have a recipe attached, the
noise level recorded in the recipe is applied.

For a list of [NR Preview] window functions, see p.131.
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You can crop only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before trimming. If
you select [Circle] for [Aspect ratio], the area outside the specified range
will only be masked in black and the image will not be trimmed.

Select the image to be trimmed.

Open the trimming/angle adjustment window.
Click the [Trimming Angle] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

Rotare right Quick Sramp Trimming
check

The trimming/angle adjustment window appears.
Editing can be done once the image is displayed clearly in the
trimming/angle adjustment window.

Trimming and Adjusting the Angle of an Image

Adjust the angle of the image as needed.
Trimming/angle adjustment window

# 171 IMG_DO01.JFG [3456 x 2304]

Largest
possible
trimming
range

Click
(rotate
image left
or right in
90-degree
increments)

ABSA 81 ) -x { ST TELY b= 103 n 026201150 ) i

|
Drag* (0.01-degree increments;
adjustment range: -45 to +45 degrees)

Use the mouse (click A/V) to adjust the angle or
directly enter the adjustment angle* (0.01-degree
increments; adjustable range: -45 to +45 degrees)

* You cannot adjust the angle of images that exceed 9999 x 6666
pixels in size.

If you click [Center on Screen], you can display the trimming
range in the center of the window.

If you click the [OK] button after adjusting only the angle of the
image, the image will be trimmed at the largest possible trimming
range.

|§| When aspect ratio information is attached to an image shot with the
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-
1D Mark Ill, EOS 5D Mark Ill, EOS 6D, EOS 7D Mark Il, EOS 7D,
EOS 70D, EOS 60D, EOS REBEL T5i/700D, EOS REBEL SL1/
100D, EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL
T5/1200D, EOS M2 or EOS M, the trimming range based on the
aspect ratio information is displayed.
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Select aratio and drag the trimming range.

ana = 171 IMG_0001 JRC (3456 x 2504]

Select a
trimming
ratio

Drag the
e trimming
— range

A4 30 = 226D, 1403 ) = (3577 & 1051100301 i

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range. (Not available
when [Circle] is selected.)

List of aspect ratios (width : height)

1:1

3:2

2:3

4:3

3:4

5:4

4:5

A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

Circle
[Free]: You can trim an image to any size, regardless of the
selectable ratio.
[Custom]: You can trim an image at the specified ratio.
[Circle]: The area outside the specified range is masked in
black. The image is not trimmed.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.126).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its trimmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at
any time

A trimmed image is displayed or printed as a trimmed image.
However, since the image is not actually trimmed, you can always
revert to the original image by clicking the [Reset] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.120).

Display of the trimmed image in each window

e Main window: The frame showing the trimming range is
displayed on the image (p.126).

* Edit window:

 Editimage window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when saved as a separate image
The trimmed JPEG or TIFF image actually becomes a trimmed image
when saved as a separate image (p.119).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D
Mark Ill, EOS 5D Mark Ill, EOS 6D, EOS 7D Mark Il, EOS 7D, EOS
70D, EOS 60D, EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS
REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T5/1200D,
EOS M2 or EOS M, the set trimming range based on the aspect ratio
information is displayed. Since the image is not actually trimmed, you
can change the trimming range or revert to the condition before
trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 5D Mark Ill, EOS 6D, EOS 7D Mark I, EOS
70D, EOS 60D, EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS
REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T5/1200D,
EOS M2 or EOS M, its trimming range cannot be changed nor
reverted to the condition before trimming, since the image is actually
trimmed and saved in the set trimming ratio.*

The image is displayed in its trimmed condition.

When reverting to the condition before trimming is performed based

on the aspect ratio information at the time of shooting, click the

[Reset] button. Also, if you want to cancel all the trimming range, click

the [Clear] button (p.135).

* For JPEG images shot with EOS 5D Mark Il or EOS 7D Mark Il,
and [Add cropping information] is set in Custom Functions, aspect
ratio information is only set and the image is not actually trimmed.

AL/

-@> Convenient functions of the trimming/angle adjustment
window

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

@ For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view the image in detail in the
trimming/angle adjustment window, so using this function is not
recommended.

|§| For a list of the trimming/angle adjustment window functions, see
p.135.
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v ® 9@ 2

Rotate left  Rotats right Ouick Stamp Trimming Batch

check

The copy stamp window appeatrs.

@ Dust Delete Data is not attached to images having settings specified

during RAW processing on the camera for distortion correction,
chromatic aberration correction, etc. As a result, you cannot perform
automatic dust erasure processing on such images.

Performing Automatic Dust Erasure Processing .
The Dust Delete Data that is appended to images shot with the camera When the image has redrawn itself, click the [Apply
that can attach this data, can be used to automatically erase dust spots. Dust Delete Data] button. —
' e Cont;ents at
. a Glance
Compatible Cameras
Basic
EOS-1D X EOCS-1D C EOS-1D Mark IV Operation
EOS-1Ds Mark 1l EOS-1D Mark IlI EOS 5D Mark Il —
EOS 5D Mark II EOS 6D EOS 7D Mark II Advanced
EOS 7D EOS 70D EOS 60D b
_
EOS 50D EOS 40D EOS REBEL
T5i/700D Advanced
Image Editing
EOS REBEL EOS REBEL EOS REBEL and Printing
. . S ——
SL1/100D T4i/650D T3i/600D
EOS REBEL EOS REBEL EOS DIGITAL REBEL » Dust spots are erased in a single operation. L;;"ecﬁjrﬂggrs
T2i/550D T1i/500D XSi/450D . o of Images
Click the [OK] button to return to the main window. 7"
EO_S DIGITAL REBEL EOS REBEL EOS REBEL =»The [&] mark (p.126) is displayed on an image from which dust
XTi/400D DIGITAL T5/1200D T3/1100D spots have been erased. JP%IQFF
EOS DIGITAL REBEL I es
XS/1000D EOS M2 EOS M
In the main window, select an image appended with Reference
Dust Delete Data. R
Click the [Stamp] button.
Index
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O
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? Additional Information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.120).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.116) or the copy stamp function (p.118).

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.119).

A/

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, see p.140.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »

[Apply Dust Delete Data].
Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image you want to
erase dust spots.

Click the [Stamp] button.

Digital Photo Professional - [ MacOSX /Users/canon/Pic

Cuick Stamp Trimming
check

The copy stamp window appeatrs.

When the image has redrawn itself, double-click the
point from where dust is to be erased.

1 12 IGO0 JPC {1458 « 2304]

Double-
click

[T L T ——

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spots to be
erased.
If the dust spot is dark in color, click the [ @»( 3 |] button, and if
the dust spot is light in color, click the [ {_»( ) ] button.
When you move the cursor over the image, the dust erasure
range appears as [O].
Place the dust spot to be erased within the [O] and
click.

B * LIE MAC_DON0 PG [H486 2 2304]

O s Click

The dust spot within the [O] is erased.

Click on another part of the image to continue erasing dust spots
in the image.

To erase dust in another part of the image, click the button
clicked in step 4 again to cancel dust erasure processing and
perform the operation again from step 3.

When the dust spot cannot be erased, [(§)] is displayed.

Click the [OK] button to return to the main window.
The [ ] mark (p.126) is displayed on an image from which dust
spots have been erased.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.118).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.120).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.119).

A/

~
-

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 5, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you
can efficiently erase dust spots by clicking the images while holding
down the <3B8> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <shift> key, and then displaying the copy
stamp window.

® For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

|§| For a list of the copy stamp window functions, see p.140.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1to 3in “Manually Erasing Dust (Repair
Function)” (p.116).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <option> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [@,] mark (p.126) is displayed on a corrected image.

Compositing and High Dynamic Range
You can composite images also using JPEG and TIFF images in the
same way as RAW images as described below.

Compositing Images (p.78)
Creating HDR (High Dynamic Range) Images (p.81)

Starting Up Map Utility
You can start up Map Utility using the procedure below.
Starting Up Map Utility (p.84)

R

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers

of Images

E g
JP IFF
| es

Reference

Index

00

118



Saving Editing Results

Saving Editing Content to an Image

All the contents (recipe) adjusted with the tool palette (p.103 to p.110)
as well as the trimmed range (p.111) and dust-erasure (p.114 to p.118)
information can be saved to a JPEG or TIFF image, or to a separate
JPEG or TIFF image.

Select the [File] menu » desired item.

Open in Edit window FO
Open in Edit window (enlarged)

Close window W
Save #/S
Save As... ﬂsﬁL
Add thumbnail to image and save 3T
Convert and save... #=D
Batch process... #B
Create new folder 3N
Print... #®P
Print with detailed setting... 48D
Print contact sheets... ~HP
Plug-in printing »
Add to collection ®G
Remove from collection 138G
Clear collection

Delete |
Info |

Your adjustments are saved to the image.

Saving as a Separate Image

If a JPEG or TIFF image is adjusted with the tool palette (p.103 to p.110)
and then saved in the same way as a RAW image as described below,
the image can be saved as a separate image with the adjustments
(recipe) applied to it.
Furthermore, if a trimmed image (p.111) or dust-erased image (p.114 to
p.118) is also saved in the same way, it actually becomes a trimmed or
dust-erased image.

Saving as a JPEG or TIFF Image (p.42)

Batch save as JPEG or TIFF images (batch processing) (p.99)
By saving as a separate JPEG or TIFF image as explained above, the
adjustments made with the tool palette are applied, and some image
deterioration that accompanies editing/saving occurs as when editing
with ordinary image editing software.

Applying Editing Contents to Another Image

You can copy the adjustment contents (recipe) of JPEG and TIFF
images that have been adjusted with the tool palette and apply them to
another image with the procedures below, in the same way as with RAW
images.

Applying adjustment contents to another image (p.41)

Utilizing adjustment contents (recipe) (p.96)

Printing
Edited JPEG and TIFF images can be printed with the procedures
below as with RAW images.

Printing (p.43)

Printing with shooting information (p.85)

Printing a thumbnail list (contact sheet printing) (p.86)

Printing RAW images on a high-end Canon printer (p.87)
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Re-Editing an Image
Only the image processing conditions are changed in images adjusted
with the tool palette (p.103 to p.110), so the “original image data itself”

remains unaffected. Also, the trimming range or dust-erasure
information of a trimmed image (p.111) or dust-erased image (p.114 to

Introduction

—_—

Contents at

L ’ Gl
p.118) is simply saved to the image. aslance
For this reason, you can undo any adjustments saved (p.119) to the
image, trimming range and dust-erasure information, and revert to the Basic
condition when last saved, or when the image was shot. Operation

Select the image that is to be re-edited.
Advanced
Operation

Select the [Adjustment] menu P desired item.

Rotate left #L Ima(gj;%Edi_ting
Rotate right #R and Printing
Apply Dust Delete Data Processing
Large Numbers
Work color space > of Images

-———

Tone Curve Assist - Standard

Tone Curve Assist - High E g
JP IFF
Revert to last saved settings “_3Z I es
Revert to shot settings ~¥Z
The image reverts to the conditions of the selected item. Reference
—_—
Index
e

O
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Reference

This reference section has been provided to enhance your experience
using DPP.
It contains various troubleshooting solutions, how to delete DPP from
your computer, explanations of the various windows and a glossary.

B An Index is provided at the end of the chapter for you to easily find
information you are looking for.
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Troubleshooting

If DPP is not operating correctly, refer to the items below.

Introduction

Installation could not be completed correctly

You cannot install software unless you are logged into an account with
Administrator privileges. Log in again into an account with
Administrator privileges. For how to log in and how to specify
Administrator settings, refer to the User’s Manual for the Macintosh
computer you are using or for OS.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements are not met. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Quit
any applications other than DPP.

The card reader does not detect the SD card

Depending on the card reader and computer OS used, SDXC cards
might not be correctly detected. In such a case, connect your camera
and computer with the provided interface cable, and transfer the
images to your computer using EOS Utility (provided software).

Images are not displayed properly

Images that are not supported by DPP are not displayed. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2, 2.21 or 2.3 compatible images and TIFF images other than
Exif compatible images may not display properly (p.3).

When a dust-erased image (p.73 to p.77, p.114 to p.118) is displayed
in a window other than the copy stamp window, it is displayed as it
was before dust erasure was performed. Check dust-erased images
in the copy stamp window.

An image could not be adjusted

The JPEG and TIFF images cannot be adjusted using the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.128).

A recipe could not be pasted (applied) to another image

You cannot paste (apply) rotation (p.10, p.25, p.124, p.132, p.133),
trimming (p.38, p.111), dust erasure (copy stamp) (p.73to p.77, p.114
to p.118) of an image to another image as a recipe. Trim the image or
erase dust of the image using the copy/paste function in each window
and rotate each image individually.

The adjustment contents (recipe) of RAW images that has been
adjusted with the [RAW] tool palette cannot be applied to JPEG or
TIFF images (p.128).

The Auto Lighting Optimizer (p.59) is a function that is only available
for RAW images shot with EOS-1D X, EOS-1D C, EOS-1D Mark 1V,
EOS 5D Mark lll, EOS 5D Mark I, EOS 6D, EOS 7D Mark Il, EOS
7D, EOS 70D, EOS 60D, EOS 50D, EOS REBEL T5i/700D, EOS
REBEL SL1/100D, EOS REBEL T4i/650D, EOS REBEL T3i/600D,
EOS REBEL T2i/550D, EOS REBEL T1i/500D, EOS REBEL T5/
1200D, EOS REBEL T3/1100D, EOS M2 and EOS M. You cannot
apply the Auto Lighting Optimizer’s adjustment contents to RAW
images shot with other cameras.

Color appears weak in the image when viewed with
other software

A RAW image which has a color space other than sRGB set (p.77,
p.93) and is then converted and saved as a JPEG or TIFF image will
appear weak in color when viewed in software that is only compatible
with sSRGB color space. In this case, set the RAW image color space
to SRGB, convert again to a JPEG or TIFF image and save, and then
view this image.
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The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if a profile for a printer that is to print images, has not
been set up, the color of the image displayed on screen and the color
of the printed photograph may differ greatly. If the color of the monitor
that displays images is corrected (p.93) and a profile for a printer is
set up correctly (p.93), the color of a printed photograph and the color
of an image on screen can be more closely matched. Using a Canon
printer (p.43) or linked printing (p.87, p.89) automatically sets up
printer profiles, so you only need to set the color of the monitor to
bring the colors closer together.

Even if you set a printer profile, if you use the color adjustment
function of the printer driver, the image may print in colors different
from those displayed on screen. Do not use the color adjustment
function of the printer driver.

Printing a large number of images in batches cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

Delete [CRW_YYYY.THM] (camera index display image) if it remains
in the folder from which images have been deleted (p.47).
* Numbers are entered for [YYYY] in the file name.

The image information does not display

A JPEG image set to Adobe RGB and shot with EOS 10D and EOS
DIGITAL REBEL/300D DIGITAL may not display image information
(p.10, p.23).

Deleting the Software (Uninstalling)

Quit any applications before uninstalling the software.

Log into the account used when installation was performed.

When you have moved the folders and the software to be deleted to
the Trash, select the [Finder] menu » [Empty Trash] and empty the
Trash. You cannot reinstall the software until you have emptied the
Trash.

Display the folder in which the software is saved.
Open the [Canon Utilities] folder.

Address Book Automator Calculator Canon Utilities

®

DVD Player Font Book Front Row

Photo Booth Preview QuickTime Player Safari Stickies

.@

System Preferences TextEdit Time Machine Utilities Open in Finder

Drag the folder for the software to be uninstalled to
the Trash.

Select [Finder] menu on the desktop » [Empty Trash].

The software is deleted.
When uninstallation ends, restart your computer.

@ You cannot retrieve data that you have emptied into the Trash and
deleted, so be particularly careful when deleting data.
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List of Main Window (Folder Window) Functions .10

Introduction

Shows/hides the tool palette (p.128) Image information (p.23) Cancels selection of all images Displays the trimming/
Shows/hides the folder area Selects all images Displays the quick check window (p.132) angle adjustment
S\_/vitches to the editimage ‘ Displays the copy stamp window (p.140) v‘vmdow (p-135) Contents at
window (p.133) 1 A , , , a Glance
@ Digitpl Photo|Professional Fil§ Edit |View Bookmark Label |Adjustmlent Tpels Window Help E 4 Wed 10:48 AM Q 1
Digital Photo Professipnal - [ MacOSX/Users/canon/Pictures/Photo/xxxx_xx_xx ] F0|del’ path —
Toolbar*! .
Batch conversion/ Basic

H *5 .
[Collection] tab sheet saving Operation

Folder] tab sheet*>
rocer B (P99, P-100, A5
[ Temporary Items — 1 — Image rOtatlon
v 08 sers —_— Advanced
¥ i canon (90 degree O H
¥ [@E Desktop S . peratl on
Check mark (p.19) e u increments)
4 iy
::2:? __ _fy:__;m_{ng e IMG_0002 CR2 P _ﬁmt_’dbﬁ_{kz _ IMG_0005.CR2 Ratlng (plg) Advanced
¥ (4 Pictures i Image Editing
- and Printing
> @ Puﬁlic o T —
» [ Shared Processing
Large Numbers
Folder area*? : - - 5 of Images
m | MGOO07CRZ | |gmm  MGOOOSCRZ | |gm  MGODISCRE  |gm  MGOOOCRE
Editing
JPEGI/TIFF
Images
e D E—
S -
' MG O0ILCRZ ) ' T MG O0D12CRZ ' T MG O013.CRZ " "~ MG ODI4CRZ  |pmg MG OOISCRZ Reference
J m
L1»\.duha RCB / Adobe RGB High quality Recipe I:la(.-:: Yes Numbarlal images: 15 Numberpfsel:n:dimages: 3 CMYK ,,,/f'— CMYK Slmulatlon
| | display (p.93
Image color space and WOFKJ Display mode** Number of selected images play (p.93)
*3
color space™ (p.77, p.94) Recipe attachment status (p.96) Number of displayed images @ @
*1 To switch between show/hide, select the [View] menu » [Toolbar]. *4 The item selected in [Viewing and saving RAW images] (p.90) of the @
*2 The images inside the folders selected here are displayed in a [Preferences] window is displayed. =
thumbnail list on the right. *5 You can switch between the [Folder] and [Collection] windows.

*3 Displays the coordinates of the cursor position and the RGB values (8-bit
conversion) when click white balance was performed with the tool palette. 124
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List of Main Window (Collection Window) Functions .3 e eetion
Image information - - i i i
Shows/hides the tool palette Selects all images Cancels selection of all images D||sp|ays the quick check window S
_ - g Displays the copy
Switches to the edit image ‘ stamp window Contents at
window ,| a Glance
@| Digital Photo|Professional Fil§ Edit |View Bookmark Label [Adjustmjient Toels Window Help E 4 Wed 9:46 AM Q
[SEES] Digjital Photjo Professional - [Collection] —
Toolbar , .
Collection] tab sheetl Batch conversion/ Basic
[Collection] tab shee saving opa R
[Folder] tab sheet
— Displays the trimming/
: angle adjustment Advanced
3 = window Operation
— Rating
e S onw  m wowe & wowe B wooser ey o | weovor Advanced
— Image rotation ”:nadggﬁgt'itr']”gg
(90 degree S
increments)
Processing
Large Numbers
— Check mark of Images
Editing
JPEGI/TIFF
Images
Reference
m
Adobe RGB / Adobe RGB Highiguality Recipe data: No Number of images: 7 Number of selected images: 0 cmvK v CMYK simulation
. | ! . display
Image color space and work Display mode Number of selected images
*2
color space*~ (p.77, p.94) Recipe attachment status Number of displayed images @ @
*1 The total number of images added to the [Collection] window is *2 Displays the coordinates of the cursor position and the RGB values (8- @
displayed in the () in the [Collection] tab sheet. Accordingly, when an bit conversion) when click white balance was performed with the tool =
image that is displayed as a single image is added (p.22), twice the palette.

total number of displayed images is displayed.
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Image Frame Information in the Main Window and Edit Image Window (.10.p.34) R
Information displayed when [Large thumbnail] (p.10) is selected
(= NN Digital Photo Professional - [ Canon 1/Users/Canonl/Desktop/xxxx_xx_xx ]
: Contents at
3 » _ - a Glance
2 @@ © 8 7 e
e Digital Lens
Optimizer mark Basic
. 72 i
Folder Collection(0} (p-68to p.72) Operation
Check mark ¥ S MacOSX =
(p.18, p.19) > L& Applications Copy stamp Advanced
@ Temporary ltems N — L mark Operation
W Lucry (p.73 to p.77,
v % canon p.114 to p.118)
¥ [[@F Desktop Advanced
[ 7 Travel o[ Lens Image Editing
_ aberration and Printing
Rating mark » I Documents correction —
(p.18, p.19) P ¥ Libary mark (p.63) :
[= Movies Trimmi LPrOCl?lSSIt?g
. o raiicis | Trimming arge Numbers
Brl_ghtness -"f_!---- range** of Images
adjustment ¥ [ Fictures
oL (0.26 v G Photo (p.38, p.111)
value™ (20 [ HHXXK_KX_XX i [ Aperture™ Editing
T ® hokk 17400 JPEG/TIFF
= Fulhllc IMC_0001CR2 IMG_0002 CR2 GPS Images
White balance icon*1 (p.28) File name GPS mark*> Reference
Unsaved editing content mark

Image type*? Shutter speed*3

Index

*4 When aspect ratio information is attached to an image shot with
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D
Mark 11l, EOS 5D Mark Ill, EOS 6D, EOS 7D Mark Il, EOS 7D, EOS
70D, EOS 60D, EOS REBEL T5i/700D, EOS REBEL SL1/100D, EOS
REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T5/1200D,
EOS M2 or EOS M, the image is displayed as a trimmed image.

*5 Displayed on images shot on a GPS function-compatible Canon
camera.

*1 Does not display with [Small thumbnail].

*2 Displays in RAW+JPEG images displayed as a single image (p.22).
[RAW] is displayed in RAW images.
(In [Small thumbnail] (p.10), [R] is displayed.)

*3 Does not display with [Medium thumbnail] or [Small thumbnail].
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List of Edit Window Functions .11, p.25)

Path and file name of image

Tool palette*! (p.128, p.129, p.130)

806 E Digital PI:\uto Professional - [ MacOSX /Users/canon/Pictures /Phote/xxxx_xx_xx/IMG_0001.CR2 ]

( 918, 1282): 79, 81, 93

RAW ]IAdnb! RCE CN!YK High qu:i\lt\! }%‘

Display mode**
Information display*2 _ o
CMYK simulation display (p.93)

Image color space*3 and work color space (p.77, p.93)

*1 To switch between show/hide, select the [View] menu » [Tool palette].
*2 Displays the coordinates of the cursor position and the RGB values (8-
bit conversion).

Do ¥ IMG_0001.CR2

| raw | rce

NR/ALO | LENS

| Brightness adjustment

(=]

|Whila balance adjustment

| @ (Auta) 1-3-1 (Tune.‘.)
|Piclur25tyle b ”

[_E (Standard)

W! (Browse... )

Cantrast:

Highlight: | Vbt v sty

Shadow: Lt sy
! Linear

Calor tone: ALl ,$‘ R

Color saturation: 0 T@T

Unsharp mask I+

Strength: 101 e“|||||\|l
Fineness: o $H|||||\||
Thrashold: (i e

*3 RAW images are displayed with [RAW].
*4 The item selected in [Viewing and saving RAW images] (p.90) of the
[Preferences] window is displayed.
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List of Tool Palette Functions S
RAW Tool Palette (p.25) RGB Tool Palette (p.58) ]
e 4.6 %} IMG_00D01.CR2 & a8 ¥ IMG_0001.CR2
[ RAW | RGB NR/ALO  LENS | " RAW | RGB | NRfALO  LENS | Automatic adjustment Cgrgle;r;[(s:eat
. ) Tone curve assist Lw— :
- Brightness adjustment (p.26) |Tm e L—Jl—+J| = (tone curve assist) (p.33, p.104)
R = \—W! " [c]s] Iz Click white balance (p.106) >
e 255 .
i s i %'—\ ——— White balance adjustment Operation
| Bl &) (qune) (p-28, p.54) — Tone curve adjustment
e =] _ _ (p.56, p.108) . .
(—— Picture Style settings (p.26, p.57) Operation
| andar, ] (Browse... . .
s B pundvd AC ‘), - Dynamic range adjustment (p.109)
_ ) Advanced
- Dynamic range adjustment (p.55) Image Editing
and Printing
o : 1 : —_
| S0 50 60 40 20 0 20 40 | _ - ; oy
Contrast: [ Se———— Contrast adjustment (p.29) . 5 — Brightness and contrast Processing
Highlight: 0 Tt 1 . . o ) i = p Large Numbers
R oo Shadowr/highlight adjustment (p.55) | contrast 528 T 38 adjustment (p.105) 9 mages
_J Linear Linear setting (p.29) i PreTel ol _ _
E":‘“’:E - ig; i i Color tone and color saturation Saturation: 6t s O © Hu;:oa;nd Saturation adjustment Editing
| e oy Ao AR adjustment (p.30) Sharpness: R D (p.107) JPEG/TIFF
. I
R R ) Sharpness adjustment (p.107) __mages |
Fineness; {0} SSpTT— Sharpness adjustment (p.31)
Threshold: {0) m 5 ‘
Sharpness I:] | Reference
Sharpness: i m !
Enlargement display position* —— Enlargement display position* m
* If animage is displayed enlarged, the enlargement display position can be @
moved by dragging. The enlargement display position appears when ~—

[Docking display] (p.92) has been set and the edit image window (p.133)
has been enlarged.
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Introduction
NR/ALO Tool Palette NR/ALO Tool Palette
(When a RAW image is selected) (When a JPEG or TIFF image is selected)
= - — - Contents at
(ala) . ¥ IMG_1001.CR2 , nn . ¥ IMC_1001,JPC : a Glance
RAW RGB | NRFALOD | LENS - RAW RCGB | NRFALOD | LENS
IAﬂtn Lighting Optimizer I |Autn Lighting Optimizer |
o] - Auto Lighting Optimizer (p.59) = Basic
I Low  Standard  Strong ) Low  Standard  Strong . . Operation
|Noise reduction LW?‘I— Apply noise reduction button (p.60) |Noise reduction le—t— Apply noise reduction button (p.110)
R ___neeevien. 71— Displays the [NR Preview] window A ___weeeien - Displays the [NR Preview] window
: minance noise reduction (p60’ plgl) l minance noise reduction 1101 131
[ s " ——— J— Luminance noise reduction for = s o (P p-131) ég‘é?gﬁgﬁ
i . : RAW |mages (p60) Chreminance noise redutr:i_i?_r_t
@ —— Chrominance noise reduction for @ - .
_TIFF/JPEG RAW images (p.60) TIFF/IPEG Advanced
Luminance noise reduction [ Luminance noise reduction ]— Luminance noise reduction for Image Editing
(L} D 20 7 0 ——— 5 JPEG and TIEE imageS (pllO) and Prlntlng
Chrominance noise reﬁua_i?n TGMINANCe noise ction
o it 22 i o 9~ ® | Chrominance noise reduction for Processing
JPEG and TIFF images (p.110) Large Numbers
of Images
Editing
JPEG/TIFF
Images
Reference
——— Enlargement display position* ——— Enlargement display position* Index
* If an image is displayed enlarged, the enlargement display position can @

be moved by dragging. The enlargement display position appears
when [Docking display] (p.92) has been set and the edit image window
(p.133) has been enlarged.
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LENS Tool Palette

ann ¥ IMG_1001JPG

| 'RAW  RGE  NR/ALO |

LENS |

Digital Lens Optimizer TURE... H

Setting

OFF

Lens data

Yes

Update... ]—

Lens aberration correction Tune... 1

Peripheral illumination
Chromatic aberration
Colar blur

Distortion

OFF
OFF
QOFF
OFF

—— Digital Lens Optimizer adjustment button (p.71)
—— Amount of Digital Lens Optimizer (p.70)

—— Lens data status (p.70)
—— Lens data Update button (p.70)

—— Lens aberration correction adjustment button (p.63)

—— Lens aberration correction (p.63)
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List of NR Preview Window Functions .60, p.110) _
Introduction
—
Contents at
|Nnn NR Preview : a Glance
Basic
Operation
Enlargement display
position Advanced
Operation
Navigator window
Advanced
Image Editing
Image type* and Printing
' D e
Luminance noise reduction = R . .
[{m 5o B - Luminance noise .
NERRP  dIERERERENE! 3 redUCtIOI’l LargeNumberS
Chrominance noise reduction ) ) ) of Images
! ' o E 20! Chrominance noise
bbb bbb J_ redUCtlon Edltlng
( cancel ) € Apply 4| Apply noise reduction JPEG/TIFF
button Images
W J e ————

Reference

NR check window

Index

3l
O

* When you select a JPEG or TIFF image and display the [NR Preview]
window, [TIFF/JPEG] appears and you can reduce luminance noise
and chrominance noise for the JPEG and TIFF images.
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List of Quick Check Window Functions .16 p.18)

50% view/100% view (moiré reduction off)/full view*!

Check marks (p.18)

File name of image

2/15 IMIG_DDGZ.CRZ [3456 x 2304]

\
| 50%view ]{ Full screen I—

Check mark

Clear o

l12345|

. Reject .

Rating

— Displaystheimage
in full screen*2
Removes check
marks (p.18)

L Rating (p.18)

( Pre\lrious :) ( Next )

Switches between
displayed images

TJAF Paint

[ Image Information ]

————

( Rotate left ) [ Rotate right )

Displays the AF
points (p.16)
Displays the image
information window
(p.24)

Image rotation
(90 degree
increments)

*1 You can select 50% view/100% view (moiré reduction off) by selecting
[Preferences] in the [Digital Photo Professional] menu and using
[Quick check tool display] in the [View settings] tab sheet. You can
also move the display position in the enlarged display by dragging the
image.

*2 To return to the normal screen, press the <esc> key.

Rating (Reject) (p.18)
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List of Edit Image Window Functions .3 p36)

Shows/hides tool palette Image information (p.23) Enlargement ratio of displayed image Displays the trimming/

Shows/hides thumbnail display area Shows/hides grid*4 Displays the copy stamp window angléa adjlulsltmeritgvg/indow
Switches to main window ‘ (p.73t0 p.77, |O|-114 to p.118, p.140) (p.| DAL PASS)
(p124) |‘, Digitil Photo|Professjonal flile Edit View Label Adjustment Tools Window Help B 4 Wed 10:08 AM & 1 |mage path and

@ Digital Phot|o Professional - [ MacOSX /Users fcanon/Pictures/Photo/xxxx_xx_xx/IMG_003.CRz§

file name
Batch conversion/

DDBD DD DO @@ D

Toolbar saving
[ rAW | RGB  NR/ALO  LENS S (p99 ploo
‘Erighmess adjustment li" p 1 41,) ,
e 0.00 .
= Image rotation
_(90 degree
@ (uto) mcrementS)
P =i Switchesbetween
| @ (Standard) 5] (Browse... ) dlsplayed |mages
| - +—— Tool palette
| Yy (p.128)
“100 8.0 6.0 -40 -2.0 0 40
. . 3 Contrast: {0 Fem——
Thumbnail display area*3 | il e g
I Shadow: 1 T ——
T o TTOTT
‘Color saturation: A e
Strength {0
Fineness: A —
Threshold (0] —
( "
|nf0l’matl0l’l dlsplay*2 {(1039, 1304) " 110, 126, 168 RAW / Adabe RGB CMYK —  High quality ‘ 2

|
I(Ln?gegglg)r space™! and work color space o1y simulation display (p.93)  Display mode*s

*1 RAW images are displayed with [RAW].

*2 Displays the coordinates of the cursor position and the RGB values
(8-bit conversion).

*3 Displays images selected in the main window. The image selected
here is enlarged and displayed on the right.

*> The item selected in [Viewing and saving RAW images] (p.90) of the
[Preferences] window is displayed.

*4 You can set the grid spacing with [Grid pitch] in the [Preferences] (p.91).
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List of Convert/Save One Image Window Functions .42

Introduction

00,08 Convert and save
File name Contents at
a Glance
_ Save As: | IMG_0001 L7
Types of image _
3 i Tags: Basic
Type of image Extension Operation
- & | 1 1
Exif-JPEG IPG Where: | [ Desktop 3 Save destination
Exif-TIFF 8bit TIF File format
TIFF 16bit TIF Advanced
— , , Kind of file | Exif-JPEG aal Operation
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG _
TIFF 16bit+Exif-JPEG | .TIFL.JPG mage quality T /IO JPEG compression rate*?
. . Advanced
Output setting Embeds of ICC profiles*? (p.143) Image Editing
. Output resalution 350 |dpi % Embed ICC profile and Printing
Resolution*1 |
[ Resize setting ) Processing
|| Resize | Lock aspect ratio Large Numbers
Size changing*4 Width Height Unit of Images
5472 % 3648 pixel
{ 5472 pixel ) { 3648 pixel ) Editing
: . JPEGITIFF
Shooting info setting Images
Shooting information setting*> (¢)Include all shooting info
[ Remove only GPS info
- . Reference
() Remove shooting info

| Cancel | [ Save ]— Save Index
*1 The setting range is 1 to 60,000 dpi. *3 The setting range is 1 to 10. The higher the numerical value, the higher
*2 Color space (p.77, p.93) information that is set in an image is attached the image quality becomes. @ @
to an ICC profile. *4 The larger of the two values set in [Width] and [Height] is applied to the
Even if you remove the check mark from images that have been set to longer edge of an image and change its size. @
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.77, *5 Shooting information setting can be selected. N

p.93), the ICC profiles are embedded automatically.
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List of Trimming/Angle Adjustment Window Functions (3s p.111)

Cancels all the trimming (aspect ratio) information

GIala ¥ 1/1 IMG_0001.CR2 [3456 x 2304] , +— Full screen display/returns to normal screen

[ Full screen 1

( cear )( Rresee——1— Reverts to the condition when the image was shot
Aspect ratio . . .

3:2 ~ 1 — Ratio of trimming range (you can also enter

= K> 00 numerical values if you have selected [Custom])*1
[* o 2 )— Upper left coordinates of timmed range (you

Lil 8 362 © can also enter numerical values)

Width Height . .
[lm ¥ 1051 ] )— Size of trimmed range (you can also enter

: = numerical values)
: it .1 »;J— Angle of image adjusted
7 Pr— F:’ == ﬂ (Drag bar, use the mouse to click A/V or enter
» otate left otate ri t T .
: 2 =—/ numerical values to set angle)

copy ). mse | J— Copiesthe trimmed range and applies (pastes)
: it to another image*2

—— Applies the copied trimming range to all other
images*?2

i Apply All
s

[ Previous )k Next

-

— Switches between displayed images*?

Opacity —
Y B mre == . . .
T = Level of opacity outside a trimmed range
Grid pitch — Shows/hides grid lines
o — ) (Drag bar to set distance between grid lines)
{ Center on Screen ]
I Displays the trimming range in the center of the
( Cancel ) ( oK ) WIndOW
L (704,362 )->(2281,1413)= (1577 x 1051)[ 1.50] %‘l
Trimming range Displays borders around a trimmed range

Image rotation (90-degree increments)

*1 If [Free] has been selected in the [Aspect ratio] list box, you can also *2_ Qperates when you have selected multiple images and the trimming/
drag the borders of the trimmed range to change its range. angle adjustment window is displayed.
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List of Lens Aberration Correction Window Functions @63

When the list box for selecting an extender is displayed in the
[Lens aberration correction] window, select the extender

attached at the time of shooting from the list box.

To correct distortion aberration of images shot with a fisheye lens,
four effects can be selected from the [Effect] list box in addition to
[Shot settings] normally used for distortion correction.

-Ya¥a Lens aberration correction - [IMG_0001.CR2]

u

— Enlargement display section*1

" Reset .| Revertstothe condition whenthe
Ae— image was shot

Shoating distance information < | > . . . .
- o [ Shooting distance information
® slider*? (p.66)

',:,"t'Per,iner.al illumination
L L0

|| Chromatic aberration

— Peripheral illumination correction

}— Chromatic aberration correction

L 100
* ) [* ) ) Corrects blue chromatic aberration
C_ Color blur ) Color blur correction
| Distortion T I_ Distortion correction
O

Shows/hides position of
V! Navigator ) enlargement display section

L cad Grid display

| |
Enlargement display position (Navigator display)  Corrects red chromatic aberration

*1 The area you clicked on the image (Enlargement display position) is

displayed at 200%.

*2 For RAW images shot with MP-E 65mm /2.8 1-5x Macro Photo or EF
50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to the zoom magnification.

The slider is not displayed for images shot with an EF-M lens.
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List of Digital Lens Optimizer Adjustment Window Functions 6s) s

@ When the list box for selecting an extender is displayed in the
Digital Lens Optimizer window, select the extender attached at the
time of shooting from the list box.

§:

Enlargement display position (Navigator display)

%

Shooting distance information slider*? (p.72)
Digital Lens Optimizer adjustment (p.72)
[Do not sharpen previews] check box (p.72)

Reference
Enlargement display section*! @ Q

©

137

*1 The area you clicked on the image being enlarged (Enlargement display position) is displayed at 100%.
*2 The slider is not displayed in the Digital Lens Optimizer window for images shot with an EF-M lens.



List of Compositing Tool Window Functions .7

|| IMG_0001.CR2 [3456 x 2304]

[ 100% view ——
| IMG_0002.CR2 —

100% display (p.79)

— Select foreground image (p.79)

- Thumbnail display for foreground
image (p.79)

—— Select composite method (p.79)

— Use RAW compositing (p.80)

Weighting slider (p.79)

Alignment controls (p.80)

@

Continue 3
'_( Save As... )
|

— Continue compositing (p.81)
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List of HDR Window (Adjust Image) Functions sy s ,mmducﬁonl

Contents at
a Glance

Basic
TY— r Select an effect (p.83) Operation

Advanced
Operation

8enNo Adjust Image

Adjust tone/color (p.83) Advarced

Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
Adjust detail emphasis (p.83) JPEG/TIFF
Images
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List of Copy Stamp Window Functions .73t p.77,

[# 1/2 IMG_0050.CR2 [3456 x 2304]

| 100% view | | Full size view H
{. Apply Dust Delete Data q—
(Light) (Dark) )
ielel ICIe]
Select Copy Source j—

[ Fix Copy Source position ——

Pen type
=) Brush

i

Set to 100% View to perform stamp operation. ;j

* QOperates when you have selected multiple images and the copy
stamp window is displayed.

p.114 to p.118)

— Full screen display/returns to normal screen
— Applies Dust Delete Data (p.73, p.114)

— Types of dust to be erased (p.75, p.116)

- Specifies the copy source (p.77, p.118)

— Fixes the copy source position (p.77, p.118)
— Types of stamps (p.77, p.118)

Sets the size of the dust erasure range (p.75,
— p.116) or copy range (p.77, p.118) in arange of
5t0 100 (in one pixel increments) (you can also
enter a numerical value)

/— Restores/redoes the image

Copies the dust erasure range or copy range and
applies (pastes) it to another image

Switches between displayed images*

)
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List of Convert/Save Multiple Images Window (Batch Processing) Functions (.99 et
Batch settings
(* save folder
MG 000T.LR2 e ol — Save destination Contents at
IMG_0002.CR2 ENG/Users /canon/Desktop | Browse.. | a Glance
IMG_0003.CR2 File format
IMG_0004.CR2
IMG_0005.CR2 4( Kind of file | Exif-JPEG ¢_|)
IMG_0006.CR2 7 = . 7
File names of images to be IMG_0007.CR2 g 1 T JPEG compression rate*3 OpBe?Z!t(izon
batch saved st o Resolution*!
IMG_0010.CR2 Output resolution 350 dpi @ Embed ICC profile Embeds ICC profiles*2 (p.143)
IMG_0011.CR2 (" Resize setting )
IMG_0012.CR2 | Resize v Lock aspect ratio ) ) Advanc_:ed
IMG_0013.CR2 Width Height Unit Size changing*4 Operation
IMG_0014.CR2 5472 B 3548 _pixel :
IMG_0015.CR2 L { 5472 pixel ) {3648 pixel ) )
(" File name ) Advanced
Types of image (#) Current file name Image Editing
P d string P and Printing
Type of image Extension " File name
Exif-JPEG JPG - String Sequence number PrOCQSSing
£ . DPP_ 0001 Save'Sequence number Large Numbers
E)_:_l:cF-Il-__I F]_Z[fblt I:E Ex.: IMG_0001 JPG, IMG_0D02 [PG of Images
It . \ J
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG SEJHQ S 7 B
- ) */include ail shooting Into H H H H
TIFF 16bit+Exif-JPEG | .TIF/.JPG Ol e s info Shooting information setting*® N B
{ () Remove shooting info ) RIS
( fer setti ) .
II:T;EEU:H:?:?:IM&T Batch transfer to other image
f———— editing software (p.100) Reference
Images to be converted are limited to i : 2
RAW |mages*5 - Convert RAW images only | | Cancel | [ Execute — Save
Index
*1 The setting range is 1 to 60,000 dpi. *4 The larger of the two values set in [Width] and [Height] is applied to the
*2 Color space (p.77, p.93) information that is set in an image is attached longer edge of an image and change its size.
to an ICC profile. *5 Appears when you click the [Batch process] button (p.124, p.133)
Even if you remove the check mark from images that have been set to without an image selected in the main window or the edit image @ @
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.77, window. To convert RAW images only, instead of clicking the [Execute]
p.93), the ICC profiles are embedded automatically. button, click this button.
*3 The setting range is 1 to 10. The higher the numerical value, the higher *6 Shooting information setting can be selected.

the image quality becomes.
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List of Rename Window Functions .10

Order in which images are sorted

Checkmark to apply the same
name to RAW images and JPEG
images recorded simultaneously

MacOSX /Users/canon/Pictures /Photo/ 3o _xx_xx

(" File Name

DPP i)
L .

Shooting Date/Time E] Seguence number

Extension

( Basic Settings

]

(" Format settings

N
Ej Do not change E]
J/
<

Sort

%) Fit to main window
) File Name

_ shooting Date/Time

—‘ lj Same file name for RAW+JPEG images

( __ Copy & Rename

MacOSX/Users /canon (Desktop

Checkmark to copy the images
Click the [Browse] button and set
the save destination

Sequence number

0001 | Save sequence number

Shooting Date/Time

Month Day Year E!
MM-DD-YY E]

Elnser‘t underbar

o J
Original File Maodified File Name
IMG_0001.CR2 DPP_09-13-06_0001.CR2
IMG_0001JPG DPP_09-13-06_0002.JPC U
IMG_0002.CR2 \DPP_09-13-06_0003.CR2
IMG_0002.JPG !DPP_09—13—06_0004JPG
IMG_0003.CR2 EDPP_09—13—06_0-005.CR2
IMG_0003.JPG — |DPP_09-13-06_0006.JPG
IMG_0004.CR2 EDPP_GQ—IZ—UE_ODD?.CRZ
IMG_0004.JPG 'DPP_OQ—IZ—UE_DGOE.JPG
IMG_0005.CR2 |DPP_09-13-06_0009.CR2 -
IMG_0005 PG !DPP_GB—lE.—OG_GGlD.JPG =5
£ ' N0y T : : = A

(: Cancel \Je—Exetnte—)

Sets the new file name

Sets the format of information
in the file name
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Glossary
RAW image

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* *RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that printimages each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

|ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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) ) ) Introduction
Color space CMYK simulation profiles
A color space is the reproducible color range (color gamut A profile that simulates colors when printing in a CMYK environment
characteristics). DPP supports the following five kinds of color space. (printing machine, etc.). With DPP, you can simulate color with four Contents at
sRGB : Standard color space for Windows. Widely used for types of profile. a Glance
the standard color space of monitors, digital Euro Standard : Profile normally used for book printing in
cameras, and scanners. Europe, suitable for simulation of standard
Adobe RGB : A wider color space than sRGB. Mainly used for European printing. Basic
printing for business purposes. JMPA : Profile normally used for book printing, etc. in R
Apple RGB : Standard color space for Macintosh. A slightly Japan, suitable for simulation of magazine
wider color space than sRGB. advertising standard color printing. Advanced
ColorMatch RGB : A slightly wider color space than sRGB. Mainly U.S.Web Coated : Profile normally used for book printing in Operation
used for printing for business purposes. North America, suitable for simulation of
Wide Gamut RGB : A wider color space than Adobe RGB. North American standard printing.
Refer to the color chart below for the color area of each color space. JapanColor2001 type3 : Profile becoming a standard in the Japanese Advanced
printing industry, suitable for simulation of 'Qna(?%ﬁgt'ith"gg
Color chart of color spaces compatible with DPP JapanColor standard printing.
Processing
Y . .
Rendering intent o images
Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below. Editing
Perceptual : Before and after conversion, all colors are JPEG/TIFF
Color range that can be converted to maintain the relationship between I/
seen by the human eye colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However, Reference
depending on the image, the saturation may
change overall.
Relative Colorimetric : There will not be much conversion to colors |
. o : ndex
which are similar before and after conversion,
x but colors which are not similar are converted
appropriately. Because there are little changes
Gamma White point to similar colors which comprise most of an @ @
value (color temp.) image, you can print a natural-looking image in
—— | SRGB 2.2 6500K(D65) which the saturation has not changed greatly.
R Adobe RGB 22 6500K(D65) However, depending on the image, there are
............ Apple RGB 1.8 6500K(D65) cases where the overall tone of an image
- ColorMatch RGB 1.8 5000K(D50) c_ha_nges somew_hat as colors which are not
______ Wide Gamut RGB 22 5000K(D50) similar and highlights change. 144




Index

A

AJUSE JPEG IMAGES......eiiiieiiiiiiiiieieeee et 103

AdJUSt RAW IMAQJES... oo i e eeieeeiiiiiis e et e e e e e s e e e e e e eeannenes 25

AJUSE TIFF IMAGES......eiiiiiieiiiiiiiee e 103

Adjusting (JPEG or TIFF Image)
Automatic Adjustment (Tone Curve ASSISt)........ccceeeeeeeieeeeeeeenn, 104
2T gTo ] 11 ToTT S 105
Click White BalanCe ............uuuvviiiiiiiiiiiiiiieeiieeeeseeeeeeseeeseeseeeeseeeees 106
LO00] 0] [ 1= 1] SRR 105
DyNamiC RANQE........uuuuiiiiie it 109
HUB e 107
RGB TOOIl Palette ........oiveieeiiieeiicie e 128
S T= LLE ] =1 1o o 107
S =T 0] LTSS 107
Tone Curve AdjUSIMENT... ... 108

Adjusting (RAW image)
APPIY AdIUSIMENTS.....cceiiiii e 97
Automatic Adjustment (Tone Curve ASSISt)......cccceeevvieerreeeeniiinnnn. 33
BIIgNINESS .uiii e 26
Brightness of HighlightS.............ciie i 55
Brightness of ShadOWS.............ooviiiiiiiiiiiiiieee e 55
Click White BalanCe ............uuuuuuuuumniiiiiiiiiiiiiiiiiieniiiieenneeneenneennnennnes 28
COolOr SAUIAtION .uvvieiiiie e e eeeee e 30
COlOr TEMPEIALUIE ....eeeiiieiiiiiiieee e 54
COl0r TONE ... e 30
LO70] (o gAY =T PP 54
L0000 = 1] PPN 29
COPY AJUSTMENTS .....uuuiiiiiiiiiiiiiiiiiiirrrirrerrrrresrrrrreerrrerr————————————. 97
DYyNamiC RANQE........uuuiiiiie et e e 55
Filter EffECt ... 31
MONOCRIOME ... e 30
Personal White BalanCe .............ccceeeiiiiiiiiiiiicci e 98
PiICTUIE STYIE . 26
Picture Style File .......ooooiiiiiii e 57
RNV oo B =1 1= 1 (= 128
SAVE AQJUSIMENLS ....vvviiiiiiiiiiiiiiiiriiiiirieiriaeveeereeereesrsesrereesesresreeeeees 97
Tone Curve AdjUSIMENT......ccooiiei e 56
B0 ] T I =1 (= o PP 31
TOOI Palette ..o 128, 129
WHhite BalanCe .........coovviiiiiii e 28

Adjustment Contents (RECIPE).....cceevviiiiriiiiiiieeiieiiiiiee e 96, 143
AdODE RGB ... 144
APPIE RGBi....ee s 144
F N = U aTo TN [ = To T 20, 21
AUto Lighting OPtIMIZEN .....oooiiiiiiieee e 59
Automatic Adjustment (Tone Curve ASSISt) ....ccooeevvvviiiiiiicinee e, 33, 104
Automatic Dust Erasure Processing.......cccccveeveveevveeennnn. 73,74, 114, 115
B
Batch Apply White Balance to Images (Personal White Balance)....... 98
Batch Change the File Name of Images.........cccccceviiiiiiiiiiieeeennee 101
Batch Convert/Save Images (Batch Process) .......ccccccceeeeviieeeveveennnnnnn, 99
Batch Process (Batch Save JPEG and TIFF Images)................ 99, 141
Batch Process of Multiple Images
Change File NamMe .........oooiiiiiiii e 101
Convert/Save (Batch ProCess)..........cccccuvvivieeeiiiiiiiiiiieeeeenns 99, 141
Personal White Balance..........ccccccccvvvviiiiiiieeeeee 98
RECIPE DALA .....cuvviiiiiieiiieiieee e 96
THANSTEI .. 100
Batch Settings WINAOW.............uuuvuiiiiiiiiiiiiiiiiiiiiiniieseineeeene. 99, 100, 141
Batch Transfer IMages ... 100
Batch Transfer Images to Image Editing Software.............cccvvvveeeeee. 100
Before/After Comparison DiSPIAY ........ccoviiiiiiiiiieiiiiiiieeeece e 51
DIt NUMDET ... 143
BOOKMArK ... 49
BrIgNINESS. ... 26, 105
C
Change File Name..........ccccooe i, 101
Changing the File Name of Images in the Order in the Main Window .... 101
CheCK MarK ......ocviiiiiiiiiiie et 18, 19, 126, 132
Chromatic Aberration CorreCtion ...........cooeeeiieiiicieec e 63
Chrominance Noise Reduction (JPEG, TIFF Images)..............ccuu.... 110
Chrominance Noise Reduction (RAW IMages) .....cccccoeeevvvvvvvvininneeenn. 60
Click White BalanCe.........oooeuniiiiiiiiie et 28, 106
CMYK SIMUIation ... 93, 94, 144
Collection WINAOW .......covuiiiiieee et 6, 36, 125
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Color BIUr COorreCtion .........ccoeviieeiieiiiee e, 63
(©70] o] 001 o T- T SRR POTPPPPPPPR 144
Color Management (Color Matching)..........ooooeeieeeiiiiiiee s 143
Color Setting of the Monitor (Profiles) .........ceevvveevveeeveeriennennn. 93, 94
Color Setting of the Printer (Profiles).......ccccvvveviveveeviviriennnee. 93, 94
L070] (0] ] oI o] =T 144
ICC Profiles ..o 143
Color Management (PreferenCes)......ccccovvveviiveeeiiiiiiie e 93
Color SAtUrALiON ......cceveeeeee e 30
Color Setting of the Monitor (Profiles).......cccccevvieieiiieiciiree. 93, 94
Color Setting of the Printer (Profiles) .........cccoccuiviiiiiiiiiiiiiieeeeeen 93, 94
L0701 [0] ST o 1> o7 = S 144
AdODE RGB ... 144
APPIE RGB ... 144
Color Space Setting for Each Image ...........ccccvvvevveveiieiieeiieeveeeeee, 77
ColorMatCh RGB .......ceiiiiiiiiiiic e 144
Default Setting of Color Space...........ccccevevvvviii i eee e, 93, 94
SRGB ... e 144
Wide Gamut RGB ... 144
Color Space Setting for EACh IMage...........cooocuviiriiieeeiiiiiiiiieeeeee e 77
Color TEMPEIAIUIE......ceeeeeieeeeeeeeeee e, 54
COlOr TONE ., 30
COlOr WRNEEI ... 54
ColorMatCh RGB........oooiiiiiie 144
Compatible Cameras with the Lens Aberration Correction Function ....... 61
Compatible Lenses with the Lens Aberration Correction Function...... 61
Compositing IMAageS .......ooovvviiiieieeeee e, 78
Contact Sheet Printing (Printing a Thumbnail List)............................. 86
CONIFAST et 29, 105
Convert to JPEG or TIFF Image and Save................... 42,99, 134, 141
Convert/save One Image Window ..., 42,134
Copy Stamp (Image Correction) .........cooeeeeeeeeeeeiieeieeeeeee, 77,118
Copy Stamp WIiNdOW ..........ceevveeriniiiiiiiieeeee e 73,75, 114, 116, 140
Copying and Pasting (Applying) ReCIPeS........cccovvvviiiiiiiiiiiiee 97
Correct Images (Copy Stamp Function) ..........ccccceeveeen. 77,118
Creating @ FOIEN .......ooveie e e 47

D
Default Noise Reduction SettingsS............oovvuiiiriiieeeiiiniiiiieeee e 93
Default Setting of Color Space ..........cocuvieiei i 93,94
Delete IMAGES ....ccoiiiiiiieie et a7
Deleting
Delete IMAGES .....eiiiiiieiiiiiee et a7
Delete the SOftWAre ............uvviviiiiiiii e 123
Deleting DPP (Uninstalling) .........ccoooeiiiiiiiiiiceee 123
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Printing
Printing a Thumbnail List (Contact Sheet Printing) ..................... 86
Printing One Sheet of Paper .........coevvvevvivvivviiieeieeiieeeeeeeeeee, 14, 46
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Save
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View and Save RAW IMages.......ccocoevveiiieiiininninnns 89, 90
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(04 0T Tod g 4= 1 G PP 18, 19
= 1 1] o 1 18, 19
SRGB ...ttt aaa s 144
SEarting UP DPP ..o 6
YU o] o Lo £(=To [ =T = 3
Synchronization (Edit WiNdOW)............ccoooiiiiiiiieiiiiecee e 52
Synchronize Edit WINAOWS ..........ooouiiiiiiicreeie e 52
SYNCNIONIZE IMAGES ... .. 52
System ReQUIFEMENLS .....uuuuii i e e e e e e e e e e e eenes 3
T
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Thumbnail Display of Images (Main Window)............ccccceeeeeeiieenn. 10
Change the DiSplay ...........uuuvuuiiiiiiiiiiiiiiiiiiiieiiierieereeerrerreeeee————— 10
LI 10T T PP 143
TONE CUINVE et e e e ettt eeaaeeeanes 143
Tone Curve AdjUSIMENT .......ovvviviiiiiieeieieee e, 56, 108
Tone Curve Assist (Automatic Adjustment) ............cceoeeeeeeeeeen. 33, 104
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Tool Palette
LENS TOOI Palette......ccoeiiiiiiiiiiiieeeeciiieeee e 130
NR/ALO TOOl Palette.........ueeeeiiiiiiiiiiieiiieieeeeeeeeeeeeeeeeeeeeee e 129
RAW TOOI Palette........cuuiiiiiiiiiiiiiiiieiieiiieee e 128
RGB TOOl PAlEE ..o 128
Tool Palette (PreferenCes) ..... ..o 92
Transfer
Batch Transfer Images to Image Editing Software...................... 100
Transfer an Image to PhotoSNOP...........oocciviiiiiiiiiiieeceeee 77
Transfer an Image to PhotoShop ... 77
Trimming and Adjusting the Angle of an Image......................... 38, 111
Trimming/Angle Adjustment Window .............oocccvvveeeeennnnne 38, 111, 135
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View Settings (PreferenCes) ..........uvuvviiiiiiiiiiiiiiiiiiiriieeereeereseeeereeereeee. 91
W
WHhItE BAIANCE.......uuiiiiiiiiiiiiiiiiiiiiiiit ittt e e e eeeeeeeeas 28
Click White BalanCe ...........ooccviiiiiiiiiiiiiiiieieeeee e 28, 106
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COlOr WREEL.... .ttt 54
Personal White BalancCe ...........ccccooi 98
Wide GamUE RGB ... 144
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About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademarks
Macintosh and Mac OS are trademarks of Apple Inc., registered in the
U.S. and other countries.
Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.
All other trademarks are the property of their respective owners.
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